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Entry forms are integrated into all Geotec graphic modules to enter, modify, delete and view data. Entry 

forms include calculations, validations, default values and automations. Entry forms are used to retrieve 

data based on various criteria via the Query mode. 
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The data is saved directly in the connected Geotec database, either a Microsoft Access (.mdb), SQLite 

(.db3), SQL Server or Oracle database. 

1. Database  

Geotec databases have a standardized structure of tables, fields, and relations between tables – no 

definition of tables or fields needs to be made by the user. The database structure can be in English or in 

French. The databases are generated via the DBM module.  

To open the entry forms, the graphic module must be connected to a Geotec database (DB). 

• Click  or File > Open DB to open an Access or a db3 DB.   

• Click  or File > Connect DB to connect to an SQL Server or Oracle DB. Enter the username, 

password and login alias provided by your IT department.  

The title bar displays the name of the module and the connected DB in square brackets such as: 

[DBMS: File] (DB Version - Language). 

1.1. Data Hierarchy  

The hierarchy structure of the database is presented in Figure 1. 

• The site refers to the mandate for which borings are being carried out. It is defined by a unique 

number in the DB.  

• The boring is defined by its number and its site number. The site-boring combination must be 

unique in the DB.  

• Samples, layers, in situ tests and other data are all linked to the boring.  

• Lab tests are defined by their site-boring-sample combination which must be unique in the DB.  

• Axes are defined in the site to generate profile views. 

 

Figure 1 – Hierarchy structure of the Geotec database 
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2. Access the entry forms  

Most of the buttons on the application toolbar of the graphic modules are linked to the data. They 

correspond to items from the Data menu and are described in this documentation. 

2.1. Entry forms menu 

Click the Entry Forms Menu button  on the application toolbar or Data > Entry > Entry Forms Menu. 

A window opens, showing a button per entry form, all grouped by data type under the tabs Description 

(paragraph 6), Rock (paragraph 7), In situ tests (paragraph 8), Lab tests (paragraph 9) and General 

(paragraph 10). The four main entry forms, at the top of the database hierarchy, are described in 

paragraph 5. 

When a query is made and data is retrieved, the name of each table containing data related to the query 

is displayed in red, to facilitate management. 

 

Figure 2 – Entry forms menu 

2.2. Quick access buttons 

Depending on the module, quick access buttons are available in the application toolbar to the left of the 

Menu button, or via Data > Entry. These buttons open the most common entry forms depending on the 

module. In Log, the quick access buttons  are Site, Boring, Stratigraphy and Sample. 

2.3. Interactive access  

Depending on the module, the entry forms can also be opened by double-clicking in a graphic. 

Interactive editing is described in the documentation of each module. 

• In Log, double-click in the header of the log report to open Boring, or in a column to open the 

corresponding form. 
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• In Lab, double-click in a graph to open the entry form whose data is displayed. 

• In Pro, double-click in a data column to open the corresponding entry form.  

• In Site, in 2D, double-click on a borehole symbol to open the Boring form, and on a line to open 

Axis. In 3D, double-click on a data column to open the corresponding form. 

• In Time, double-click in a graph to open Piezometer. 

2.4. Open Table  

Any table or view of the database can be opened by clicking the Open Table button  on the 

application toolbar or via Data > Open Table. 

The list includes the tables and/or views (queries) of the database, depending on what is checked in 

Include in the list. The user can then choose the desired table or view from the list. 

The user can select the Display mode for the entry form. The display modes can also be changed when 

the form is open (paragraph 3.2.3). Then, click Open. 

 

Figure 3 – Open Table  

3. Characteristics of the entry forms  

The entry forms all have the same characteristics. The Boring form is shown as an example for the 

following.  
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Figure 4 – Characteristics of the entry forms  

3.1. Title bar of the entry forms  

The title bar identifies the table associated to the entry form. The number of records retrieved via a 

query is indicated, as well as the position of the one currently displayed. The status is indicated: 

• New: to insert a new record in the database. 

• Modified: record modified but not yet saved. Modified values are displayed in red. 

• Saved: existing and unmodified record.  

3.2. Toolbar of the entry forms  

When an entry form is open, the menu bar changes. It reflects actions specific to entry forms. Most 

menu items have a corresponding button in the toolbar of each form.  

3.2.1. Save or cancel 

Click the button  or use Action > Save or the [F10] key to save any entry or modification in the 

database. By navigating between records, changes are automatically saved. After saving, the status 

indicated in the title bar changes to “ aved”. 

To cancel changes, use the [Esc] key or  button and say no to the save request. 

3.2.2. Refresh the graphic page  

The graphic page is automatically refreshed with data when  is pressed. The button corresponds to 

Action > Always Refresh. 
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3.2.3. Display mode 

Each entry form can be displayed in 3 different ways, depending on user preference. 

• Click on   or use Display > Tabs to view with predefined tabs and groups of labels and fields. 

• Click on   or use Display > Datasheet to see records as rows, and fields as columns. Columns can 

be resized by placing the cursor in the header between columns (the cursor becomes:  ) or 

moved by placing the cursor in the header of a column (the cursor becomes:  ). Columns can 

also be hidden by dragging the column header out of the entry form. 

• Click on  or use Display > Columnar to see one record at a time, the 1st column listing the fields 

and the 2nd listing the values. Rows can be moved by placing the cursor on a row name (cursor 

becomes:  ). 

3.2.4. Do a query  

Use the buttons    , or the Query menu, or the [F7] and [F8] keys to do queries. See paragraph 

11 for all details on Simple queries and data retrieval.  

3.2.5. Navigate 

When data is retrieved after a query or data entry, use the buttons        or Record > First 

to Record > Last to go to the first, previous, specific number, next or last record. The keys [Ctrl]+[Home] 

go to the first record, and [Ctrl]+[End] to the last. While navigating, any modification is automatically 

saved in the database. 

In Datasheet display mode, you can also use the up and down arrows on the keyboard to navigate. 

If the change in the current record has an impact on the graphic report, it will be refreshed, unless the 

option to Refresh the graphic page is not checked. 

3.2.6. Insert 

Click the button  or use Record > Insert or the [F6] key to insert a new record into the database. The 

status shown in the title bar changes to "New". 

For some entry forms, basic data is entered directly when inserting a new record to speed up data entry, 

such as primary keys (Site No., Boring No.). This data can be modified. 

In Datasheet display mode, you can also use the down arrow on the keyboard to insert a new record. 

3.2.7. Delete 

Click on the button  or use Record > Delete or the [Shift]+[F6] keys to delete the current record from 

the database. If it’s a parent record to other records (e.g. boring containing samples), it is not possible to 

delete, except if data is from the same entry form (bottom table). To do cascade deletions, please use 

the DBM module. 
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In Datasheet display mode, you can also use the [Delete] key after selecting one or more rows. 

A message indicating the number of records and the table involved asks to confirm the deletion. Click on 

No to cancel the deletion. 

3.2.8. Duplicate  

Click on the button  or use Record > Duplicate or the [F6]+[F4] keys to duplicate the current record. 

A primary key is then suffixed by _DUP. This value will be modified by the user. Duplication does not 

involve dependent records. 

The Record > Copy Previous option or the [F4] key is used to copy the previous record, if a new empty 

record has been inserted. 

3.2.9. Layout 

Click the button  or use Action > Layout to open the configuration form to customize the current 

entry form. You can also click on the button  located above the vertical scroll bar in Datasheet or 

Columnar mode or for secondary tables in Tabs mode. See paragraph 18. 

3.2.10. Import external data 

Click the button  or use Action > Import Data to open the window to Import external data. See 

paragraph 16. 

3.2.11. Export data   

Click the button  or use Action > Export Data to export data in CSV format. See paragraph 17. 

3.2.12. Calculate  

Click on the button  or use Action > Calculate to open the calculation window (paragraph 4).  The 

button is only active if a calculation exists in the form. 

The calculations are described in the paragraph of each specific form.  

3.2.13. Shortcuts  

Click on the button  or use Help > Keyboard Shortcuts to see the list of all shortcuts that can be used 

in the entry forms for various functions. 

3.3. Generalities of the entry forms  

3.3.1. Information about the field 

The fields are predefined by Geotec. Use the [F1] key to open a pop-up with the NAME, TYPE, LENGTH of 

the field and IF REQUIRED. Hover over any field or header to display a tooltip describing the field and its 

unit or format. 
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3.3.2. Types of fields  

Geotec fields are numeric, alphanumeric (text) or dates. Dates are entered as yyyy-mm-dd hh:mi:ss 

format in the entry forms. "00" replaces hours, minutes or seconds if not provided. 

3.3.3. Field properties  

Background and text colors identify each field's property. 

• Key fields (required) – turquoise. The combination of keys defines a record as unique in the DB. 

Records must be entered hierarchically. Ex: a boring must be created before creating its samples. 

Keys can have up to 20 characters with letters, numbers and symbols - _ ( ) . Accents and other 

special characters cannot be used. 

• Required fields – turquoise. A few fields are not part of the primary keys but are nevertheless 

required. 

• Disabled fields – grey. No value can be entered. 

• Fixed fields – green. These values are calculated or used for calculations but are not saved in the 

DB. These are Aliases. 

• Calculated fields – orange. These values are calculated and can be modified and saved in the DB. 

3.3.4. Unit conversion  

Depths can be entered in meters or feet, and lengths in meters, feet or inches, depending on the type of 

conversion defined. The selection of a unit conversion applies only to the current form and only applies 

to depth or length data that will be entered or modified after the selection has been made. The last unit 

conversion chosen in a form is selected by default the next time you open this form.  

Use Display > Conversions to select the unit conversion for each entry form.  

 

Figure 5 – Conversion of lengths and depths units 

Possible conversions for lengths are: 

• None no conversion 

• ft > m enter the value in feet, it is converted to meters ( x 0.3048) when leaving the field 
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• in > m enter the value in inches, it is converted to meters ( / 12 x 0.3048) when leaving the 

field 

• in > ft enter the value in inches, it is converted to feet ( /12) when leaving the field 

Possible conversions for depths are: 

• None no conversion 

• ft > m enter the value in feet, it is converted to meters ( x 0.3048) when leaving the field  

When a conversion is applied, the fields involved become calculated fields, therefore in orange. The 

tooltip indicates in which unit the value should be entered. 

3.3.5. Navigate between fields  

To move from a field to another, use the [Enter] or [Tab] keys to go to the next field, or the [Shift]+[Tab] 

keys to go to the previous field. You can also use Field > Previous and Field > Next. 

3.3.6. Duplicate a value  

Use the [F3] key or Field > Duplicate to copy the value of the same field but from the previous record. 

This tool is very useful to quickly copy the same value in several records. 

3.3.7. Text editor  

All alphanumeric fields (texts) can be edited in a text editing window. Line breaks correspond to the “|” 

character of the forms. To open the text editor, use the keys [Ctrl]+[E]. 

3.3.8. Double-click 

The double-click can be used in several fields to facilitate data entry. 

• A double-click in a key field (turquoise background, such as site no, boring no, sample no, etc.) 

opens the parent table on the current record. 

• A double-click in a field referring to another table opens the corresponding table (client no, 

contract no, sieving method no, etc.). 

• A double-click in the text fields opens the Lists table if the type of selection is Default, Value, 

Description, + Value or + Description. 

• A double-click in the text fields opens the text editor if the type of selection is Distinct or No list. 

• A double-click in a date field opens a date editor. 

• A double-click in a field named FILE_NAME or PHOTO_NO opens the Windows file selection. 

3.3.9. Lists of values  

Alphanumeric (text) fields can have a drop-down list, showing either the records defined in the 

LIST_ENG table (or LIST_FRE if Geotec is used in French) for the corresponding table and field, or the 

values entered for that same field in other records of the database. 
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The list is opened with the button  displayed to the right of each field, with the [F9] key or via Field > 

List. 

The values of the LIST_ENG table (or LIST_FRE in French) can be edited via Display > Predefined Lists for 

the current table. It can also be opened by double-clicking in a field or via the + NEW item in the list, for 

the current field. See paragraph 10.7.   

The type of drop-down list for each field is defined with the Customize entry forms (Layout) (paragraph 

18). 

In Query mode (paragraph 11), the lists show all values for the current field in the records of the DB, as 

well as is NULL to search for records with no value in the current field. 

3.3.10. Contextual menu  

Click with the right button of the mouse in any field of the forms in Tabs mode, or on the header 

containing the field name in Datasheet or Columnar mode to open a contextual menu. 

 

Figure 6 – Contextual menu of the entry forms  

Type of selection defines the type of drop-down list to use. It can only be modified for Text fields. In 

some cases, such as primary keys and foreign keys, it is not possible to change the choice. 

• Default. The list shows the records from the LIST_ENG table, and if there are none, the existing data 

from the database, for the current field. 

• Distinct. The list shows the existing data in the database for the current field. 

• Value. The list shows the values from the LIST_ENG table for the current field. Only one choice can 

be selected at a time. 

• Description. The list shows the descriptions from the LIST_ENG table for the current field. Only one 

choice can be selected at a time. 

• + Value. The list is the same as for Value, but the choices are concatenated after each selection. 

• + Description. The list is the same as for Description, but the choices are concatenated after each 

selection.  

• No list. No list is displayed. 
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Format is only active for numeric fields and dates. It is used to modify the format of the values in the 

form. The format in the database is not changed. 

Protect is active except for key fields and required fields. 

• None. The field is not protected against editing.  

• Partial. The user can only select from the drop-down list. 

• Total. The field cannot be edited. 

Freeze is only active in Datasheet mode. It blocks the horizontal scrolling and keeps the columns to the 

left of the frozen one always fixed. 

The changes are saved directly with the form customization, i.e. in REPORT_COL table (paragraph 18). 

4. Calculation window 

When an entry form has a calculation function, the button  and Action > Calculate option are active. 

By selecting the option, a calculation window opens. Note that data must be retrieved (therefore in the 

entry form) to do calculations. 

 

Figure 7 – Calculation window 

• The name of the table involved is indicated in the title. 

• If multiple records are retrieved, the user can choose to calculate the results for the Current one 

only, or for All records, the number being indicated in the first message. If only one is retrieved, 

only the Current button is active. 

• For certain calculations (see the calculations detailed in the paragraph of each entry form), the user 

can choose to modify empty fields only, not existing values. To do this, check the Fill empty fields 

only box. Otherwise, the calculation modifies all existing values. When this option is not applicable 

in the calculation function, the box is disabled. 
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For example, for the calculation of stratigraphic descriptions, one may want to calculate only the 

records for which the descriptions are empty (that were not entered manually). 

• If an archived site or boring exists in the database, the box Also calculate archived data is active. 

Check this option to calculate also data that are archived. Otherwise, the records are ignored. 

If you write in the report, the archived data are listed when calculations are not done because the 

option was not checked. 

• The Calculations report options define the information presented to the user following the 

calculations. 

o By default, the report directory shows the directory of output files defined in the preferences. 
If it is modified here, it will also be modified in the preferences. 

o By checking Write in report, the daily report named Transactions_date.txt is updated with 
calculation information. Otherwise, the calculations are done but without a calculation report. 
Calculation information includes the number of records read and modified and the number of 
fields updated. 

o By checking View report, the daily report is shown on the form, with the text editor defined in 
the preferences (see the X3D documentation). This option is active only if “Write in report” is 
checked.  

o By checking Prompt at the end of the calculations, a window is displayed when calculations 
are done to show the number of records read and modified, and the number of fields updated. 

• Other options may be displayed depending on the calculation.  

5. Main entry forms  

Most of the Geotec data is related to four main tables, according to the data hierarchy (paragraph 1.1). 

In the Entry forms menu, these entry forms are opened via the 4 buttons at the top. 

5.1. Site form 

The form shows data from the SITE table of the Geotec database. It identifies and describes a site. It is 

the top of the hierarchical structure. 

The Limit <, Domain< and Map buttons are active only in the Site module. They are used to define a 

polygonal limit or the domain directly with the mouse, and to edit the map. See the Site documentation. 

• The site number is the key of the record. Enter up to 20 characters with letters, numbers and 

symbols - _ ( ) . Accents and other special characters cannot be used. 

In the Identification tab… 

• The type of site is alphanumeric with 3 characters and is used to categorize the site. 

• The municipal code allows up to 10 digits. The list of numbers and names of municipalities defined 

in the MUNICIPALITY table is suggested (paragraph 10.6). 
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• The geological province where the site is located can be selected. It is only used for contamination 

calculations. 

• The client number is alphanumeric with 20 characters. The list of client numbers and names 

defined in the CLIENT table is suggested (paragraph 10.2). 

• The project number is alphanumeric with 20 characters. The list of project numbers and names 

defined in the PROJECT table is suggested (paragraph 10.3). It will be copied in its borings. 

• The contract number is alphanumeric with 20 characters. The list of contract numbers and names 

defined in the CONTRACT table is suggested (paragraph 10.4). It will be copied in its borings  

• The region number is alphanumeric with 20 characters. The list of region numbers and descriptions 

defined in the REGION table is suggested (paragraph 10.5). 

• The plan number is alphanumeric with 40 characters. It is used to enter the number of the main 

plan in which the site appears. 

• The structure number is alphanumeric with 20 characters. 

• The description is alphanumeric with 255 characters to describe the site or the mandate. 

In the Location tab… 

• The position of the site's origin, i.e. its lower left corner, can be defined by its easting and northing 

(in meters), in the coordinate system, the NAD system and zone defined in the tab. 

• The site longitude and latitude can be entered or calculated. 

They are used in the Google Maps tool integrated to the modules. 

• The size of the site is defined with its width and height; in meters. 

• The location of the site is alphanumeric with 255 characters. 

• The coordinate system is either MTM or UTM. The information is needed for coordinate 

calculations. 

• The NAD projection system is either NAD27 or NAD83. The information is needed for coordinate 

calculations. 

• The zone where the site is located is entered. Automatically, it will be copied as the zone of its 

borings, but can be modified. The information is needed for coordinate calculations. 

• The angle is the orientation of the site domain with respect to the geographic North. The angle is 

between 0 and 360 degrees. 

In the Management tab... 

• The archiving code is noted with character A for 'archived'. When a site is archived, it is not 

possible to modify, delete or insert data. 

• The archiving date is noted in the format yyyy-mm-dd hh:mi:ss. 



DATA ENTRY FORMS | Version 8.12.1 | Page 22 

  

• The person who archived the site (archived by) is alphanumeric with 40 characters. 

• The remark on archiving is alphanumeric with 255 characters. 

• A cartographic file can be associated to the site, with a maximum of 255 characters. By clicking on 

the button right of the field, the Windows file selection screen opens. This cartographic file can be 

displayed in the Pro and Site modules. 

To save the file name with its full path, enable the option in the preferences. See the X3D 

documentation. 

• The unit system is either SI (international system) and IM (imperial system). By default, SI is used 

even if the field is empty. 

• Grouping is used to group sites together; with 5 characters. 

• Category is used to enter a code to categorize the site, with 20 characters. 

• Transfer is a 1-character code to classify records for their management. 

At the bottom of the form, a list of tables linked to SITE is available. The number in parentheses next to 

the table name indicates the number of records associated with the current site. By clicking on a table, 

the form opens either on the existing values, or in "new" mode. The list includes Axis, Boring, Client, 

Contract, Project and Regions. 

5.1.1. Calculations 

Geotec calculates the longitude and latitude of the site. The coordinate system and NAD must be 

defined for the site. 

• If easting, northing and zone are entered, Geotec converts them to lat-lon. 

• If the width and height are also entered, Geotec calculates the site center in meters while taking 

into account the angle, then converts into lat-lon. 

• If easting, northing or zone is not entered, Geotec calculates the average of the longitudes and 

latitudes of the site’s borings. 
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Figure 8 – Site entry form 

5.2. Axis form  

The form shows data from the AXIS table and its secondary tables AXIS_PI, AXIS_STRATA and 

AXIS_PROFILE of the Geotec database. It is used to define axes or cross-sections. It is in the hierarchical 

structure (Figure 1) just under SITE. 

The Points< button is only active in the Site module. It is used to define the axis points directly with the 

mouse. See the Site documentation. 

• The site number and the axis number together constitute the key of the records. 

• The site number identifies the site of the axis. The drop-down list shows all sites defined in the SITE 

table. 

• The axis number identifies the axis. Enter up to 20 characters with letters, numbers and symbols - _ 

( ) . Accents and other special characters cannot be used. 

In the Identification tab… 

• The type of axis is a code of 3 characters maximum. The axis is generally a surveyed line (LA) or a 

seismic line (LS).  

In Pro, the profiles of seismic lines can be projected onto the main axis. Their type must be LS in 

order to be processed.  

• State is a 1-character field indicating is the location of the axis is Planned, Realized or Validated. 

• Chainage is the chainage of the first point, in meters. The chainage is numeric. 

• Range is the distance beyond which the borings are not projected on the profile views in the Pro 

module, in meters. It is a numeric value. 

If no distance is entered, Pro will use the distance set in the Pro options. If a distance is saved in the 

database, it overrides the option set in Pro. 

• Spacing is used to enter the normal spacing between geophones measuring seismic velocities; in 

meters. 

Pro takes this distance into account when displaying profiles. If the distance between two 

measurements in the AXIS_PROFILE table is greater than the spacing, the profile is not drawn 

between these two measurements. 
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• The phase is alphanumeric with 20 characters with Preliminary, Final and Revision as choices. 

• The contract number is alphanumeric with 20 characters. The list of contract numbers and names 

defined in the CONTRACT table is suggested (paragraph 10.4). 

• The contractor who did the surveying is entered; with 40 characters. 

• The location of the axis is alphanumeric with 80 characters. 

• The description is alphanumeric with 255 characters to describe the axis. 

In the Management tab... 

• The Realized by, Verified by, and Approved by fields allow 40 characters. 

• Dates of survey, verification and approval are noted in the format yyyy-mm-dd hh:mi:ss. 

• Remark is alphanumeric with 255 characters for other notes.  

• Transfer is a 1-character code to classify records for their management. 

5.2.1. Survey points  

The Survey points tab at the bottom of the Axis form shows data from the AXIS_PI secondary table of 

the Geotec database. The tab is used to define the implementation points of the axes. 

The control points of an axis can be the end points, the break points off the axis if it is a broken line, 

and/or the intersection points (“  ”) for the tangents at the beginning and end of curved sections.  

• The site number, the axis number and the index together constitute the key of the records. 

• The index (I) is the sequence number of the control points. It is an integer. 

• The X and Y coordinates of each point are then entered, in meters. Coordinates should be entered 

in the coordinate system, NAD system and zone defined in the site of the axis. These are double 

precision numbers with 3 decimal places. Values are required. 

• The radius of curvature (R) is “0” if the axis is a broken line, and more than “0” if the point is a PI. 

The curvature direction is defined by the position of the control points around the current point. 

• Tag is used to enter the identification of the point, or tag, with up to 20 characters. The tags mainly 

characterize the PI of a surveyed or seismic line. 

• A plan number is used to enter the number of the reference plan containing the information. This 

number can be up to 40 characters long. 

• Transfer is a 1-character code to classify records for their management. 

5.2.2. Material for the strata  

The Material for the strata tab at the bottom of the Axis form shows data from the AXIS_STRATA 

secondary table of the Geotec database. The tab is used to define the materials of the layers. 

• The site number, the axis number and the material together constitute the key of the records. 
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• Material indicates the material type of the layer. The list of materials and their description defined 

in the MATERIAL table is suggested (paragraph 10.9). 

• The mean seismic velocity for the material type is defined. The suggested unit is m/s. 

5.2.3. Seismic lines  

The Seismic Lines tab at the bottom of the Axis form shows data from the AXIS_PROFILE secondary table 

of the Geotec database. The tab is used to define a layer profile along a given axis and the measured 

seismic velocities. 

• The site number, the axis number, the material and the distance (D) together constitute the key of 

the records. 

• The material indicates the type of material of the layer for which the survey or seismic profile is 

done. The list shows the materials inserted in AXIS_STRATA for the same site and axis. 

In Pro and Site, the color used for the profiles is the one associated with the material defined in the 

MATERIAL table. 

• The distance (D) contains the chainage of the profile point. Chainage is double precision with 3 

decimal places. 

• The elevation (Z) of each profile point is then entered; in meters. A value is required. 

• The X and Y coordinates of each profile point can be entered, in meters. The coordinates are in the 

coordinate system, NAD system and area defined in the site of the axis. 

• The velocity contains the seismic velocity recorded at each point for the layer represented by the 

type of material. The suggested unit is m/s. 

• Transfer is a 1-character code to classify records for their management. 

 



DATA ENTRY FORMS | Version 8.12.1 | Page 26 

  

 

Figure 9 – Axis entry form 

5.3. Boring form 

The form shows data from the BORING table of the Geotec database. It identifies and describes a boring. 

It is in the hierarchical structure just under SITE (Figure 1). 

The Borings< button is only active in the Site module. It is used to define the location of projected 

borings directly with the mouse. See the Site documentation. 

• The site number and the boring number together constitute the key of the records. 

• The site number identifies the site of the boring. The drop-down list shows all sites defined in the 

SITE table. 

• The boring number identifies the boring. Enter up to 20 characters with letters, numbers and 

symbols - _ ( ) . Accents and other special characters cannot be used. 

In the Identification tab… 

• The boring type is a 2-character code to specify the nature of the boring. The default types present 

in the Geotec database are listed below. If the type is present in the lists table, its description is 

displayed in the field right of the Type field. 

Table 1 – Default types of borings 

Type Description Type Description 

CO Cobra TP Test pit 

CP Piezocone PZ Stand alone piezometer 

AT Air track  QC Quality control 

GP Guelph permeameter AS Auger sample hole  

MA Manual sampling HA Hand auger 

PT Dynamic penetration test BH Borehole 

SP Static penetrometer TR Trench 

• State is a 1-character field indicating whether the boring is Planned, Realized, Validated or 

Archived. When a boring is archived, it is not possible to modify, delete or insert data. 

• The stop code is a 1-character field indicating the reason for the end of boring, such as on Blocks, at 

Determined depth, Forced, Undetermined, on probable Rock and Voluntary. 
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• The reference can contain a code indicating the reference elevation: the elevation of the natural 

terrain (NG) or the elevation of the drill floor (FL). The calculations are always made with the NG. 

• The ground level at the location of the boring is entered; in meters. It is used in various elevation 

calculations. If the ground level is modified, the piezometric levels of the borehole can be 

recalculated. 

• The floor level of the drill, for a borehole, is entered; in meters. 

• The total depth of the boring is automatically incremented when data is entered in the other 

forms. It can also be changed manually. 

• The rock depth is inserted automatically when the first rock layer (type R) is entered for the boring. 

It can also be changed manually. 

• The natural soil depth is entered; in meters. 

• The sloughing depth is entered; in meters. 

• The boring start and end dates are in format yyyy-mm-dd hh:mi:ss. 

• The project number is alphanumeric with 20 characters. The list of project numbers and names 

defined in the PROJECT table is suggested (paragraph 10.3). It was copied from the site if it was 

defined.  

• The contract number is alphanumeric with 20 characters. The list of contract numbers and names 

defined in the CONTRACT table is suggested (paragraph 10.4). It was copied from the site if it was 

defined.  

• A parent boring can be defined for the boring. The drop-down list shows all borings from the same 

site. Data from the boring and its parent can be displayed simultaneously in Log. See the Log 

documentation. 

• Remark is alphanumeric with 255 characters for other notes.  

• The contractor for drilling is entered; with 80 characters. 

• The dossier number of the contractor is entered; with 40 characters. 

• The source is used in the control of materials and indicates where the material was taken; with 20 

characters. 

• Material indicates the type of material for the control of materials, with 20 characters. The list of 

materials and their description defined in the MATERIAL table is suggested (paragraph 10.9). 

In the Location tab… 

• The zone where the boring is located is entered. It was copied from the site if it was defined. The 

information is required for coordinate calculations. 

• The easting and northing of the boring can be entered or calculated, in meters, in the coordinate 

system and NAD defined in the site of the boring. 
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• Longitude and boring latitude can be entered or calculated. 

They are used in the Google Maps tool integrated to the modules. 

• The dip of the boring (in degrees) is entered. It is used in various elevation calculations and in 

projections.  

• The azimuth of the boring (in degrees) is entered. It is used in projections. 

• The reference is alphanumeric with 40 characters to indicate the type of boring reference (for 

example: geodesic, arbitrary). 

• The plan number is alphanumeric with 255 characters. It is used to enter the number of the main 

plan on which the boring is shown. 

• The boring location is alphanumeric with 80 characters. 

• The axis number is a string of 20 characters. The axes defined in the AXIS table are shown in the 

list. The Pro module shows the borings whose coordinates are defined. If a boring does not have 

coordinates but has an axis number, a chainage and possibly an offset, Pro will show this boring 

along the axis using the defined chainage and offset. 

• The chainage and offset to the centerline determine the position of the boring relative to the axis. 

If an axis number is associated to the boring, the chainage and offset will apply for the 

representation of the boring along this axis specifically, if the two coordinates of the boring are not 

defined. 

According to geotechnical convention, if a boring is to the left of the axis line, its offset is negative. 

To determine the left and right of an axis line, look towards the increasing chainages. 

In the Equipment tab… 

• The drill used is entered; with 40 characters. 

• The type of hammer used for driving the sampler is entered, with 40 characters. 

• The fall height of the hammer is entered; the suggested unit is the meter. 

• The fluid used for drilling is entered, with 40 characters. 

• The list of casings is written, with 40 characters. 

• The diameter of the main casing used is entered, in millimeters. 

• The corer used for drilling is entered; with 40 characters. 

• The diameter of the corer is entered, in millimeters. 

• The A/R field is used to indicate whether the azimuth is apparent (“ ”) or real (“ ”). 

• The type of compass is indicated by “0” if pivoting, or “1” if gyrating. 

In the Hydrogeology tab… 
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• For the groundwater, up to 2 measurements can be entered with:  

o The depth of the water table; suggested unit is meter 

o The measurement date, in the format yyyy-mm-dd hh:mi:ss 

o The casing depth at the time of measurement (in meters) 

o The stabilization time, in hours 

o Five remarks of 2 characters can be added regarding the groundwater measurement. 

• For piezometric installations: 

o Barometric correction can be applied for vibrating wire piezometers and water level 
dataloggers such as Level Logger. 

Select the barometric station to associate to the nest of piezometers installed in the boring. 
The list of barometer numbers defined in the BAROMETER table is suggested. Double-click in 
the field to open the Barometer table.  See paragraphs 6.3.3 and 6.4 for the piezometer 
calculations and barometer definition, respectively.  

Enter a default B1 value. This value is used if there is no barometric pressure for the date of 
the piezometric level. 

o To display on the boring log the water depth on a specific date, enter a Selected date in the 
format yyyy-mm-dd hh:mi:ss. Otherwise, the latest reading date is used.  

• A non aqueous phase liquid observed in the boring can be described with: 

o Its depth; suggested unit is meter 

o Its measurement date, in the format yyyy-mm-dd hh:mi:ss 

o The type of contaminant 

o The thickness of the non aqueous phase liquid; in millimeters. 

In the Management tab... 

• The Driller, Technician, Compiled by, Verified by, Approved by, and Project manager can have up 

to 40 characters. 

• The printing date of the boring report is automatically inserted into the database by Log when the 

user prints a boring report. 

• When a record belonging to the current boring is modified and saved, the modification date is 

updated. 

• A style file associated to the boring can be defined, with 255 characters. This field is used by Log if 

the parameter is checked in the options of Log. 

• A photo can be associated to the boring, with a maximum of 255 characters. By clicking on the 

button right of the field, the Windows file selection screen opens. The photo can be displayed if an 

object in the style file is associated with this field in Log. 
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To save the photo with its full path, enable the option in the preferences. See the X3D 

documentation. 

• A photo description can be entered, with 255 characters. 

• The scale can be entered (number of meters on field per meter on paper). It will be used by Log in 

the boring display, if the parameter is checked in the options of Log 

• The precision on the level allows you to enter the accuracy on the reading of the elevation of the 

boring which depends on the method of obtaining: GPS, surveying, etc. 

• Category is used to enter a code to categorize the boring, with 20 characters. 

• Transfer is a 1-character code to classify records for their management. 

In the Validation tab, there are fields added and described by the City of Montreal. 

At the bottom of the form, a list of descriptive tables linked to BORING as well as a list of in situ tests is 

available. The number in parentheses next to the table name indicates the number of records associated 

with the current boring. By clicking on a table, the form opens either on the existing values, or in "new" 

mode. 

The list of descriptive tables includes Casings (Boring methods), Cobbles, Ground, Observations, 

Piezometers, Rock Joints, Runs, Samples, Stratigraphy and Trench / Test pits.   

The list of in situ tests includes Absorption, Cobra, Concentrations, Static Cone, Piezocone, Dynamic 

Cone, Geocamera, Lugeon, Permeability, Pressuremeter, Property values (Other properties) and Vane. 

5.3.1. Calculations 

Geotec calculates the longitude and latitude of the boring, or its X and Y coordinates. In both cases, the 

coordinate system and the NAD must be defined for the site of the boring. The user chooses which 

conversion to do in the Calculation window. 

• By selecting to calculate longitudes and latitudes, Geotec uses the easting, northing and zone of the 

boring to convert into lat-lon. 

• By selecting to calculate coordinates, Geotec uses the longitude and latitude to convert into 

easting, northing and zone. 
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Figure 10 – Boring entry form 



DATA ENTRY FORMS | Version 8.12.1 | Page 32 

  

5.4. Sample form  

The form shows data from the SAMPLE table of the Geotec database. It is used to describe the samples 

taken along a borehole. It is in the hierarchical structure just under BORING. All laboratory tests will be 

linked to the defined samples. 

• The site number, the boring number and the sample number together constitute the key of the 

records. 

• The site and boring numbers identify the boring along which the sample was taken. The drop-down 

lists show all sites that have a least one boring defined in the BORING table, then all borings of the 

BORING table for the selected site. 

• The depth increment can be entered. A new sample will be positioned at a depth equal to the top 

depth of the previous sample plus the increment. 

Without an increment, sampling is considered continuous. A new sample will be positioned at a 

depth equal to the bottom depth of the previous sample. 

• When adding samples, choose the sample state via the radio buttons or use the same sampler as 

the previous one. 

o If the box Same sampler is checked, the state, type and length of the previous sample are 
copied to the new one and the number is automatically incremented. 

o If the box Same sampler is not checked, all fields are inactive until the state is chosen. Choose 
between remolded, intact, core or grab. The type and length associated with the state are then 
entered and the number is automatically incremented.  

•  The sample number identifies the sample or subsample. Enter up to 19 characters with letters, 

numbers and symbols - _ ( ) . Accents and other special characters cannot be used. The number is 

copied to the Parent field, which is used only for subsamples. 

o The number of the first sample is suggested as 01. Modify it if desired. 

o The number of the samples added in the current boring is based on the previous sample 
(number and format). For example: 

With 002, the next will be 003. With GL-10, the next will be GL-11. 

In the Description tab… 

• The State field mirrors the top radio buttons. Depending on the state of the sample, some fields are 

disabled. A default type and length are associated with each state if radio buttons are used (not 

Same sampler). These can be specified by editing the drop-down list of the STATE field in the lists 

table. 

Values must be G, R, I and C. Descriptions are specified as: label, type, length (in meters). If the 

types and lengths are not specified, Geotec uses: 

  →  emoulded,   , 0.6096  

  →  ndisturbed,   , 0.6096  
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  →  ock core,   , 1.524 

  →  rab,   , 0.3048 

The state is used in Log, Pro and Site to symbolized the samples. 

• The sample type is a 3-character code to indicate the type of sampler used to take the sample.  

When a new sample is added, the type of the previous or the type associated to the state is 

suggested but can be modified. The default types present in the Geotec database are listed below. 

Table 2 – Default types of samplers 

Code Sampler Code Sampler 

AS Auger sampler SC Split corer 

CT Corer tube SS Split spoon 

CR Diamond rock core ST Thin wall sampler (Shelby) 

GB Grab sample TW Thin wall sampler 

MA Manual VI Vibration 

PS Piston sampler WC Water content 

QC Quality control sample WS Wash sample 

• The top depth of the sample is entered; in meters. When a new sample is added, the top depth is 

suggested by default, based on the depth increment. 

• The sample length is either entered directly, or calculated by entering the bottom depth. When a 

new sample is added, the length of the previous one or the length associated with the state is 

suggested. 

• The bottom depth of the sample is not a field of the database. It is calculated when the user enters 

the length. If the user enters a bottom depth for the sample, its length will be calculated. 

• The caliber of the casing or corer is entered; with 10 characters.  

• N1 to N6 are the number of blows per six inches; as integers. 

• N is the standard penetration value; this value is the sum of N2 and N3. The N value is shown 

automatically when N2 and N3 are entered; the user can modify it. 

• A remark on N can be entered with 40 characters, typically to indicate a refusal length. 

• Driving energy can then be entered, a numeric value. 

• Recovery length is not a database field. By entering a value, the recovery (%) is automatically 

calculated. 

• The recovery (in %) can be calculated from the length entered, or entered directly. If the recovery 

is 0%, Log, Pro and Site symbolize the sample state as 'Lost'. 

• The cumulative length of pieces greater than 4 inches (RQD) is not a database field. By entering a 

value, the RQD is automatically calculated. 

• The RQD (%) can be calculated from the length entered, or entered directly. 
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• Pocket penetrometer (PP) resistance is numeric, in kPa. 

• USCS classification can be entered or calculated. 

If the USCS field is shown in Log, Pro or Site, the color of the material defined in the MATERIAL table 

or the pattern starting with U_ can be displayed. See the Log documentation. 

• Tests is alphanumeric with 255 characters and is used to list other in-situ or laboratory tests done 

on the sample. 

• Chemical analyses is alphanumeric with 255 characters and is used to list the chemical analyses 

done on the sample. 

• The description of the sample can be done via the soil description matrix which opens via the icon 

. The matrix is described in paragraph 6.2. The description can also be entered manually, with 511 

characters. A rock description matrix is for future development. 

In the Management tab... 

• The sampling date is in yyyy-mm-dd hh:mi:ss format. 

• The sample lab number is alphanumeric with 20 characters maximum. 

• The duplicate number is added, if desired, with 20 characters. 

• The intact tube number can be entered, up to 10 characters. 

• A photo can be associated to the sample, with a maximum of 255 characters. By clicking on the 

button right of the field, the Windows file selection screen opens.  

To save the photo with its full path, enable the option in the preferences. See the X3D 

documentation. 

• The Sampled by, Compiled by and Verified by fields are used to enter name of the technician, the 

person who compiled the information, and the inspector when the sample was taken. 

• Remark is alphanumeric with 255 characters for additional details on the sample. 

• When a modification to the sample is saved, the modification date is updated. 

• Transfer is a 1-character code to classify records for their management. 

• To estimate the exploitable height of a borrow pit, we have the material and its top and bottom 

depths. The list of materials and their description defined in the MATERIAL table is suggested. If the 

sample lies within a stratigraphic layer, the top and bottom depths of the layer are indicated. 

If the Material field is displayed in Log, Pro or Site, the color of the material defined in the 

MATERIAL table can be displayed. 

• When the calculation is done (via the button  or using Action > Calculate), the calculation date is 

updated. 

In the Properties tab... 
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• The percentage of organic matter and the concentration of VOC (volatile organic compounds) are 

8-character and alphanumeric. 

• The olfactory and visual observations are alphanumeric with 4 characters, to describe the 

organoleptic observations. 

• Rock properties are obsolete fields and should be used via the RUN table (i.e. rock strength, degree 

of fragmentation, number of joints, joint set number and weathering). 

At the bottom of the form, a list of laboratory tests is available. The number in parentheses next to the 

table name indicates if a test is associated to the current sample. By clicking on a table, the form opens 

either on the existing values, or in "new" mode. 

The list of laboratory tests includes Concentrations, Consolidation, Density, Fall Cone (Swedish cone), 

Grain size analysis, Soil Relative Density, Consistency Limits, Proctor and Shear. 

5.4.1. Sub-samples 

Sub-samples are added to the current sample via the Add a sub-sample button. 

• The Add a sub-sample button is active when positioned on: 

o A sample that has no subsample. 

o The last sub-sample of a sample, if the bottom depth of the sample has not been reached. 

• By clicking on the button, the number of the first sub-sample is set to 'A'. The value can be modified 

but must have 1 character only. The number of subsequent sub-samples increments alphabetically. 

This number is concatenated to the number of the main sample (parent) and copied in the Sample 

field, e.g. 002A, GL-11C. 

• The top depth of the sub-sample is suggested and can be changed. For the A, it is suggested as the 

top of the main sample. For the following, it is suggested as the bottom of the previous sub-sample. 

• The length of the sub-sample is entered, or can be calculated by entering the bottom depth. 

• The bottom depth of the sub-sample must be entered for the A. It is suggested for the following as 

the bottom of the main sample. 

• The description of the sub-sample is done the same way as the main sample. Logically, if sub-

samples are present, the main sample will not be described. 

• Several fields are disabled for sub-samples (including N, recovery, RQD, etc.). All other fields can be 

entered as for samples. 

5.4.2. Create a stratigraphic layer 

Stratigraphic layers can be created from the samples. The button Create a stratigraphic layer is active 

when positioned on a sample or a sub-sample and its bottom depth is greater than the maximum 

bottom depth found in the STRATIGRAPHY TABLE for the current boring.  
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By clicking on the button, the description matrix opens and a new layer is proposed.  

• The layer begins at the bottom depth of the previous layer, or at 0 if there is no layer yet.  

• The layer ends:  

o At the top depth of the current sample or sub-sample if its Description is empty.  

o At the bottom depth of the current sample or sub-sample if it has a Description.  

o The bottom depth of the layer can be modified if necessary. 

• The matrix shows a weighted average of the descriptive elements of all samples and sub-samples 

found between the top and bottom of the layer. The values can be modified. By clicking OK, the 

layer is saved. 

5.4.3. Calculations 

Geotec calculates the description of the sample or sub-sample based on the values selected in the 

matrix (paragraph 6.2). The user has the choice to modify all descriptions in the calculation, or only the 

records whose description is empty. To do this, check the box Fill empty fields only. 

This makes it possible to quickly calculate the sample descriptions in English or French without having to 

reopen the matrix for each sample. 

 



DATA ENTRY FORMS | Version 8.12.1 | Page 37 

  

 

 

Figure 11 – Sample entry form 

6. Entry forms for boring description 

In the Entry forms menu, the entry forms for boring description are available via the buttons of the first 

tab. They include the stratigraphy description, installation of wells or piezometers, description of 

trenches, boring methods, and fields observations. 

6.1. Stratigraphy form 

The form shows data from the STRATIGRAPHY table of the Geotec database. It is used to describe the 
stratigraphy along a boring. 

• The site number, the boring number, the type of strata and the top depth together constitute the 

key of the records. 

• The site and boring numbers identify the boring along which the stratigraphy is described. The 

drop-down lists show all sites that have a least one boring defined in the BORING table, then all 

borings of the BORING table for the selected site. 

• The strata type is a 1-character code, either S, R, T, E or U. 

o Simplified (type S): for soils. It is recommended to use the soil description matrix (paragraph 
6.2). 

o Rock (type R): for rocks. The top depth of the first rock layer is copied into the ROCK_DEPTH 
field of the boring. 

o Text (type T): to display a remark at a specific depth without creating a layer. 

o End of boring (type E): to add a custom description explaining the end of boring conditions, 
which will be displayed at the bottom of the boring report. 
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o Unified (type U): for future development, with selection of the unified classification. 

• The top depth of the layer is required. By default, the top of the first layer is at 0 meter (or feet). 

The top of subsequent layers is equal to the bottom of their previous layer. These values can be 

modified. 

• The bottom depth of the layer is entered, if applicable. The bottom depth is required for strata of 

type S, R and U. 

• The description of the strata can be done via the soil description matrix which opens via the icon , 

for the layers of type S. The matrix is described in paragraph 6.2. The description can also be 

entered manually, with 511 characters. A rock description matrix is for future development. 

• The stratigraphic code defines the materials of the layer. The use of the field varies depending on 

the selected strata type. The code is filled in automatically if materials are selected via the matrix 

(paragraph 6.2). 

o Type S (simplified): this code is filled in automatically if the matrix is used. Up to 6 materials 
can be defined. The drop-down list shows the materials named S_name in the current patterns 
file (.ptn). 

o Type R (rock): the user defines the dominant rock material. The drop-down list shows the 
materials named R_name in the current patterns file (.ptn). A large number of R-type patterns 
can be found in the geotec8.ptn patterns file. 

o Type T (text): stratigraphic code is not used. 

o Type E (end of borehole): to show that the boring stopped on rock, enter R in the stratigraphic 
code, which will display a rock symbol in the boring report. Otherwise, the code is not used. 

o Type U (unified): the user defines the material of the layer according to USCS classification. The 
drop-down list shows the materials named U_name in the current patterns file (.ptn). The U-
type materials found in the geotec8.ptn patterns file are listed below. 

Table 3 – Unified classification 

Symbol Component Symbol Component 

GP Poorly-graded gravel OL Organic silt 

GW Well-graded gravel MH Highly plastic silt 

SP Poorly-graded sand CH Highly plastic clay 

SW Well-graded sand OH Organic clay 

ML Low plasticity silt Pt Peat 

CL Low plasticity clay   

The Log, Pro and Site modules will use the stratigraphic code and relative proportion, if applicable, to 

display stratigraphic symbols representing each layer. 

• The relative proportion is filled in automatically if the soil matrix is used. It is used only for a type-S 

layer and can have a maximum of 6 digits. It indicates the relative proportion of each material 

defined in the stratigraphic code. 

o 1: dominant material (> 35%) 



DATA ENTRY FORMS | Version 8.12.1 | Page 39 

  

o 2: lower abundance material (20% to 35%) 

o 3: scarce material (10% to 20%) 

o 4: trace material (1% to 10%) 

For example, silty sand, some clay, trace gravel will be listed as: 

Code = SMCG and Proportion = 1234 

For other types, leave the field empty or put 1. 

• The top line allows you to force a type of line at the top depth of the layer in the boring report. 

o L0 removes the separator line 

o L1 puts a solid line 

o L2 puts a dotted line 

o L3 puts a dashed line 

• Layer material is alphanumeric with 20 characters. The list of materials and their description 

defined in the MATERIAL table is suggested (paragraph 10.9). 

If the Material field is displayed in Log, Pro or Site, the color of the material defined in the 

MATERIAL table can be displayed. 

• The wet density of the layer is recorded, in kg/m3. It can be used in the calculations of the vertical 

stress in the Piezocone form (paragraph 8.3). 

• The type of deposit is a 2-character code. 

• Geological formation is a 3-character code. 

• Geological group is a 2-character code. 

• Properties 1 to 4 are additional 3-character codes to describe other properties of the layer, if 

needed. 

• When a modification to the stratigraphy is saved, the modification date is updated. 

• When the calculation is done (via the button  or using Action > Calculate), the calculation date is 

updated. 

• The priority is an integer allowing to define the priority of the layer relative to the deposit 

sequence. 

• Transfer is a 1-character code to classify records for their management. 

6.1.1. Calculations 

Geotec calculates the description of type-S layers based on the values selected in the matrix (paragraph 

6.2), which includes the stratigraphic code and the relative proportion. The user has the choice to 

modify all descriptions in the calculation, or only the records whose description is empty. To do this, 

check the box Fill empty fields only. 
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This makes it possible to quickly calculate the layer descriptions in English or French without having to 

reopen the matrix for each layer. 

Records of type E, T, U or R are not affected by the calculations. 

 

Figure 12 – Stratigraphy entry form 

6.2. Soil description matrix (samples and layers) 

The soil description matrix is used to describe soils from samples and sub-samples (paragraph 5.4) and 

from stratigraphic layers (paragraph 6.1). It opens via the icon right of the Description field. 

By selecting the descriptive elements, the textual description is automatically generated according to 

the following order. It is displayed in the middle of the matrix. 

Category. Material (size), gradation, shape, color, oxidation, density / consistency, 

plasticity, moisture, calcareous. Structure. Presence (%) (list of debris). Inclusions. Evidence 

of contamination. 

The sample number, sub-sample number, or layer depths are shown at the top left of the matrix. 

The Copy from previous button at the top copies the matrix information from the previous record as 

well as the description, if any manual edits were done.  

Click Cancel to exit the matrix without keeping the changes. Click OK to exit the matrix and copy the 

generated description in the Description field of the table. It will replace a description that has already 

been entered. 
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Figure 13 – Soil description matrix  

Category 

The category is the main type of soil or rock. The category can be presented in boring reports in bold, 

italic, underlined and/or capital letters. 

Materials 

The materials can be selected at 2 places: 

• Either via the radio buttons to indicate the proportions of clay, silt, sand and gravel. 

o  he first material selected is set to ‘ ain’.  

o  nly two materials can be selected as ‘ ain’; the third being automatically set to ‘ djective’ 
for a maximum of 100% material.  

o To remove a material selection, touch the radio button again.  
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• Either via the drop-down list at the top right of the matrix. Only one can apply per sample or layer.  

The codes corresponding to the materials selected (either from the drop-down list, the proportions 

table or the presences) are indicated in the field of the drop-down list, as information. Up to 6 materials 

can be selected. The proportions are also indicated next to the drop-down list, with the first digit 

corresponding to the first code, the second digit to the 2nd code, etc. Patterns associated to the codes 

and proportions are displayed in Log, Pro and Site. These values are saved in the CODE1 and PROP fields 

of the SAMPLE and/or STRATIGRAPHY tables. 

• A main material (from the table or the drop-down list) has a proportion of 1 (> 35%) 

• An adjective has a proportion of 2 (20-35%) 

• 'Some' has a proportion of 3 (10-20%) 

• 'Trace' or 'Presence' has a proportion of 4 (< 10%) 

Primary and secondary materials may be presented in boring reports in bold, italic, underline and/or 

capital letters. 

Presence (%) of cobbles, boulders and organic matter 

You can add the percentage of cobbles, boulders and organic matter in the text field, as well as the 

maximum diameter.  To see it in the description, check its box.  

Debris 

This is an 80-character field to list all debris. Check its box to see them in the description. 

Color 

The color can be entered, with 40 characters. It is included in the description. 

Structure 

The soil structure can be entered. It is included in the description. It can provide information about the 

geologic origin, the in-situ permeability, the contaminant pathways, etc.   

Inclusions and contamination 

Any inclusion or contamination can be indicated here, with 80 characters. These values are added at the 

end of the description.  

Particle size 

When sand is selected in the proportions table, the Sand item becomes active at the bottom of the 

matrix. Same thing with gravel. Up to 2 checkboxes can be selected. The particle size will be indicated in 

parentheses in the description.   

Gradation 

The gradation can be defined.  ne checkbox can be selected.  t’s included in the description.  

Density or consistency 
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If we have a clay or a silty clay with no other main material, the Consistency item is present and up to 2 

checkboxes can be selected. Otherwise, the Density item is present and up to 2 checkboxes can be 

selected. It is possible to force the use of Density or Consistency via the Cohesionless / Cohesive button 

at the top right. 

If the N-value is entered in the sample definition, the corresponding density or consistency is 

automatically selected based on Table 4. The selection can be modified. The density or consistency 

range is included in the description. 

Table 4 – Density or consistency based on N-value 

N-value Density  N-value Consistency 

< 5 Very loose  < 3 Very soft 

5-10 Loose  3-4 Soft 

11-30 Compact  5-8 Firm 

31-50 Dense  9-15 Stiff 

> 50 Very dense  16-30 Very stiff 

   > 30 Hard 

Oxidation 

 he oxidation state can be defined.  ne checkbox can be selected.  t’s included in the description.  

Plasticity 

 he plasticity can be defined.  p to 2 checkboxes can be selected.  t’s included in the description.  

Particle shape 

When gravel, cobbles or boulders is selected, the Shape item appears at the bottom of the matrix. Up to 

2 checkboxes can be selected to describe the angularity. The particle shape is included in the 

description.   

Moisture 

 he moisture can be defined.  p to 2 checkboxes can be selected.  t’s included in the description.  

Calcareous 

 he calcareous state can be defined.  p to 2 checkboxes can be selected.  t’s included in the description. 

6.3. Piezometer form 

The form shows data from the PIEZOMETER table and its secondary tables PIEZOMETRIC_LEVEL and 

PIEZOMETER_SEAL of the Geotec database. It is used to define the characteristics of the piezometers, 

observation and pumping wells, as well as the different materials used for their installation and the 

piezometric levels recorded. 

• The site number, the boring number and the piezometer number together constitute the key of 

the records. 



DATA ENTRY FORMS | Version 8.12.1 | Page 44 

  

• The site and boring numbers identify the boring where a well or piezometer(s) have been installed. 

The drop-down lists show all sites that have a least one boring defined in the BORING table, then all 

borings of the BORING table for the selected site. 

• The piezometer number identifies the piezometer. Enter up to 20 characters with letters, numbers 

and symbols - _ ( ) . Accents and other special characters cannot be used. 

• The installation code is selected. The code’s description is automatically copied into the field to its 

right, which can be edited. The drawing of the installation and the calculations vary according to the 

code selected. 

o H for Hydraulic or T for Open Tube 

o S for Sleeve or R for  ’ring 

o E for Electric or V for vibrating wire 

o P for Pneumatic 

o L for water level datalogger such as Level Logger 

• The type of installation is filled based on the code selected and can be modified. It is 80-character 

alphanumeric. 

• The serial number of the piezometer installed is noted with 20 characters. 

• A maximum interval between 2 measurements of piezometric levels (in days) can be imposed, for 

the Time module. When the number of days between two consecutive measurements is greater 

than the imposed interval, the curve will be interrupted between these two measurements. With a 

value of 0, no discontinuity is made. 

• The type of sealer used is enter, with a maximum of 80 characters. 

• The Stop code is a 1-character field indicating the reason the well / piezometer stopped being 

driven, such as Forced, Undetermined and Voluntary. 

• The installation date is noted in the format yyyy-mm-dd hh:mi:ss. 

• When a modification to the installation is saved, the modification date is updated. 

• When the calculation is done (via the button  or using Action > Calculate), the calculation date is 

updated. 

• The screen code is selected. The code’s description is automatically copied into the field to its right, 

which can be edited. The drawing of the screen varies according to the code selected. 

o C for Casagrande (drawn as a rectangle) 

o T for Pierced Tube (drawn as a rectangle with horizontal lines) 

o P for Point (drawn by a rectangle and a triangular tip at the end) 

• The type of screen is filled based on the code selected and can be modified. It is 80-character 

alphanumeric. 



DATA ENTRY FORMS | Version 8.12.1 | Page 45 

  

• Opening is the size of the openings in the screen; in millimeters. 

• The screen length is entered; in meters. It is used in the drawing and calculations. 

• The bottom depth of the screen is entered; in meters. It is used in the drawing and calculations. 

• The screen diameter is entered, in millimeters. 

• The protector code is selected. The code’s description is automatically copied into the field to its 

right, which can be edited. The drawing of the protector varies according to the code selected. 

o B for protective box (drawn as a box around the tube) 

o T or other for protective casing (drawn as vertical rectangles surrounding the tube) 

• The type of protector is filled based on the code selected and can be modified. It is 80-character 

alphanumeric. 

• The diameter of the protector is entered, in millimetres. 

• The length of the protector is entered; in meter. It is used in the drawing. 

• The top depth of the protector is entered, in meters. A negative depth means that the top of the 

protector is above the natural ground. It is used in the drawing. 

• The cover type is entered, with 80 characters. If a value is defined, the cover can be drawn at the 

top depth of the protector. 

• The type of upper cap is entered, with 80 characters. If a value is defined, the upper cap can be 

drawn. 

• The type of lower cap is entered, with 80 characters. If a value is defined, the lower cap can be 

drawn. 

• Remark is alphanumeric with 255 characters for additional details on the installation. 

• The Inactive checkbox can be checked to indicate that a piezometer is not longer being monitored.  

• Transfer is a 1-character code to classify records for their management. 

Open Tube 

This section is present for all installation codes except P, E and V. 

• The tube diameter is entered; in millimeters. 

• The depth of the top of the tube is entered; in meters. If the tube is above ground, the top depth 

must be negative. It is used in the drawing and calculations. 

Pumping chamber 

This section is present for all installation codes except L, P, E and V. 

• The type of pumping chamber is entered, with 80 characters. 

• The diameter of the pumping chamber is in millimeters. 
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• The length of the pumping chamber is entered; in meters. It is used in the drawing. 

Vibrating wire 

This section is present for installation codes E and V. 

• Choose to use the linear equation or the polynomial equation using the radio buttons. By default, 

the linear equation is chosen. 

• Enter the reading at installation R0 in reading units. 

• Enter the barometric pressure at installation B0 in kPa. 

• Enter the temperature at installation T0 in Celsius degrees. 

• Enter the thermal coefficient TC in kPa / Celsius degree. 

• For the linear equation, enter the calibration factor CF in kPa / reading units. 

• For the polynomial equation, enter: 

o The coefficient A in kPa/reading units2. The value in scientific format can be entered. 

o The coefficient B in kPa/reading unit. 

o The coefficient C is calculated automatically as 𝐶 = −(𝐴 × 10−6 × 𝑅0
2 + 𝐵 × 𝑅0) 

Level Logger  

This section is present for installation code L. 

• Enter the distance between the probe of the datalogger and the top of the tube, in meters. It is 

used in the drawing and calculations. 

Pneumatic  

This section is present for installation code P. 

• Enter the inertia correction factor. 
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Figure 14 – Piezometer entry form 

6.3.1. Piezometric levels  

The Piezometric levels tab at the bottom of the Piezometer form shows data from the 

PIEZOMETRIC_LEVEL secondary table of the Geotec database. The tab is used to enter piezometric levels 

recorded for the current piezometer. 
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• The site number, the boring number, the piezometer number and the measurement date together 

constitute the key of the records. 

• The measurement date is entered with format yyyy-mm-dd hh:mi:ss.  

• The reading is entered and varies depending on the installation code.: 

o It is the depth of the water from the top of the tube; in meters, for all installation codes except 
L, P, E and V.  

o It is the reading on the dial, in reading units, for installation codes E and V. 

o It is the absolute pressure, in kPa, for installation code L. 

o It is the pressure, in kPa, for installation code P. 

• T1 is the temperature during the reading, in Celsius degrees.  

• B1 is the barometric pressure during the reading, in kPa. 

• The water pressure, in kPa, is entered or calculated. 

• The piezometric level, in meters, is entered or calculated. 

• Five 2-character remarks can be added regarding the measurement. 

• Remark is alphanumeric with 255 characters for additional details on the measurement. 

• Transfer is a 1-character code to classify records for their management. 

6.3.2. Seals 

The Seals tab at the bottom of the Piezometer form shows data from the PIEZOMETER_SEAL secondary 

table of the Geotec database. The tab is used to define the materials used in the installation of the well 

or piezometers. The information applies to the current boring, not to a specific piezometer. 

• The site number, the boring number, the top and bottom depths together constitute the key of 

the records. 

• The top and bottom depths contain the top and bottom of each seal, lantern, or fill zone, in 

meters. Materials are listed in the table from deepest to shallowest. 

By default, the bottom of the first material is equal to the total depth of the boring. The bottom of 

the following materials is equal to the top of the previous. These values can be modified.  

• The code designates the material(s) that will be drawn, based on the simplified classification. Up to 

3 materials can be defined per code. The pattern used in the drawing will be S_CODE defined in the 

current patterns files (.ptn), or several superimposed if 2- or 3-letter codes are used (ex: code SG = 

pattern for sand + pattern for gravel).  

• The material is automatically added as the code’s description if it exists in LIST_ENG. It can be 

modified, with up to 40 characters.  

• Transfer is a 1-character code to classify records for their management. 
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6.3.3. Calculations 

Geotec calculates the atmospheric pressure B1, the water pressure and the water level based on inputs. 

Atmospheric pressure B1 

By associating a barometer to the boring where a vibrating wire piezometer or a water level datalogger 

such as a Level Logger is installed (see paragraph 5.3), Geotec inserts the barometric pressure B1 at the 

date and time of the piezometric measurement, or by doing a linear interpolation between the 2 

nearest hours in the same day. If there is none, the default B1 value set for the boring is used. 

Water pressure 

The water pressure (P) at the screen depth is calculated. The dip and natural ground (NG) elevation are 

defined in the Boring entry form. 

For hydraulic installations (all codes except P, V, E and L) 

 𝑃 = (𝑑𝑒𝑝𝑡ℎ𝑏𝑜𝑡𝑡𝑜𝑚 𝑓𝑖𝑙𝑡𝑒𝑟 − 𝑑𝑒𝑝𝑡ℎ𝑡𝑜𝑝 𝑡𝑢𝑏𝑒 − 𝑟𝑒𝑎𝑑𝑖𝑛𝑔) × 𝑠𝑖𝑛( 𝑑𝑖𝑝) × 9.806 

For vibrating wire piezometers (code V and E) 

Linear equation:   𝑃𝑢𝑛𝑐𝑜𝑟𝑟𝑒𝑐𝑡𝑒𝑑 = 𝐶𝐹 × (𝑅𝑒𝑎𝑑𝑖𝑛𝑔 − 𝑅0) 

Polynomial equation: 𝑃𝑢𝑛𝑐𝑜𝑟𝑟𝑒𝑐𝑡𝑒𝑑 = 𝐴 × (𝑅𝑒𝑎𝑑𝑖𝑛𝑔2) + 𝐵 × 𝑅𝑒𝑎𝑑𝑖𝑛𝑔 + 𝐶 

Temperature correction is applied if T0 and T1 are defined. 

   𝑃 = 𝑃𝑢𝑛𝑐𝑜𝑟𝑟𝑒𝑐𝑡𝑒𝑑 − 𝑇𝑐 × (𝑇1 − 𝑇0) 

Barometric correction is applied if B0 and B1 are defined.   

   𝑃 = 𝑃𝑢𝑛𝑐𝑜𝑟𝑟𝑒𝑐𝑡𝑒𝑑 − (𝐵1 − 𝐵0) 

The calculation of B1 with temperature and barometric pressure corrections is therefore: 

Linear equation:   𝑃 = 𝐶𝐹 × (𝑅𝑒𝑎𝑑𝑖𝑛𝑔 − 𝑅0) −  𝑇𝑐 × (𝑇1 − 𝑇0) − (𝐵1 − 𝐵0) 

Polynomial equation:  𝑃 = 𝐴 × (𝑅𝑒𝑎𝑑𝑖𝑛𝑔2) + 𝐵 × 𝑅𝑒𝑎𝑑𝑖𝑛𝑔 + 𝐶 −  𝑇𝑐 × (𝑇1 − 𝑇0) − (𝐵1 − 𝐵0) 

For water level dataloggers (code L) 

 𝑃𝑝𝑟𝑜𝑏𝑒 = 𝑅𝑒𝑎𝑑𝑖𝑛𝑔 − 𝐵1 

If distanceprobe > 0, 

 𝑃 = 𝑃𝑝𝑟𝑜𝑏𝑒 + (
𝑑𝑒𝑝𝑡ℎ𝑏𝑜𝑡𝑡𝑜𝑚 𝑓𝑖𝑙𝑡𝑒𝑟 − 𝑑𝑒𝑝𝑡ℎ𝑡𝑜𝑝 𝑡𝑢𝑏𝑒 − distanceprobe

 
) × 𝑠𝑖𝑛( 𝑑𝑖𝑝) × 9.806 

For pneumatic piezometers (code P) 

 𝑃 = 𝑅𝑒𝑎𝑑𝑖𝑛𝑔 − 𝐼𝑛𝑒𝑟𝑡𝑖𝑎 

Piezometric levels 

The piezometric level is calculated according to the water pressure. 

 𝐿𝑒𝑣𝑒𝑙𝑤𝑎𝑡𝑒𝑟 = 𝑁𝐺 − 𝑑𝑒𝑝𝑡ℎ𝑏𝑜𝑡𝑡𝑜𝑚 𝑓𝑖𝑙𝑡𝑒𝑟 × sin ( 𝑑𝑖𝑝) + 𝑃 9.806⁄    
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6.4. Barometer form 

The form shows data from the BAROMETER table and its secondary table BAROMETER_POINT of the 

Geotec database. It is used to record data from barometric stations to apply a barometric correction to 

data from vibrating wire piezometers and water level dataloggers such as Level Loggers. 

The form is opened by double-clicking in the field Barometric station of the Boring form.  

• The barometer number is the key of the record. Enter up to 20 characters with letters, numbers 

and symbols - _ ( ) . Accents and other special characters cannot be used. 

• If the barometer is a vibrating wire, check the box. The fields with initial readings L0, B0 and T0 as 

well as the calibration coefficients are activated. You can choose the calculations with the linear or 

polynomial equation. 

• The serial number of the equipment is alphanumeric with 20 characters. 

• The installation date is in yyyy-mm-dd hh:mi:ss format. 

• The location of the barometric station is alphanumerci with 80 characters. 

• Remark is alphanumeric with 255 characters for additional details about the barometer station. 

• Transfer is a 1-character code to classify records for their management. 

The table at the bottom of the Barometer form shows data from the BAROMETER_POINT secondary 

table of the Geotec database. 

• The barometer number and the reading date together constitute the key of the records. 

• The reading date (BARO_DATE) is in yyyy-mm-dd hh:mi:ss format. It is important to have the 2 

digits for the hours, for example 04:15, 09:00, 15:30. 

Standard barometer  

• Enter the reading in kPa. This reading is copied into field B1. 

• Enter the temperature but it is not used in the calculations. 

Vibrating wire barometer 

• Choose to use the linear equation or the polynomial equation by via radio buttons. By default, the 

linear equation is chosen. 

• Enter the reading at installation R0 in reading units. 

• Enter the barometric pressure at installation B0 in kPa. 

• Enter the temperature at installation T0 in Celsius degrees. 

• Enter the thermal coefficient TC in kPa / Celsius degree. 

• For the linear equation, enter the calibration factor CF in kPa / reading units. 

• For the polynomial equation, enter: 
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o The coefficient A in kPa/reading units2. The value in scientific format can be entered. 

o The coefficient B in kPa/reading unit. 

o The coefficient C is calculated automatically as 𝐶 = −(𝐴 × 10−6 × 𝑅0
2 + 𝐵 × 𝑅0) 

• Record the reading in reading units. 

• Enter the temperature T1 in Celsius degrees.  

6.4.1. Calculations 

Geotec calculates the barometric pressure value B1 in kPa according to the inputs. 

Standard barometer  

   𝐵1 = 𝑅𝑒𝑎𝑑𝑖𝑛𝑔 

Vibrating wire barometer  

Linear equation:  𝐵1 𝑢𝑛𝑐𝑜𝑟𝑟𝑒𝑐𝑡𝑒𝑑 = 𝐶𝐹 × (𝑅𝑒𝑎𝑑𝑖𝑛𝑔 − 𝑅0) 

Polynomial equation:  𝐵1 𝑢𝑛𝑐𝑜𝑟𝑟𝑒𝑐𝑡𝑒𝑑 = 𝐴 × (𝑅𝑒𝑎𝑑𝑖𝑛𝑔2) + 𝐵 × 𝑅𝑒𝑎𝑑𝑖𝑛𝑔 + 𝐶 

Temperature correction is added if T0 and T1 are defined. 

𝐵1 = 𝐵1 𝑢𝑛𝑐𝑜𝑟𝑟𝑒𝑐𝑡𝑒𝑑 − 𝑇𝐶 × (𝑇1 − 𝑇0) 

If the barometer is not ventilated, the value B0 is added to it. 

The calculation of B1 with temperature and barometric pressure corrections is therefore made with: 

Linear equation:  𝐵1 = 𝐶𝐹 × (𝑅𝑒𝑎𝑑𝑖𝑛𝑔 − 𝑅0) −  𝑇𝐶 × (𝑇1 − 𝑇0) + 𝐵0 

Polynomial equation: 𝐵1 = 𝐴 × (𝑅𝑒𝑎𝑑𝑖𝑛𝑔2) + 𝐵 × 𝑅𝑒𝑎𝑑𝑖𝑛𝑔 + 𝐶 −  𝑇𝐶 × (𝑇1 − 𝑇0) + 𝐵0 

 

Figure 15 – Barometer entry form 
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6.5. Trench / Test pit form 

The form shows data from the TRENCH table of the Geotec database. It is used to describe test pits 

and/or trenches.  

• The site number and the boring number together constitute the key of the records. 

• The site and boring numbers identify the test pit or trench. The drop-down lists show all sites that 

have a least one boring defined in the BORING table, then all borings of the BORING table for the 

selected site. 

• The length and width of the trench are entered; in meters. 

• The azimuth (orientation) of the trench is entered, between 0 and 360 degrees.  

• The stop code is a 1-character field indicating the type of refusal during excavation, such as on 

Blocks, at Determined depth or on probable Rock. 

• The stripping thickness and the exploitable height respectively indicate the thickness of the ground 

that was stripped before doing the boring, and the thickness of the exploitable material.  The 

suggested unit is the meter.  This information is useful in the analysis of borrow pits.  

• The estimated percentages of cobbles and boulders found in the trench are entered. More details 

can be provided for the samples and / or layers via the matrix (paragraph 6.2) 

• The method or excavation equipment is entered with 40 characters. 

• A description of the bucket used can be entered with 40 characters.  

• The wall stability can be described with 255 characters.  

• A description of the excavation conditions is entered; with 255 characters.  

• The ground state is a 40-character field, indicating for example, its moisture. 

• The woodland density is a 40-character field.   

• The slope type is a 40-character field, indicating for example, its incline.  

• The topography is a 40-character field. 

• The surface soil is a 40-character field. 

• The top and bottom depths of the oxidized zone are entered, in meters.  

• A description of the oxidation conditions is entered with 255 characters. 

• The depth of two water inflow can be entered; the suggested unit is the meter.  

• A description of the water conditions is entered; with 255 characters. 

• A photo can be associated to the trench, with a maximum of 255 characters. By clicking on the 

button right of the field, the Windows file selection screen opens. The photo can be displayed if an 

object in the style file is associated with this field in Log. 
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To save the photo with its full path, enable the option in the preferences. See the X3D 

documentation. 

• A photo description can be entered, with 255 characters. 

• The described surface of the trench is provided with 40 characters.  

• A photo description can be added with 255 characters. 

• The remark is alphanumeric with 255 characters to add details about the trench. 

• Transfer is a 1-character code to classify records for their management. 

 

Figure 16 – Trench / Test pit entry form 

6.6. Boring methods form 

The form shows data from the CASING table of the Geotec database. It is used to describe the boring 

methods used and their driving mode. 

• The site number, the boring number and the top depth together constitute the key of the records. 

• The site and boring numbers identify the boring. The drop-down lists show all sites that have a 

least one boring defined in the BORING table, then all borings of the BORING table for the selected 

site. 



DATA ENTRY FORMS | Version 8.12.1 | Page 54 

  

• The top and bottom depths indicate between which depths the boring method is used, in meters. 

Both depths are required.  

• The casing caliber is indicated with a 3-character abbreviation. 

• Driving mode is a 1-character field indicating the driving mode used. The description of the driving 

mode is automatically copied to the Method field, which can be edited. 

• The type of drilling is indicated with 40 characters.  

• The method of drilling is indicated with 80 characters.  

• The remark is alphanumeric with 255 characters for additional notes. 

• Transfer is a 1-character code to classify records for their management. 

 

Figure 17 – Boring methods entry form 

6.7. Observation form 

The form shows data from the OBSERVATION table of the Geotec database. It is used to indicate any 

remarks, note or observation done in the field. Typically, these observations are not geological. 

• The site number, the boring number and the top depth together constitute the key of the records. 

• The site and boring numbers identify the boring for which there are field observations. The drop-

down lists show all sites that have a least one boring defined in the BORING table, then all borings 

of the BORING table for the selected site. 

• The depth or top depth of the observation is entered, in meters. 

• The bottom depth is entered, if the observation applies to an interval.  

• The remark is added with 255 characters to describe the observation. 

• Transfer is a 1-character code to classify records for their management. 
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Figure 18 – Observations entry form 

6.8. Cobbles form (OBSOLETE) 

WARNING: THE COBBLES FORM WILL BE REMOVED IN A FUTURE RELEASE. WE RECOMMEND USING 

THE MATRIX VIA THE SAMPLE AND/OR STRATIGRAPHY FORMS (PARAGRAPH 6.2). 

The form shows data from the COBBLE table of the Geotec database. It is used to enter percentages of 

boulders and/or cobbles between two depths. 

6.9. Ground form (OBSOLETE) 

WARNING: THE GROUND FORM WILL BE REMOVED IN A FUTURE RELEASE. WE RECOMMEND USING 

THE TRENCH / TEST PIT FORM (PARAGRAPH 6.5). 

The form shows data from the GROUND table of the Geotec database. It is used to enter the 

characteristics of the ground on which a borehole is located. 

7. Entry forms for rock 

In the Entry forms menu, the entry forms for rock description are available via the buttons of the second 

tab. They include the details about the rock joints and runs, information from the geocamera, the point 

load test and the uniaxial compression test. 

7.1. Joints form 

The form shows data from the ROCK_JOINT table of the Geotec database. It is used to describe the 

joints from a rock core or geocamera film as well as major structures.  

• The site number, the boring number and the depth together constitute the key of the records. 

• The site and boring numbers identify the borehole where cores were taken, or in which a 

geocamera was installed. The drop-down lists show all sites that have a least one boring defined in 

the BORING table, then all borings of the BORING table for the selected site. 

• The average depth of the joint, or the top depth of the major structure is entered, in meters. 

The Default parameters button opens the Rock entry form to define default values for joint 

characterization, for runs and for RMR and Barton-Q calculation for each borehole. See paragraph 7.3. 
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If a major structure is present:  

• The length of the major structure is entered, in meters, or can be calculated by entering the bottom 

depth.  

• The bottom depth of the major structure is not a field of the database. It is calculated when the 

user enters the length.  If the user enters a bottom depth for the structure, its length will be 

calculated.   

• The type of major structure is then entered, with 6 characters. If the type is present in the table of 

lists (paragraph 0), its description is displayed next to the Structure field.  

• The number of joints in the major structure is enter.  

Geotec automatically calculates:  

  Nbr joints = nb of joints per meter of structure x length of structure 

The number of joints per meter of structure can be defined in the default parameters (paragraph 

7.3). The default value is 40.  

 

Figure 19 – Joints entry form 
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If a joint is present: 

• The type of joint is entered, with 10 characters maximum. If the type is present in the table of lists 

(paragraph 0), its description is displayed next to the Type field.  

If the type is empty, it is suggested by Geotec based on the separation selected.  

o If the description contains *vein* → V  for Vein 

o Healed →    for Healed Joint (or FL in French for Fracture Liée) 

o < 0.1 mm →    for Closed Joint (or FF for Fracture Fermée) 

o 0.1 to 1 mm → (   for Partially Opened Joint) (or FP for Fracture Partiellement Ouverte) 

o 1 to 5 mm or > 5 mm → (   for Opened joint) (of FO for Fracture Ouverte) 

In Log and Pro, a special display can be used for the joints with markers named J_TYPE. See the Log 

documentation.  

• Alpha is the joint angle relative to the core axis; it’s an integer between 0 and 90o.  

• Beta is the azimuth of the joint relative to the core; it’s an integer between 0 and 360o. 

• Dip is the joint angle relative to a horizontal plane; it’s an integer between 0 and 90o. It can be 

entered or calculated by Geotec. It is used in the stereonet and in the calculation of joint sets.  

• Direction is the azimuth of the joint relative to the north; it’s an integer between 0 and 360o. It can 

be entered or calculated by Geotec. It is used in the stereonet and in the calculation of joint sets. 

The calculation theory of POND (Planes from Oriented, Navigated Drillcore) of Stanley and Hooper 

(2011) is used to calculate the dip and direction of joints based on the following angles:  

Azimuth of borehole (or 0 if not defined) 

Dip of borehole (or 90 if not defined) 

Joint Alpha angle 

Joint Beta angle 
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• The set number is alphanumeric.  Joint sets are 1, 2, 3, 4, 5 or R (random). The joint set can be 

entered by the user or calculated by Geotec. 

To determine the joint set number, Geotec verified if its dip and direction are within the minimum 

and maximum dip and minimum and maximum direction of one of the joint sets defined for the 

borehole in the Default parameters (paragraph 7.3). The corresponding set number is assigned to 

the joint. If no set corresponds or if no joint sets was defined in the default parameters, the joint is 

random (R).  

The set number determined by Geotec is indicated right of the checkbox. If at least one joint set is 

defined in the parameters, the option Replace with calculated set no is active and is used to 

replace the field values by the ones calculated by Geotec.  

The five next characteristics are used to determine the joint ratings for the RMR and Barton Q 

calculation. Default values are suggested.  It is also possible to define the default parameters (paragraph 

7.3) to use for the joints of the borehole.   

• The joint shape is selected between 6 choices: 

o Discontinuous → jw = 4 

o  rregular → jw = 4 

o  tepped → jw = 2.5 

o Undulating (default value) → jw = 2 

o  urved → jw = 1.5 

o  lanar → jw = 1 

The jw rating (Barton Q) is associated to each choice and used in the calculations.  
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• The joint roughness is selected between 6 choices: 

o Very rough → js = 2 and Ra4c = 6 

o  ough → js = 1.5 and Ra4c = 5 

o Slightly rough (default value) → js = 1.25 and Ra4c = 3 

o  mooth → js = 1.0 and Ra4c = 1 

o  olished → js = 0.75 and Ra4c = 0 

o  lickensided → js = 0.5 and Ra4c = 0 

The js rating (Barton Q) and the Ra4c rating (RMR) are associated to each choice and used in the 

calculations.  

• The joint separation is selected between 5 choices:  

o  ealed →  a4b = 6 and Ja = 0.75 

o < 0.1 mm (default value) →  a4b = 5 

o 0.1 to 1 mm →  a4b = 4 

o 1 to 5 mm →  a4b = 1 

o > 5 mm →  a4b = 0 

o Enter the joint aperture, in mm.  

The Ra4b rating (RMR) is associated to each choice and used in the calculations.  

• The joint infilling is selected between 5 choices: 

o  one / stained →  a4d = 6 and  a = 1 (except if joint is healed,  a = 0.75) 

o Cohesionless (default value) →  

o If separation is < 5 mm, Ra4d = 4  

o If separation is > 5 mm, Ra4d = 2 and Ja = 6 

o If separation is between 1 and 5 mm, Ja = 4 

o If separation is < 1 mm, Ja = 2 

o  ard cohesive →  

o If separation is < 5 mm, Ra4d = 4 

o If separation is > 5 mm, Ra4d = 2 and Ja = 10 

o If separation is between 1 and 5 mm, Ja = 6 

o If separation is < 1 mm, Ja = 3 

o  oft cohesive →  

o If separation is < 5 mm, Ra4d = 2 

o If separation is > 5 mm, Ra4d = 0 and Ja = 13 

o If separation is between 1 and 5 mm, Ja = 8 

o If separation is < 1 mm, Ja = 4 
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o Swelling →  

o If separation is < 5 mm, Ra4d = 2  

o If separation is > 5 mm, Ra4d = 0 and Ja = 18 

o If separation is between 1 and 5 mm, Ja = 10 

o If separation is < 1 mm, Ja = 5 

o Enter the infilling material  

The Ja rating (Barton Q) and Ra4d rating (RMR) are associated to the infilling and separation 

together and used in the calculations.  

• The joint weathering is selected between 5 choices: 

o  one (default value) →  a4e = 6 

o  light →  a4e = 5 

o  oderate →  a4e = 3 

o  igh →  a4e = 1 

o Decomposed →  a4e = 0 

The Ra4e rating (RMR) is associated to each choice and used in the calculations.  

The Rock Mass Rating parameters are calculated by Geotec or selected by the user.  

• Ra4a is the joint continuity (persistence) rating. It is between 0 and 6. The persistence is defined by 

default as 1 to 3 m, but can be redefined for the borehole in the default parameters.  

o  or < 1 m →  a4a = 6 

o For 1 - 3 m →  a4a = 4 

o For 3 - 10 m →  a4a = 2 

o For 10 - 20 m →  a4a = 1 

o  or > 20 m →  a4a = 0 

If the persistence is based on roughness (see default parameters), Ra4a depends on Ra4c. For Ra4c 

= 5 → Ra4a = 4. For Ra4c = 3 → Ra4a = 2. Otherwise, Ra4c = Ra4a.  

• Ra4b is the joint separation rating, based on joint separation. It is between 0 and 6. 

• Ra4c is the joint roughness rating, based on joint roughness. It is between 0 and 6. 

• Ra4d is the joint infilling rating, based on joint infilling and separation. It is between 0 and 6. 

• Ra4e is the joint weathering rating, based on joint alteration. It is between 0 and 6. 

• The sum of the Ra4 is indicated for information, as: Ra4 = Ra4a + Ra4b + Ra4c + Ra4d + Ra4e. 

• Jcon is the joint condition number (RMR 1989). It is used only if the user chooses the Jcon 

calculation method for Ra4 (paragraph 7.3).  

o If the joint infilling is hard cohesive, soft cohesive or swelling 
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o  f separation is > 5 mm →  con = 0 

o If separation is from 1 to 5 mm or the joint roughness is slickensided →  con = 7 

o If separation is from 0.1 to 1 mm →  con = 14 

o  therwise… 

o For a curved or planar joint … 

o For a very rough joint →  con = 24 (cohesionless) or 26 (stained) 

o For a rough or slightly rough joint →  con = 19 (cohesionless) or 24 (stained) 

o For a polished or slickensided joint →  con = 14 (cohesionless) or 19 (stained) 

o For a discontinuous, irregular, stepped or undulating joint … 

o For a very rough joint →  con = 26 (cohesionless) or 30 (stained) 

o For a rough or slightly rough joint →  con = 24 (cohesionless) or 26 (stained) 

o For a polished or slickensided joint →  con = 19 (cohesionless) or 24 (stained) 

• Ra4 is the parameter evaluating the joint condition. It is between 0 and 30. Ra4 is either equal to 

the sum of Ra4a to Ra4e (default value), either equal to Jcon, or equal to the average of both. The 

calculation method can be redefined for the borehole in the default parameters (paragraph 7.3). 

The Barton-Q parameters are calculated by Geotec or selected by the user.  

• Jr is the joint roughness number. It is between 0.5 and 4.  

Jr can be calculated based on Jr = jw * js if the option is checked in the default parameters for the 

borehole (paragraph 7.3). The value of Jr is maximum 4.  

o jw is the rating based on joint shape (between 1 and 4), and js is the rating based on joint 
roughness (between 0.5 and 2).  

If the option Jr = jw * js is not checked (default value), Jr is determined as follows.  

o For a discontinuous, irregular or stepped joint →  r = 4 

o For an undulating or curved joint … 

o For a very rough or rough joint →  r = 3 

o For a slightly rough or smooth joint →  r = 2 

o For a polished or slickensided joint →  r = 1.5 

o For a planar joint… 

o For a very rough or rough joint →  r = 1.5 

o For a slightly rough or smooth joint →  r = 1 

o For a polished or slickensided joint →  r = 0.5 

o If the joint infilling is cohesionless, hard cohesive, soft cohesive or swelling AND the joint 
separation is > 5 mm →  r = 1 

• Ja is the joint alteration number, based on joint infilling and separation. It is between 0.75 and 20.  

• JRC is the joint roughness coefficient, between 0.5 and 20. It is not used in the calculations.  

o For a discontinuous, irregular or stepped joint →     = 20 



DATA ENTRY FORMS | Version 8.12.1 | Page 62 

  

o For an undulating or curved joint … 

o For a very rough or rough joint →     = 14 

o For a slightly rough or smooth joint →     = 11 

o For a polished or slickensided joint →     = 7 

o For a planar joint … 

o For a very rough or rough joint →     = 2.5 

o For a slightly rough or smooth joint →     = 1.5 

o For a polished or slickensided joint →     = 0.5 

• The joint or major structure description has 255 characters. If a geocamera file from WellCad, Dips 

or other software is imported into Geotec, the value in the Description field is analysed. The 

separation can be checked automatically based on the texts decoded:  

o With *ealed*, *welded*, *lié* or *soudé*, Healed is checked. 

o With *close* or *fermé*, < 0.1 mm is checked. 

o With *part* or *slight*, 0.1 to 1 mm is checked. 

o With *open* or *ouvert*, Geotec verifies the value in the Aperture field (mm). 

o With an aperture greater than 5, >5 mm is checked. 

o With an aperture greater than 1, 1 to 5 mm is checked. 

o Otherwise, 0.1 to 1 mm is checked. 

o For other descriptions, Geotec verifies the value in the Aperture field.  

o With an aperture greater than 100 mm, so typically for major structures 

o The structure length is calculated as: aperture / 1000 

o The number of joints is calculated as: nbr of joints per meter of structure x structure 
length 

o With *shear*, *fractur* or *cisail*, the structure is defined as FZ (fractured zone) 

o With *broken*, *rempli* or *broy*, the structure is defined as BZ (broken zone) 

o With an aperture greater than 5, >5 mm is checked. 

o With an aperture greater than 1, 1 to 5 mm is checked. 

o With an aperture greater than 0.1 mm, 0.1 to 1 mm is checked. 

o Otherwise, the separation from the default parameters is checked.  

• The joint or major structure remark has 255 characters. If a geocamera file from WellCad, Dips or 

other software is imported into Geotec, the value in the Remark field is analysed.  

The shape can be checked automatically based on the texts decoded:  

o With *discontinu*, Discontinuous is checked.  

o With *irregular* or *irréguli*, Irregular is checked.  

o With *stepped* or *escalier*, Stepped is checked.  

o With *undulat* or *ondul*, Undulating is checked.  
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o With *curve* or *courb*, Curved is checked.  

o With *plan*, Planar is checked.  

The roughness can be checked automatically based on the texts decoded:  

o With *discontinu*, *very*, *v.* or *très*, Very rough is checked.  

o With *slight*, *sl.* or *lég*, Slightly rough is checked.  

o With *rough* or *rugueux*, Rough is checked.  

o With *smooth*, *lisse* or *dou*, Smooth is checked.  

o With *poli*, Polished is checked.  

o With *slicken* or *strié*, Slickensided is checked.  

• The name of the person who logged the information about the major structure or joint is entered, 

with 40 characters, as well as the logging date in format yyyy-mm-dd hh:mi:ss.  

• Transfer is a 1-character code to classify records for their management.  y putting an “ ” in the 

Transfer field, the joint will not be displayed in the stereonet and will be ignored in the calculations 

of joint sets statistics.   

In the Stereonet tab… 

A stereonet is displayed in vector representation, showing all the joints of the current borehole, except 

those with an “ ” in the  ransfer field.  ach joint is displayed according to its dip and direction.  

• Dip: A dip of 0 is at the center of the stereonet, and a dip of 90 is on the outside.  

• Direction: A direction of 0 is at the bottom of the stereonet. The direction increases clockwise. The 

direction of 90 is therefore at the left of the stereonet.  

• For information, specific markers exist for healed joints (type HJ), closed joints (type CJ), partially 

opened joints (type PJ) and opened joints (type OJ). The other types are represented as a gray 

square.  

• The definition of the joint sets in the default parameters of the borehole are shown as information.  



DATA ENTRY FORMS | Version 8.12.1 | Page 64 

  

 

Figure 20 – Joints entry form - Stereonet 

7.2. Run form 

The form shows data from the RUN table and its secondary table RUN_SET of the Geotec database. It is 

used to describe the runs in the boreholes.  

• The site number, the boring number and the run number together constitute the key of the 

records. 

• The site and boring numbers identify the borehole where cores were taken. The drop-down lists 

show all sites that have a least one boring defined in the BORING table, then all borings of the 

BORING table for the selected site. 

• The run number can have up to 20 characters. The number of the first run is automatically 

suggested as 01, and the following ones are incremented.  

The Default parameters button opens the Rock entry form to define default values for joint 

characterization, for runs and for RMR and Barton-Q calculation for each borehole. See paragraph 7.3. 
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Figure 21 – Run entry form 

• The top and bottom depths of the run are required, in meters.  

• The run length is not a field in the database. It is calculated when the user enters the bottom depth. 

If the user enters a length for the run, its bottom depth will be calculated.  

• The total core recovery TCR can be calculated via its length, or inputted directly in %. 

• The solid core recovery SCR can be calculated via its length, or inputted directly in %. The 

calculation of SCR can be done by Geotec based on the joints in the run, if the calculation method is 

checked in the default parameters (paragraph 7.3). 

o We use the diameter corresponding to the caliber entered in the CASING table (paragraph 6.6) 
at the depth of the run based on Table 7, or 50 mm if no caliber is found. 

o We ignore all joints whose separation of “0” (healed joint) or whose  ransfer field is “ ”. 

o The pieces are calculated as the difference in depth of 2 consecutive joints minus the aperture 
of the first joint, while taking into account the top and bottom of the run for the first and last 
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joint (± 0.11 m on both extremities of the run). For a major structure, the piece is calculated as 
the structure length / (nbr joints + 1).  

o We add all pieces that are > diameter. 

o The SCR is the ratio of this length over the run length. 

• The Rock quality designation RQD can be calculated via its length (sum of lengths > 10 cm), or 

inputted directly in %. The calculation of RQD can be done by Geotec based on the joints in the run, 

if the calculation method is checked in the default parameters (paragraph 7.3). 

o We ignore all joints whose separation of “0” (healed joint) or whose  ransfer field is “ ”. 

o The pieces are calculated as the difference in depth of 2 consecutive joints minus the aperture 
of the first joint, while taking into account the top and bottom of the run for the first and last 
joint (± 0.11 m on both extremities of the run). For a major structure, the piece is calculated as 
the structure length / (nbr joints + 1).  

o We add all pieces that are > 10 cm. 

o The RQD is the ratio of this length over the run length. 

• The number of joints in the run can be entered by the user or calculated by Geotec if the 

calculation method is checked in the default parameters (paragraph 7.3). Geotec calculates the 

number of joints defined in the ROCK_JOINT table between the top and bottom depth of the run, as 

well as the number of joints in major structures, if applicable.  

• The average joint spacing (mm) is not a field of the database. It is calculated as:  

Spacing = run length * 1000 / (nbr of joints + 1) 

• The rock code defines the dominant rock material. The drop-down list shows the materials named 

R_name in the current patterns file (.ptn). A large number of R-type patterns can be found in the 

geotec8.ptn patterns file.  

• The geological formation can be entered, with up to 40 characters.  

• A description of the run is added, with 255 characters.   

• The Rock mass strength (RMS) is used to calculate Ra1. 

o UCT: Geotec calculates the average of the UCS strength values from the 
UNIAXIAL_COMPRESSION table whose test depth is between the top and bottom of the run. 
The average is shown in the UCT field as information.  

o PLT: Geotec calculates the average of the equivalent UCS strength values from the 
POINT_LOAD table whose test depth is between the top and bottom of the run. The average is 
shown in the PLT field as information.  

o RMS can be entered by the user. Otherwise, Geotec uses: 

o RMS = PLT if PLT is defined and UCT is not 

o RMS = UCT if UCT is defined and PLT is not 

o RMS = (PLT + UCT) /2 if both PLT and UCT are defined 
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• The Intact rock strength index (R0 to R6) is estimated based on the uniaxial compressive strength 

UCS. The default value is Medium strong, but can be redefined for the borehole in the default 

parameters. If RMS is not defined, Ra1 will be calculated based on the index selected.  

o Extremely weak (R0 -     between 0.25 and 1   a) →  a1 = 0 

o Very weak (R1 -     between 1 and 5   a) →  a1 = 1 

o Weak (R2 -     between 5 and 25   a) →  a1 = 2 

o Medium strong (R3 -     between 25 and 50   a) →  a1 = 4 

o Strong (R4 -     between 50 and 100   a) →  a1 = 7 

o Very strong (R5 -     between 100 and 250   a) →  a1 = 12 

o Extremely strong (R6 -     > 250   a) →  a1 = 15 

• The percentage % of weak rock varies between 0 and 100%. 

• The rock weathering (W1 to W6) is selected between these 6 choices.  

o None (W1) 

o Slight (W2) 

o Moderate (W3) 

o High (W4) 

o Complete (W5) 

o Residual soil (W6) 

The Rock Mass Rating parameters are calculated by Geotec or selected by the user.  

• Ra1 is the rating of intact rock strength, based on the RMS or the strength index R0 to R6. It is 

between 0 and 15.  

If RMS is defined, Ra1 is calculated with a linear interpolation between the following points: 

RMS 0 1 5 25 50 100 250 10000 

Ra1 0 0.5 1.5 3 5.5 9.5 15 15 

 

Figure 22 – Interpolation for calculation of Ra1 in Run entry form  

Otherwise, Ra1 is calculated based on the R0 to R6 index as defined above.  
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• Ra2 is the rating of RQD. It is between 3 and 20. It can be selected by the user from the drop-down 

list or calculated by Geotec with a linear interpolation between the following points: 

RQD 0 10 25 50 75 90 100 

Ra2 3 3 5.5 10.5 15 18.5 20 

 

Figure 23 – Interpolation for calculation of Ra2 in Run entry form 

• Ra3 is the rating of average joint spacing. It is between 5 and 20.  It can be selected by the user 

from the drop-down list or calculated by Geotec with a linear interpolation on logarithmic basis 

between the following points, where “s” is the average joint spacing.  

s 1 10 60 200 600 2000 10000 

Ra3 5 5 6.5 9 12.5 20 20 

  

Figure 24 – Interpolation for calculation of Ra3 in Run entry form 

• Ra4 is the rating of joint condition. It is between 0 and 30.  

o Geotec calculates the average Ra4a, Ra4b, Ra4c, Ra4d and Ra4e of the joints for each set 
number (paragraph 7.2.1).  

o Ra4 for each set number is then calculated as indicated in paragraph 7.1 and is used to 
determine RMR for each set number.  

o Based on the selected RMR calculation criteria, Geotec uses the values of the run, including 
RMR, Ra1, Ra2, Ra3, Ra5 and Rb to recalculate Ra4.  

• Ra5 is the rating of groundwater conditions. It varies between 0 and 15. The default value is 15 but 

can be redefined for the borehole in the default parameters.  

• Rb is the rating adjustment for joint orientations.  It varies between 0 and -12. The default value is 0 

but can be redefined for the borehole in the default parameters. 
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• The RMR is the rock mass rating and is between 0 and 100 %. RMR is automatically calculated as:  

RMR = Ra1 + Ra2 + Ra3 + Ra4 + Ra5 + Rb 

o The RMR displayed in the entry form and saved in the database is calculated based on the 
criteria selected in the default parameters for the borehole. The criteria is indicated below the 
field Class.  

o Class: The class of rock quality is calculated for the RMR based on Table 5. 

The Barton Q parameters are calculated by Geotec or selected by the user.  

• Jn is the joint set number. It is between 0.5 and 20. It is calculated based on joint sets in the run.  

o  or each joint set… 

 f the number of joints in the run is ≥ than the minimum number of joints per run (6 or the 
value in the default parameters) and if the number of joints in the set is ≥ than the minimum 
number of joints per set (2 or the value in the default parameters), then the number of sets in 
increased by 1. A random set is not included in the total number.  

o Jn is then determined based on the number of sets obtained, the number of joints in the run 
and the presence of a Random set.  

 br joints ≥ 20 * run length →  n = 20 
Nbr sets = 0 and Nbr joints = 0  →  n = 1 
Nbr sets = 0 and Nbr joints > 0  →  n = 1 
Nbr sets = 1 and no random  →  n = 2 
Nbr sets = 1 and a random   →  n = 3 
Nbr sets = 2 and no random  →  n = 4 
Nbr sets = 2 and a random   →  n = 6 
Nbr sets = 3 and no random  →  n = 9 
Nbr sets = 3 and a random   →  n = 12 
Nbr sets ≥ 4   →  n = 15 

• Jr is the joint roughness number. It is between 0.5 and 4.  

o Geotec calculates the average Jr of the joints for each set number (paragraph 7.2.1) as well as 
the Jr associated to each calculation criteria of Barton-Q.   

o Based on the Barton-Q calculation criteria selected, the Jr associated to the criteria is displayed 
in the entry form and saved in the database. 

• Ja is the joint alteration number, based on joint infilling and separation.  It is between 0.75 and 20.  

o Geotec calculates the average Ja of the joints for each set number (paragraph 7.2.1). 

o Based on the Barton-Q calculation criteria selected, Geotec uses the values of run, including Q, 
RQD, Jn, Jr, Jw and SRF to recalculate Ja.  

• Jw is the joint water reduction number. It varies between 0.05 and 1. The default value is 1 but can 

be redefined for the borehole in the default parameters. 

• SRF is the stress reduction factor. It varies between 0.5 and 400. The default value is 1 but can be 

redefined for the borehole in the default parameters. 
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• Jv is the number of joints per cubic meter. It is displayed as information only.  

𝐽𝑣 =
(115 × 𝑅𝑄𝐷)

3.3
 

• Q is the rock quality index and is between 0.001 and 1000. The Barton-Q is automatically calculated 

as:  

𝑄 =
𝑅𝑄𝐷

𝐽𝑛
×

𝐽𝑟

𝐽𝑎
×

𝐽𝑤

𝑆𝑅𝐹
 

where RQD is at least 10.  

o Q displayed in the entry form and saved in the database is based on the criteria selected in the 
default parameters for the borehole. The criteria is indicated below the field Class.  

o Class: The class of rock quality is calculated for the Barton-Q based on Table 6. 

• A remark about the run can be added with 255 characters.  

• The name of the person who described the run is entered, with 40 characters, as well as the 

logging date in format yyyy-mm-dd hh:mi:ss.  

• Transfer is a 1-character code to classify records for their management.  

7.2.1. Joint sets statistics 

The Joints tab at the bottom of the form shows data from the ROCK_JOINT table of the Geotec 

database. Automatically, all joints whose depth is between the top and bottom depths of the run are 

listed. Their values can be edited. The joints can be sorted by depth or by set number depending on the 

radio button selected.  

The Sets tab at the bottom of the form shows data from the RUN_SET secondary table of the Geotec 

database. 

The joint sets statistics are calculated by Geotec. If there is already existing data, the must be deleted 

with the button Delete sets statistics in order to be regenerated. A joint set is generated if at least 1 

joint or major structure belongs to it in the run, including the   set.  ny joint with “ ” in its  ransfer field 

is ignored in the calculations. Each set shows the average of all values of its joints as well as the Barton Q 

and RMR calculation.  

In the Stereonet tab… 

A stereonet is displayed in vector representation, showing all the joints of the current borehole, except 

those with an “ ” in the Transfer field. Each joint is displayed according to its dip and direction.  

• Dip: A dip of 0 is at the center of the stereonet, and a dip of 90 is on the outside.  

• Direction: A direction of 0 is at the bottom of the stereonet. The direction increases clockwise. The 

direction of 90 is therefore at the left of the stereonet.  

• The joints are displayed with a marker representing their type (paragraph 7.1).  
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• The definition of the joint sets in the default parameters of the borehole are shown as information.  

The joint sets statistics show a summary of the values calculated in RUN_SET (Sets tab). The number of 

joints, RMR and Barton Q are shown for: 

• Set numbers 1, 2, 3, 4, 5 and R if applicable 

• Weighted average of sets →  he number of joints per set is taken into account 

•  verage of sets →  he number of joints per set is not taken into account, each set counts as 1 joint 

•  inimum set value →  he minimum    , the minimum Q and the number of joints of the 

associated set 

•  aximum set value →  he maximum    , the maximum Q and the number of joints of the 

associated set 

• Dominant set →  he values of the set with most joints 

 

Figure 25 – Run entry form – Stereonet and joint sets statistics 

The class of rock quality is calculated for the RMR and the Barton-Q based on Table 5 and Table 6 

respectively. By defining a color for each class in the table of lists (for table RUN, fields Q_CLASS and 

RMR_CLASS), it will be used as the cell background color for each corresponding value.  
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Table 5 – Classes of rock quality (RMR) 

RMR 81-100 61-80 41-60 21-40 0-20 

Class I II III IV V 

Description Very good Good Fair Poor Very poor 

 

Table 6 – Classes of rock quality (Barton Q) 
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7.3. Default parameters form 

The Rock entry form is opened via the Default parameters button in the Joints and Runs entry form. The 

form shows data from the ROCK table and its secondary table ROCK_SET of the Geotec database. It is 

used to define default values for joint characterization, for runs and for RMR and Barton-Q calculation 

for each borehole, as well as to establish the definition of joint sets. It is also used to define the 

calculation method with regards to joint distribution.  

• The site number and the boring number together constitute the key of the records. 

• The site and boring numbers identify the borehole for which default parameters are set, for the 

rock joints and runs. The drop-down lists show all sites that have a least one boring defined in the 

BORING table, then all borings of the BORING table for the selected site. 

A number of joints can be defined for 3 default parameters of the borehole.  

• Nbr of joints per meter of structure: by default, the value is 40 but can be modified. This value is 

used when calculating the number of joints in a major structure, as: 

Nbr joints = nb of joints per meter of structure x length of structure 

• Minimum nbr of joints per run: by default, the value is 6 but can be modified between 1 and 20. 

This value is used for the Jn calculation.  

• Minimum nbr of joints per set: by default, the value is 2 but can be modified between 1 and 10. 

This value is used for the Jn calculation.  
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Figure 26 – Entry form of default parameters for rock joints and runs 

The five next characteristics are used to determine the joint ratings for the RMR and Barton Q 

calculation. Choose the default values to use for the rock joints of the borehole. Each characteristic is 

described in paragraph 7.1. 

• The joint shape is selected between: Discontinuous, Irregular, Stepped, Undulating (suggested by 

default), Curved or Planar 

• The joint roughness is selected between: Very rough, Rough, Slightly rough (suggested by default), 

Smooth, Polished or Slickensided 

• The joint separation is selected between: Healed, < 0.1 mm (suggested by default), 0.1 to 1 mm, 1 

to 5 mm or > 5 mm 

• The joint infilling is selected between: None / stained, Cohesionless (suggested by default), Hard 

cohesive, Soft cohesive or Swelling 

• The joint weathering is selected between: None (suggested by default), Slight, Moderate, High or 

Decomposed 
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The Rock Mass Rating parameters include default values for the joints, runs and calculation methods to 

use. 

• Persistence is the joint continuity. The value will be used to calculate Ra4a. The persistence is 

selected between: Based on roughness, < 1 m, 1 to 3 m (default value), 3 to 10 m, 10 to 20 m or > 

20m. 

• Ra4 calculation is the method to use to determine Ra4, the parameter evaluating the joint 

condition. Ra4 is either equal to the sum of Ra4a to Ra4e (default value), either equal to Jcon, or 

equal to the average of both.  

• Ra5 is the rating of groundwater conditions. It varies between 0 and 15. The selected rating will be 

used by default for the runs of the borehole. Ra5 = 15 is suggested by default.  

• Rb is the rating adjustment for joint orientations.  It varies between 0 and -12. The selected rating 

will be used by default for the runs of the borehole. Rb = 0 is suggested by default.  

• Strength R is the intact rock strength index R and varies between 0 and 6. It is estimated based on 

uniaxial compressive strength UCS. The default value is 3 (medium strong). The strength R will be 

selected by default for the runs of the borehole. It can be used in the calculation of Ra1.  

• RMR based on is used to select the most important criteria for the calculation of RMR. However, 

the RMR calculated for all criteria is available in the statistics (Stereonet tab of the Run form). The 

default value is Weighted average of sets (choice 7).  

The Barton Q parameters include default values for the runs and calculation methods to use. 

• Jw is the joint water reduction number. It varies between 0.05 and 1. Jw selected will be used by 

default for the runs of the borehole. Jw = 1 is suggested by default.  

• SRF is the stress reduction factor. It varies between 0.5 and 400. SRF selected will be used by 

default for the runs of the borehole. SRF = 1 is suggested by default. 

• The checkbox Jr = jw * js indicated the calculation method of Jr. If the box is not checked (default 

option), Jr will be from the predefined choices based on shape and roughness. If the box is check, Jr 

will be the product of jw and js.  

• Q based on is used to select the most important criteria for the calculation of Barton Q. However, 

the Q calculated for all criteria is available in the statistics (Stereonet tab of the Run form). The 

default value is Minimum set value (choice 9).  

The management includes comments about the default parameters as well as the calculation method 

with regards to joint distribution. 

• A description of the geological formation or other can be added, with 255 characters.  

• The remark is added with 255 characters. 

• Transfer is a 1-character code to classify records for their management. 
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• To always use joint distribution to calculate the number of joints per run, the RQD and the SCR, 

check their corresponding boxes. If the box is not checked, the parameter is calculated only if 

empty. It is not calculated if there is already a value.  

The calculation method for the number of joints, the RQD and the SCR is specific to the 

workstation. It is not associated to each borehole.  

In the Stereonet tab… 

A stereonet is displayed in vector representation, showing all the joints of the current borehole, except 

those with an “ ” in the  ransfer field.  ach joint is displayed according to its dip and direction.  

• A dip of 0 is at the center of the stereonet, and a dip of 90 is on the outside.  

• A direction of 0 is at the bottom of the stereonet. The direction increases clockwise. The direction 

of 90 is therefore at the left of the stereonet.  

• For information, specific markers exist for healed joints (type HJ), closed joints (type CJ), partially 

opened joints (type PJ) and opened joints (type OJ). The other types are represented as a gray 

square.  

• The joint sets defined in the bottom table are also displayed in the stereonet. If a color is defined 

for the set number in the table of lists, it will be used for the set display (for table ROCK_SET, field 

SET_NO, value 1 to 5).  

The table at the bottom of the Rock form shows data from the ROCK_SET secondary table of the Geotec 

database. This is where joint sets are defined. Geotec will use these definitions to determine to which 

set the joint belongs and to do joint sets statistics.  

• The site number, the boring number and the set number together constitute the key of the 

records. A total of 5 sets can be defined.  

• The minimum dip, maximum dip, minimum direction and maximum direction are used to define a 

set with 4 sides.  

• The minimum dip, maximum dip and minimum direction are used to define a conical set.  

o  he center of the cone is the “ inimum dip,  inimum direction” point.  

o The radius of the cone is equal to the maximum dip.  

7.4. Geocamera form 

The form shows data from the GEOCAMERA table of the Geotec database. It is used to define the 
geocamera images taken along a borehole.  

• The site number, the boring number, the type of image and the top depth together constitute the 

key of the records. 
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• The site and boring numbers identify the borehole where the geocamera was installed. The drop-

down lists show all sites that have a least one boring defined in the BORING table, then all borings 

of the BORING table for the selected site. 

• The type of image is a 2-character code, either AC for acoustic image, OP for optical image, 3D for 

three-dimensional image, or PH for photo. 

• The top and bottom depths of the layer where the photo was taken are indicated, in meters. 

• Diameter indicates the hole dimension; the suggested unit is the mm.  

• The file name is entered, with a maximum of 255 characters. The file must be a .bmp extension. By 

clicking on the button right of the field, the Windows file selection screen opens.  

To save the file with its full path, enable the option in the preferences. See the X3D documentation. 

The images can be displayed with the Log module. 

• A description of the image can be added with up to 255 characters.  

 

Figure 27 – Geocamera entry form 

7.5. Point load form 

The form shows data from the POINT_LOAD table of the Geotec database. It is used to enter the 
parameters and calculate the results of the point load test for a rock sample.  

• The site number, the boring number and the depth together constitute the key of the records. 

• The site and boring numbers identify the borehole from which the core samples are taken for point 

load tests. The drop-down lists show all sites that have a least one boring defined in the BORING 

table, then all borings of the BORING table for the selected site. 

• The top depth of the sample core is entered, in meters.  

• Choose the test type. 

o Diametral: The core is placed horizontally between the platens 

o Axial: The core is placed vertically between the platens 

o Prismatic: The core is prismatic or irregular in shape and placed horizontally between the 
platens 
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• The test number can be entered, with 20 characters. 

Diametrical Type: The ratio of core length over the core diameter should be greater than 1. 

• Enter the core diameter (d), in millimeters (mm). 

Geotec verifies if a caliber is entered in the CASING table at the depth of the test (paragraph 6.6). If 

yes, the corresponding diameter is entered, based on Table 7. If no caliber is found or does not 

correspond to the following list, 50 mm is suggested. 

Table 7 – Caliber and corresponding diameter 

Caliber Diameter (mm)  Caliber Diameter (mm) 

PQ 85.0  HX 76.2 

HQ 63.5  NX 54.7 

NQ 47.6  BX 42.0 

BQ 36.5  AXT 30.1 

AQ 27.0  EXT 21.5 

PQ3 83.0  XRT 18.7 

HQ3 61.1    

NQ3 45.0    

• Enter the core length (L), in millimeters (mm). 

• The distance between the contact points (D), and the equivalent diameter (De) equal the diameter. 

Axial type: The ratio of core length over the core diameter should be between 0.3 and 1. 

• Enter the core diameter (d), in millimeters (mm). It is suggested based on Table 7  as for the 

Diametral test. It equals the core width (W). 

• Enter the core length (L), in millimeters (mm). 

• The distance between the contact points (D) equals the core length. 

• The equivalent diameter is calculated as: 𝐷𝑒 =  √4 × 𝑊 × 𝐷 𝜋⁄  

Prismatic Type: This test is done on blocks of rock or irregular cores. 

• Enter the average core width (W), perpendicular to the direction of loading, in millimeters (mm). 

• Enter the core length (L), in millimeters (mm). 

• Enter the distance between the contact points (D). 

• The equivalent diameter is calculated as: 𝐷𝑒 =  √4 × 𝑊 × 𝐷 𝜋⁄  

The test results are then entered or calculated. 

• The maximum load applied (P) is the failure load, in kN. 

• The strength index (Is) is entered or calculated, in MPa. 

• The corrected strength index for a 50 mm core (Is50) is entered or calculated, in MPa. 



DATA ENTRY FORMS | Version 8.12.1 | Page 78 

  

• The equivalent UCS value is entered or calculated, in MPa. 

• Remark is alphanumeric with 255 characters for additional comments. 

• The realized by field takes a 40-character string. 

• The test date is noted in the format yyyy-mm-dd hh:mi:ss. 

• Transfer is a 1-character code to classify records for their management. 

7.5.1. Calculations 

In addition to the equivalent diameter, Geotec calculates the strength index Is, the corrected strength 

index Is50 and the equivalent UCS. 

Equivalent diameter:   𝐷𝑒 =  √4 × 𝑊 × 𝐷 𝜋⁄  

Strength index:    𝐼𝑠 =  
𝑃×1000

𝐷𝑒
2  

Corrected Strength index:  𝐼𝑠50 =  
𝑃×1000

𝐷𝑒
1.5√50

 

UCS equivalent:   𝑞𝑐 =  𝐶 × 𝐼𝑠50 where C varies with core diameter 

    C = 24.5 if d ≥ 60 

    C = 24 if d ≥ 54 

    C = 23 if d ≥ 50 

    C = 21 if d ≥ 42 

    C = 19 if d ≥ 30 

    C = 18 if d < 30 

 

Figure 28 – Point load entry form 

7.6. Uniaxial compression test form  

The form shows data from the UNIAXIAL_COMPRESSION table of the Geotec database. It is used to 
enter the parameters and calculate the results of the uniaxial compression test for a rock sample.  
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• The site number, the boring number and the depth together constitute the key of the records. 

• The site and boring numbers identify the borehole from which the core samples are taken for 

uniaxial compression tests. The drop-down lists show all sites that have a least one boring defined 

in the BORING table, then all borings of the BORING table for the selected site. 

• The top depth of the sample core is entered, in meters.  

• The test number can be entered, with 20 characters. 

• Enter the core diameter (d), in millimeters (mm). 

Geotec verifies if a caliber is entered in the CASING table at the depth of the test (paragraph 6.6). If 

yes, the corresponding diameter is entered, based on Table 7. If no caliber is found or does not 

correspond to the following list, 50 mm is suggested. 

• Enter the core length (L), in millimeters (mm). 

The test results are then entered or calculated. 

• The maximum load (P) is the failure load, in kN. 

• The uniaxial compressive strength (UCS) is entered or calculated, in MPa. 

• Remark is alphanumeric with 255 characters for additional comments. 

• The realized by field takes a 40-character string. 

• The test date is noted in the format yyyy-mm-dd hh:mi:ss. 

• Transfer is a 1-character code to classify records for their management. 

7.6.1. Calculations 

Geotec calculates the strength (UCS) in MPa as: 𝑞𝑐 =  
4×𝑃×1000

𝜋𝑑2  where d is in millimeters and P is in kN. 

 

Figure 29 – UCT (uniaxial compression test) entry form 
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8. Entry forms for in-situ tests 

In the Entry forms menu, the entry forms for in-situ tests are available via the buttons of the third tab.  

8.1. Vane form 

The form shows data from the VANE table and its secondary table VANE_POINT of the Geotec database. 

It is used to describe a vane test and the resistances measured. 

• The site number and the boring number together constitute the key of the records. 

• The site and boring numbers identify the boring where vane tests were done. The drop-down lists 

show all sites that have a least one boring defined in the BORING table, then all borings of the 

BORING table for the selected site. 

• Enter up to 40 characters in the fields Realized by and Verified by. 

• The test date and verification date are noted in the format yyyy-mm-dd hh:mi:ss. 

• The name of the data file can be entered, with a maximum of 255 characters. By clicking on the 

button right of the field, the Windows file selection screen opens.  

To save the file with its full path, enable the option in the preferences. See the X3D documentation. 

• Remark is alphanumeric with 255 characters for additional details. 

• The vane number has up to 20 characters.  

• The type of blade indicates its dimensions, with 40 characters.  

• The most recent calibration date is noted in the format yyyy-mm-dd hh:mi:ss. 

• The K calibration coefficient of the apparatus is a numeric value.  

• The top depth of the clay layer is recorded, in meters. 

The table at the bottom of the Vane form shows data from the VANE_POINT secondary table of the 

Geotec database. 

• The site number, the boring number and the depth together constitute the key of the records. 

• The depth of the vane resistance measurement is entered, in meters. 

• The shear strength of unremoulded soil (maximum shear strength SU) is numeric, in kPa.  

• The shear strength of remoulded soil (residual shear strength SUR) is numeric, in kPa. 

• Sensitivity to remoulding (ST) is the ratio of intact strength to remoulded strength. Sensitivity is 

calculated automatically when both strengths are entered. The user can modify it. 

• Remark is alphanumeric with 255 characters for additional details on the test at the given depth. 

• Transfer is a 1-character code to classify records for their management. 
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8.1.1. Calculations 

Geotec calculates the sensitivity as Su / Sur if both values are entered. 

 

Figure 30 – Vane entry form 

8.2. Pressiometer form 

The form shows data from the PRESSIOMETER table of the Geotec database. It is used to enter 

measurements done with a pressuremeter or dilatometer in a boring, whether for soils or rock.  

• The site number, the boring number and the depth together constitute the key of the records. 

• The site and boring numbers identify the boring where the pressuremeter or dilatometer 

measurements were taken. The drop-down lists show all sites that have a least one boring defined 

in the BORING table, then all borings of the BORING table for the selected site. 

• The depth of the test is entered, in meters. 

• A test number can be indicated, with 20 characters. 

• The test type indicates the test used: Ménard-E (ME) or Ménard-G (MG) method. 

• The creep pressure is in kPa. It defines the limit between the pseudo-elastic behavior and the 

plastic state. 

• The limit pressure is in kPa. It is the pressure at which failure occurs.  

• The Ménard deformation modulus is in kPa. It defines the pseudo-elastic behavior of the soil. 

• Remark is alphanumeric with 255 characters for additional details on the test at the given depth. 

• Category is used to enter a code to categorize the test, with 20 characters. 
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• Transfer is a 1-character code to classify records for their management. 

 

Figure 31 – Pressiometer entry form  

8.3. Piezocone form (CPTU) 

The form shows data from the CPTU table and its secondary tables CPTU_POINT, CPTU_ZONE and 

CPTU_SISMIC of the Geotec database. It is used to define piezocone penetration tests (CPTu) including 

calculation parameters, measurements, SBT interpretation and shear wave velocities (SCPTu). 

Geotec calculates several parameters based on the theory of Robertson et al (1986) and Robertson 

(1990) and uses charts to predict the Soil Behavior Type (SBT). The methods used for the interpretation 

of the piezocone test and the empirical and theoretical equations used to determine the various 

properties as presented in paragraph 8.3.4. 

Several fields are automatically filled when importing a .drf file. See section A4 of Appendix A – 

Importing *.drf files for piezocones - for more details. 

• The site number and the boring number together constitute the key of the records. 

• The site and boring numbers identify the boring where a piezocone penetration test was done. The 

drop-down lists show all sites that have a least one boring defined in the BORING table, then all 

borings of the BORING table for the selected site. 

In the Identification tab…  

• The top and bottom depths correspond to the start and end depths of the test, respectively, in 

meters. They are inserted automatically when importing a drf. 

• The groundwater depth table is entered, in meters. It is copied from the BORING table when 

importing a drf. A depth of 0 is used by default if no value is entered. 

• The refusal type is alphanumeric with 255 characters. 

• Remark is alphanumeric with 255 characters for additional comments. 

• The acceptable normalized cone resistance qcn is noted, in kPa. 

• The upper and lower depth limits indicate the interval where the values are considered to comply. 
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• Transfer is a 1-character code to classify records for their management. Following the import of a 

drf, the value D is indicated. 

 n the  quipment tab… 

• The number of the probe used has 40 characters. It is inserted automatically when importing a drf. 

• The tip used has 40 characters. 

• The cone diameter is indicated, in mm. The default value is 20 mm. The diameter is not used in the 

calculations. 

• The area ratio for the cone is shown. The default value is 0.8. 

• The rate of penetration of the cone is in mm/min. It can be used in the interpretation of the 

results. 

• The increment between depth measurements is in mm. If a drf is imported, the increment is 

automatically defined as the smallest difference between 2 successive depths. 

For the log display, if the distance between two points is greater than 10x the increment, no line 

will be drawn between these points. 

• The radio buttons Total resistance qt and Tip resistance qc indicate the field to use in the 

calculations. The corresponding field INPUT_QC is 0 for QT and 1 for QC. 

If a drf is imported, the input defined in the file or when importing is automatically selected. 

If data is entered in one of the two fields (QT or QC), the corresponding button is automatically 

selected. 

• The radio buttons Resistivity and Conductivity indicate whether the input is conductivity (in mS/m) 

or resistivity (in ohm-m) if an RCPTu test was performed. The value of the INPUT_CO field is 0 for 

resistivity and 1 for conductivity. 

• Initial and final piezocone calibration constants can be entered for: 

o The cone resistance qc (MPa) 

o The pressure head u2 (m) 

o The friction fs (kPa) 

o The probe temperature (volts) 

In the Calculations tab, enter the parameters to use for the calculations. 

• The Nkt constant is a cone factor generally between 10 and 20. The default value is 14. 

• The Nst constant is a cone factor generally between 1 and 10. The default value is 3.08. 

• The ratio of the undrained shear strength (su) over the preconsolidation pressure (pc) Su/Pc is 

between 0.1 and 0.5. The default value is 0.22. 
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If both Nkt and Nst are entered, they are used in the calculation. Otherwise, Su/Pc is used with the 

Nkt value.  

• The minimum value of Ic to calculate su and pc is generally between 2 and 3. The default value is 

2.6. 

• The minimum value of fs to use in the calculation is entered. It can vary between 0 and 1 and the 

default value is 0.1. The value of fs min is used in calculations when FS is lower than fs min. If fs min 

is not defined, calculations are not done when FS is negative or 0. 

• The N exponent is used to calculate Qtn. It is between 0.5 and 1. If no value is entered, N is 

calculated at each depth.  

• Cq max is the maximum value of the stress normalization factor. The default value is 1.7. 

• The Dr constant is for the calculation of the relative density. The default value is 350. 

• The minimum thickness to create an SBT zone is entered, in meters. When the SBT values are the 

same over the minimum thickness or more, a zone is created. The default value is 0.1. The 

minimum value to calculate a zone is 0.001 meter. 

• The calculation method for the SBT zones is selected from the following list. The SBT values are 

calculated from the 6 charts, but the zones in CPTU_ZONE will be for the selected method 

(paragraph 8.3.2).  

o SBT_Rf 

o SBT_Bq 

o SBT_Ic 

o SBTn_Fr 

o SBTn_Bq 

o SBTn_Ic 

• The type of density to use in the vertical stress calculations is either Constant, Profile or Variable. 

The default value is V (variable). 

o Constant uses the densities entered in the Piezocone form, i.e. the wet density (above the 
water table) and the saturated density (below the water table). If either is not entered, 
Variable is used for the corresponding depths. 

o Profile uses densities from the SBT Zones tab. If there are no values, the densities in the 
Stratigraphy form are used (paragraph 6.1). Otherwise, if a parent boring is defined with the 
piezocone, the densities in the Stratigraphy form of the parent boring are used. If no density is 
found for a specific depth, Variable is used for that depth. 

o Variable uses the calculated density at each depth in the Piezocone Readings tab, with an Rf 
between 0.1 and 10. 

• The wet and saturated densities are entered; in kg/m3. They are used when the type of density 

selected is Constant. The default values are 1,900 and 2,000. 
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• When a modification to the piezocone test is saved, the modification date is updated. 

• When the calculation is done (via the button  or using Action > Calculate), the calculation date is 

updated. 
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Figure 32 – Piezocone entry form  

8.3.1. Piezocone readings 

The Piezocone readings tab at the bottom of the Piezocone form shows data from the CPTU_POINT 

secondary table of the Geotec database. The tab is used to record piezocone penetration resistance 

measurements and to calculate various parameters. 

• The site number, the boring number and the depth together constitute the key of the records. 

• The depth of the soil penetration resistance measurement is in meters. 

• The tip cone resistance QC or the cone resistance corrected for U2 (QT) is in kPa. The other value 

will be calculated (paragraph 8.3.4). If the resistance is lower than 11 kPa (or 0.011 MPa), the 

parameters for this depth are not calculated. 

• The friction resistance FS is entered, in kPa. If FS is lower than fs min defined in the Calculations 

tab, fs min is used in the calculations. If fs min is not defined, calculations are not done when FS is 

negative or 0. 

When importing a DRF or CSV file, FS values smaller than -999 are not imported (value set to null). 

• The measured porewater pressure U2 is entered, in kPa. 

• IX and IY are the inclines in the X and Y directions (in degrees). 

• Temp is the temperature, in degrees. 

• Electrical conductivity (in mS / m) or electrical resistivity (in ohm-m) is entered, if a RCPTu test was 

done. The other value will be calculated (paragraph 8.3.4). 

• Transfer is a 1-character code to classify records for their management. Following the import of a 

drf, the value D is indicated. 

• All other fields in the Piezocone readings tab are values calculated by Geotec. The parameters and 

equations are detailed in paragraph 8.3.4. 
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8.3.2. SBT zones 

The SBT zones tab at the bottom of the Piezocone form shows data from the CPTU_ZONE secondary 

table of the Geotec database. The tab is used to enter or identify calculated SBT zones, based on the SBT 

method selected in the Calculations tab. 

• The site number, the boring number and the top depth together constitute the key of the records. 

• The top and bottom depths are those of the zone where SBT values are the same.   

• The zone description has 255 characters. If the SBT zones are calculated, Geotec will use the 

equivalence of each SBT value, or just the value if the equivalence is not defined (paragraph 10.11).  

• The soil density D of the zone is entered, in kg/m3. It is used in the vertical stress calculations when 

the type of density selected is Profile.  

• The SBT (Soil Behavior Type) for the zone is calculated, based on the calculation method selected in 

the Calculations tab. 

• Category is used to enter a code for the zone, with 20 characters. 

• Transfer is a 1-character code to classify records for their management. 

8.3.3. Shear  

The Shear tab at the bottom of the Piezocone form shows data from the CPTU_SISMIC secondary table 

of the Geotec database. The tab is used to enter the shear wave velocities measured with SCPTu 

piezocone tests. 

• The site number, the boring number and the top depth together constitute the key of the records. 

• The top and bottom depths are those of the interval in which the shear wave velocity was 

measured. 

• The average shear wave velocity is in m/s. 

• Transfer is a 1-character code to classify records for their management. 

8.3.4. Calculations 

Geotec calculates several soil properties based on the input data. The variables and equations used are 

as follows. 

Variable Definition Value or Equation 

Depth Measurement depth N/A 

Water Water table depth N/A 

FS Friction resistance (kPa) N/A 

U2 Measured porewater pressure 

(kPa) 
N/A 
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Nkt Cone factor for SU calculation 14 by default 

Nst Cone factor for PC calculation 3.08 by default 

Ic min Minimum value of Ic to 

calculate su and pc 
2.6 by default 

a Cone area ratio 0.8 by default 

pa Atmospheric pressure (kPa) Approximated to 100 kPa 

Cdr Relative density calculation 

constant 
350 by default 

Resistivity Electrical resistivity (ohm-m) 𝑅𝑒𝑠𝑖𝑠𝑡𝑖𝑣𝑖𝑡𝑦 = 1000 𝑐𝑜𝑛𝑑𝑢𝑐𝑡𝑖𝑣𝑖𝑡𝑦⁄  

conductivity Electrical conductivity (mS/m) 𝐶𝑜𝑛𝑑𝑢𝑐𝑡𝑖𝑣𝑖𝑡𝑦 = 1000 𝑟𝑒𝑠𝑖𝑠𝑡𝑖𝑣𝑖𝑡𝑦⁄  

QT Cone resistance corrected for 

U2 (kPa) 
𝑄𝑇 = 𝑄𝐶 + 𝑈2 × (1 − 𝑎) 

QC Tip cone resistance (kPa) 𝑄𝐶 = 𝑄𝑇 − 𝑈2 × (1 − 𝑎) 

QTA Cone resistance divided by 

atmospheric pressure 
𝑄𝑇𝐴 = 𝑄𝑇 𝑝𝑎⁄  

RF Friction ratio (%) 𝑅𝐹 =  𝐹𝑆 𝑄𝑇⁄ × 100% 

ISBT SBT index for non-normalized 

SBT 
𝐼𝑆𝐵𝑇 = √(3.47 − log(𝑄𝑇 𝑝𝑎⁄ ))2 + (log(𝑅𝐹) + 1.22)2 

U0 Hydrostatic pressure (kPa) 𝑈0 =  (𝑑𝑒𝑝𝑡ℎ − 𝑤𝑎𝑡𝑒𝑟) × 9.81 or 0 if depth < water 

D Density (kg/m3)  

 Constant 𝐷 = 𝐷𝑤𝑒𝑡 if depth < water 

𝐷 = 𝐷𝑠𝑎𝑡 if depth > water 

 Profile 𝐷 = 𝐷 from cptu_zone, or 

𝐷 = 𝐷 from stratigraphy, or 

𝐷 = 𝐷 from stratigraphy for parent boring  

 Variable 𝐷 = (0.27 × log(𝑅𝐹) + 0.36 × log(𝑄𝑇𝐴) + 1.236) × 1000  

With 0.1 ≤    ≤ 10 

γ Unit weight (kN/m3) 𝛾 = 𝐷 1000⁄ × 9.81 

TS Total vertical stress (kPa) 𝑇𝑆 = ∑(𝛾 × ∆𝑑𝑒𝑝𝑡ℎ) 

ES Effective vertical stress (kPa) 𝐸𝑆 = 𝑇𝑆 − 𝑈0 

FR Normalized friction ratio (%) 𝐹𝑅 =  𝐹𝑆 (𝑄𝑇 − 𝑇𝑆)⁄ × 100% 

QTN Normalized cone resistance Iteration with n = 1 and finished when (ni - ni-1) < 0.01. 

𝑄𝑇𝑁 = (𝑄𝑇 − 𝑇𝑆) 𝐸𝑆⁄  Ic SBT index for normalized SBT 
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n Exponent to calculate stress 𝐼𝐶 = √(3.47 − 𝑙𝑜𝑔(𝑄𝑇𝑁))2 + (𝑙𝑜𝑔(𝐹𝑅) + 1.22)2 

𝑛 = 0.381 × 𝐼𝑐 + 0.05 × (𝐸𝑆 𝑝𝑎⁄ ) − 0.15 where 0.5 ≤ n ≤ 1 

𝐶𝑞 = (𝑝𝑎 𝐸𝑆⁄ )𝑛 

𝑄𝑇𝑁 = (𝑄𝑇 − 𝑇𝑆) 𝑝𝑎⁄ × 𝐶𝑞 

Cq Correction factor for effective 

stress 

Bq Normalized excess porewater 

pressure 
𝐵𝑞 = (𝑈2 − 𝑈0) (𝑄𝑇 − 𝑇𝑆)⁄  

α Alpha constant  𝛼 = 100.55×𝐼𝑐+1.68 

VS Shear wave velocity (m/s) 𝑉𝑆 = √𝛼 × (𝑄𝑇 − 𝑇𝑆) 𝑝𝑎⁄  

VS1 Normalized shear wave velocity 

(m/s) 
𝑉𝑆1 = 𝑉𝑆 × (𝑝𝑎 𝐸𝑆⁄ )0.25 

G0 Initial shear modulus (MPa) 𝐺0 = 𝐷 × 𝑉𝑆2 1000000⁄  

DR Relative soil density (%)  𝐷𝑅 = √𝑄𝑇𝑁 𝐶𝑑𝑟⁄ × 100% 

E Young's modulus of elasticity 

(MPa) 

𝐸 = 0.8 × 𝐺0 

If Ic < 2.6 

N60 Number of blows per 0.3 m 
𝑁60 =

𝑄𝐶 𝑝𝑎⁄

8.5 × (1 − 𝐼𝑐 4.6⁄ )
 

N160 Normalized number of blows 

per 0.3 m 
𝑁160 = 𝑁60 × 𝐶𝑞 

Nq Bearing capacity factor 𝑁𝑞 = 𝑄𝐶 𝐸𝑆⁄  

    (φ’) Friction angle (degrees) 
𝜑 = tan−1 (

log(𝑄𝐶 𝐸𝑆⁄ ) + 0.29

2.68
) ×

180

𝜋
 

SU Undrained shear strength 𝑆𝑈 = (𝑄𝑇 − 𝑇𝑆) 𝑁𝑘𝑡⁄  

If Ic > Ic min 

PC Preconsolidation pressure 𝑃𝐶 = (𝑄𝑇 − 𝑇𝑆) 𝑁𝑠𝑡⁄  

If Ic > Ic min 

OCR Overconsolidation ratio 𝑂𝐶𝑅 = 𝑃𝐶 𝐸𝑆⁄  

If  Ic > Ic min 

ST Sensitivity 
𝑆𝑇 =

100

𝐹𝑅 × 𝑁𝑘𝑡
 

If  Ic > Ic min 
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SBT_RF 

 

 

SBTN_FR 

Soil Behavior Type (SBT) based 

on Qt-Rf chart 

 

Normalized Soil Behavior Type 

(SBT) based on Qtn-Fr chart  

 

 

SBT_BQ 

 

 

SBTN_BQ 

Soil Behavior Type (SBT) based 

on Qt-Bq chart 

 

Normalized Soil Behavior Type 

(SBT) based on Qtn-Bq chart 
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SBT_IC 

 

 

SBTN_IC 

Soil Behavior Type (SBT) based 

on ISBT  value 

 

Normalized Soil Behavior Type 

(SBT) based on Ic value 

SBT = 7 if ISBT or Ic < 1.31 

SBT = 6 if ISBT or Ic < 2.05 

SBT = 5 if ISBT or Ic < 2.60 

SBT = 4 if ISBT or Ic < 2.95 

SBT = 3 if ISBT or Ic < 3.6 

Otherwise, SBT = 2 

8.4. Static cone form (OBSOLETE) 

WARNING: THE STATIC CONE FORM WILL BE REMOVED IN A FUTURE RELEASE. WE RECOMMEND 

USING THE PIEZOCONE FORM (PARAGRAPH 8.3). 

The form shows data from the CPT table and its secondary table CPT_POINT of the Geotec database. It is 

used to describe static cone penetration tests (CPT) and the measurements.  

• The site number and the boring number together constitute the key of the records. 

• The site and boring numbers identify the boring where a static cone penetration test was done. 

The drop-down lists show all sites that have a least one boring defined in the BORING table, then all 

borings of the BORING table for the selected site. 

• A test number can be added; with 20 characters maximum. 

• The maximum tip resistance obtained during the test is entered; in kPa.  

• The maximum total resistance obtained during the test is entered; in kPa. 

• The penetration velocity for the rods into the soil is entered, in mm/min. 

• The tip diameter is in mm. 

• The apical angle is entered, in degrees. 

• The projected section can be inputted.  

• The piston and sleeve areas are entered, in cm2. 

• Transfer is a 1-character code to classify records for their management. 

The table at the bottom of the Static cone form shows data from the CPT_POINT secondary table of the 

Geotec database. 

• The site number, the boring number and the depth together constitute the key of the records. 

• The penetration depth where the cone penetration resistance and the local lateral friction are 

determined is entered, in meters. 

• The tip resistance, i.e. the strength necessary to drive the conic tip, is entered in kPa.  

• The total resistance is entered in kPa.  
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• The penetration resistance of the cone qc is entered, in kPa. 

• The local lateral unit friction fs is entered, in kPa.  

• Remark is alphanumeric with 255 characters for additional details on the test at the given depth. 

• Transfer is a 1-character code to classify records for their management. 

8.5. Dynamic test form 

The form shows data from the DPT table and its secondary table DPT_POINT of the Geotec database. It 

is used to define dynamic cone penetration tests. 

• The site number and the boring number together constitute the key of the records. 

• The site and boring numbers identify the boring where dynamic penetration tests were done. The 

drop-down lists show all sites that have a least one boring defined in the BORING table, then all 

borings of the BORING table for the selected site. 

• A test number can be added; with 20 characters maximum. 

• The hammer weight is generally entered in kg.  

• The height of fall is generally entered, in meters.  

• The depth increment per measurement can be inputted. A default value of 0.3048 m (1 foot) is 

displayed. The increment is used when inserting new rows in the bottom table. 

• Transfer is a 1-character code to classify records for their management. 

The table at the bottom of the Dynamic test form shows data from the DPT_POINT secondary table of 

the Geotec database. 

• The site number, the boring number and the depth together constitute the key of the records. 

• The top depth, before the blows, is entered. If a depth increment is defined, each new depth will 

be automatically incremented by this value. If no increment is defined, the depth will be 

incremented by the difference between the 1st and 2nd depths entered. 

• The number of blows (NB) necessary for the cone to penetrate from the current depth to the 

following is entered.  

• Remark is alphanumeric with 255 characters for additional details on the test at the given depth. 

• Transfer is a 1-character code to classify records for their management. 
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Figure 33 – Dynamic test entry form 

8.6. Cobra form 

The form shows data from the COBRA table and its secondary table COBRA_POINT of the Geotec 

database. It is used to define cobra tests. 

• The site number, the boring number and the test number together constitute the key of the 

records. 

• The site and boring numbers identify the boring where cobra tests were done. The drop-down lists 

show all sites that have a least one boring defined in the BORING table, then all borings of the 

BORING table for the selected site. 

• The test number has 20 characters maximum. 

• The diameters of the rods and tips are entered; the suggested unit is the millimeter.  

• The refusal depth indicates the depth where the cobra boring ended; the suggested unit is the 

meter. 

• The groundwater depth indicates where the water is.  

• Remark is alphanumeric with 255 characters for additional details on the test. 

• Transfer is a 1-character code to classify records for their management. 

The table at the bottom of the Cobra form shows data from the COBRA_POINT secondary table of the 

Geotec database. 

• The site number, the boring number, the test number and the depth together constitute the key of 

the records. 

• The top depth of a measurement of penetration time is entered; the suggested unit is the meter.  

• Time is the elapsed time since the beginning of the test; the suggested unit is the second.  
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• Rate is the penetration rate, or the penetration time for 1 m; the unit is the second.  

• Transfer is a 1-character code to classify records for their management. 

 

Figure 34 – Cobra entry form 

8.7. Other properties form 

The form shows data from the PROPERTY_VALUE table of the Geotec database. It is used to enter values 

of various properties that do not have a specific entry form in Geotec. The properties are defined by the 

user in the Properties form (paragraph 10.8). 

• The site number, the boring number, the top depth and the property together constitute the key 

of the records. 

• The site and boring numbers identify the boring for which various properties have been measured. 

The drop-down lists show all sites that have a least one boring defined in the BORING table, then all 

borings of the BORING table for the selected site. 

• If the property was measured on a sample or sub-sample, enter its number. If a number is entered, 

its top and bottom depth are automatically retrieved and displayed in the form. 

• The top and bottom depths of the measurement, if applicable, are entered; the suggested unit is 

the meter. If the measurement applies to a sample / sub-sample, its depths are automatically 

indicated.  

• The property defines what we are measuring. The property must have been defined in the 

Properties form (paragraph 10.8) before you can add measurements.  

• Two numeric values can be entered for the property.  

• A remark of 255 characters is used to add details or textual values.  

• Transfer is a 1-character code to classify records for their management. 

The values and remark can be entered via a table in the Sample form, which displays all properties 

whose measurement type is “3 –  ample”, whose order is positive and that are not hidden (paragraph 

10.8). When data is inserted via this table, the depths of the corresponding sample / sub-sample are 

automatically entered.  
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Property values can be displayed in the graphic modules, by entering the property in the Series cell of 

the curve of the PROPERTY_VALUE graph.  See the documentations of Log, Pro and Site for more details. 

8.7.1. Calculations 

The calculation function retrieves the depths of the samples or sub-samples entered in the SAMPLE 

table and updates them in the PROPERTY_VALUE table. If values are linked to a depth, interval or run, 

nothing is calculated.  

 

Figure 35 – Other properties entry form 

8.8. Absorption form 

The form shows data from the ABSORPTION table of the Geotec database. It is used to enter test results 

for water absorption of the rock measured between two depths.  

• The site number, the boring number, the test number and the top depth together constitute the 

key of the records. 

• The site and boring numbers identify the boring where the absorption measurements were taken. 

The drop-down lists show all sites that have a least one boring defined in the BORING table, then all 

borings of the BORING table for the selected site. 

• The test number has up to 20 characters. 

• The depths of the top and bottom packers for the test are entered, in meters. The bottom depth is 

also required.  

• The absorption measured is entered; the suggested unit is L/min/m.  

• The maximum pressure used during the test is entered; in kPa.  

• The permeability measured by the absorption test is entered; in m/s.  

• Remark is alphanumeric with 255 characters. 

• Category is used to enter a code to categorize the test, with 20 characters. 

• Transfer is a 1-character code to classify records for their management. 
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Figure 36 – Absorption entry form  

8.9. Lugeon form 

The form shows data from the LUGEON table of the Geotec database. It is used to enter results of 

Lugeon tests to determine the permeability of a geologic formation.  

• The site number, the boring number and the top depth together constitute the key of the records. 

• The site and boring numbers identify the boring where the Lugeon test was done. The drop-down 

lists show all sites that have a least one boring defined in the BORING table, then all borings of the 

BORING table for the selected site. 

• The depths of the top and bottom packers for the test are entered, in meters. The bottom depth is 

also required.  

• The average water pressure (MPa) is inputted for the 5 stages of water injection.  

• The average flow (L/min) is inputted for the 5 stages of water injection.  

• The water absorption in Lugeon units (L/min/m at a pressure of 1 MPa) is entered.  

• The permeability measured by the Lugeon test is entered; in m/s.  

• Remark is alphanumeric with 255 characters. 

• Category is used to enter a code to categorize the test, with 20 characters. 

• Transfer is a 1-character code to classify records for their management. 
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Figure 37 – Lugeon entry form  

8.10. Permeability form 

The form shows data from the PERMEABILITY table of the Geotec database. It is used to enter 

permeability measurements for a boring. 

• The site number, the boring number and the depth together constitute the key of the records. 

• The site and boring numbers identify the boring where the permeability measurements were 

taken. The drop-down lists show all sites that have a least one boring defined in the BORING table, 

then all borings of the BORING table for the selected site. 

• The depth of the permeability measurement is entered; the suggested unit is the meter.  

• The length of the measurement is entered; the suggested unit is the meter.  

• The type of test used to determine the permeability is indicated, with 20 characters. 

• The permeability measured by the test is entered; in m/s.  

• Remark is alphanumeric with 255 characters. 

• Category is used to enter a code to categorize the test, with 20 characters. 

• Transfer is a 1-character code to classify records for their management. 

 

Figure 38 – Permeability entry form  

8.11. Tromino form 

The form shows data from the TROMINO table of the Geotec database. It is used to enter results of tests 

done with the Tromino apparatus for geophysics.  

• The site number and the boring number together constitute the key of the records. 

• The site and boring numbers identify the boring where the Tromino test was done. The drop-down 

lists show all sites that have a least one boring defined in the BORING table, then all borings of the 

BORING table for the selected site. 

• The frequency F0 is between 0 and 500 Hz.  

• The standard deviation is numeric, in meters.  
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• The confidence level is a 2-character field indicating the quality of the measurement.  

• The region of the reference graph is entered.  

• The estimated depth of dense layer is entered, in meters. 

• Remark is alphanumeric with 255 characters. 

 

Figure 39 – Tromino entry form  

9.  Entry forms for laboratory tests 

In the Entry forms menu, the entry forms laboratory tests are available via the buttons of the fourth tab. 

Four entry forms are for laboratory management, including the sieving methods used, the grain size 

requirements, the hydrometer calibrations and the lab equipment.  

9.1. Grain size analysis form 

The form shows data from the GRAIN_SIZE table and its secondary table GRAIN_SIZE_POINT of the 

Geotec database. The Hydrometer tab also shows data from the HYDROMETER table. The form is used 

to enter lab measurements and calculate the results of grain size analyses, including sieving and 

sedimentation.  

• The site number, the boring number and the sample number together constitute the key of the 

records. 

• The site, boring and sample numbers identify the sample on which the sieving analysis and, if 

applicable, sedimentation test was done.   

The drop-down list of sites shows all sites that have a least one sample defined in the SAMPLE 

table. The drop-down list of borings shows all borings that belong to the site selected and that have 

at least one sample defined in the SAMPLE table.  The drop-down list of samples shows all samples 

defined in the SAMPLE table for the selected boring.  

• The type of material analyzed can be selected from the list of materials and their description 

defined in the MATERIAL table (paragraph 10.9). Double-click in the field to open the corresponding 

form for editing.  
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By default, the material associated to the sample is suggested. If there is none, then the one 

associated to the boring of the sample is suggested. Otherwise, NIL is shown.  

If a sieving method and / or a grain size requirement is associated to the material, they will be 

automatically displayed in the next 2 fields.  

• The sieving method used in the lab is selected from the list showing all sieving methods defined 

(paragraph 9.11). Double-click in the field to open the corresponding form for editing.  

The weighing method (individual or cumulative), the balance number and the weighing unit (g, kg 

or lb) for the coarse, medium and fine fractions are automatically copied in the definition of the 

grain size. Also, the sieve diameters defined in the method are generated for the curve.  

• A grain size requirement can be selected from the list showing all grain size requirements defined 

(paragraph 9.12). Double-click in the field to open the corresponding form for editing. 

The envelope can be displayed on the graphic report and the conformity of the curve will be 

verified by Geotec. 

• The classification standard is entered with 20 characters. It is for future development. 

The Water content button opens the limits entry form to define the natural water content measured on 

the sample. See paragraph 9.2 for details. 

The Stratigraphy button opens the stratigraphy entry form to define the % of cobbles and boulders for 

the layer where the sample was taken. These percentages can be included in the correction of grain size 

curves in the Lab module. See paragraph 6.1 for the details on the layers and the documentation of Lab 

for the curve correction. The button may also be labelled Cobbles to open the cobbles entry form for the 

same purpose, but this option is obsolete and will be removed in a future release.  

The Combine button is used to calculate grain size combinations. It can only be used in Lab. See the 

documentation of Lab.  

The USCS button opens the calculation window. It is used to calculate the USCS value and insert it into 

the USCS field of the SAMPLE table for the corresponding sample. In the calculation window, you can 

choose to fill only the empty fields, not the existing values. To do this, check the box Fill empty fields 

only. Otherwise, the calculation overwrites existing USCS values. See the calculation details in section 

9.1.1.1.  

The Description button opens the calculation window. It is used to calculate the Description based on 

the grain size and insert it into the DESCRIPTION field of the SAMPLE table for the corresponding 

sample. In the calculation window, you can choose to fill only the empty fields, not the existing values. 

To do this, check the box Fill empty fields only. Otherwise, the calculation overwrites existing 

DESCRIPTION values. See the calculation details in section 9.1.1.1. 

9.1.1. Results 

The Results tab at the top of the entry form shows calculation results done by Geotec from lab 

measurements of sieving and sedimentation tests. By clicking on the Results tab, the same tab gets 
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activated at the bottom of the form to display the diameters and calculated passing percentages as well 

as the raw data, or to enter the diameters and passing percentages directly, without raw data. The tab 

at the bottom shows data from the GRAIN_SIZE_POINT secondary table of the Geotec database. 

In Passing percentages… 

• The fields 225 mm to 0.002 mm contain the passing percentages of the various sieves Px, between 
0 and 100%. They are calculated by Geotec via a linear interpolation on logarithmic basis, based on 
the points of the curve indicated in the bottom table.  

If the passing percentage of the largest diameter is between 95% and 100%, an extrapolation is 
done, if necessary, for the diameters greater than 0.075 mm – in other words, so the curve reaches 
100%.  

An option is available in Lab to force the extrapolation for the diameters greater than 0.075 mm but 
smaller than the largest diameter – in other words, to bring the curve down to the silt. Otherwise, 
the curve is not extrapolated to small diameters.  

• The fineness module is calculated by Geotec as: 

  𝑓𝑚 = 10 −
[𝑃0.16+𝑃0.315+𝑃0.63+𝑃1.25+𝑃2.5+𝑃5+𝑃10+𝑃20+𝑃40+𝑃80]

100
 

In Diameters and coefficients… 

• The fields D10, D30 and D60 contain the diameters corresponding to 10%, 30% and 60% of the 
particles. They are calculated by Geotec via a linear interpolation on logarithmic basis, based on the 
points of the curve indicated in the bottom table.  

An option is available in Lab to force the extrapolation to calculate the diameters Dx smaller than 

the largest diameter of the curve. The diameters Dx are not extrapolated if they would be greater 

than the largest diameter of the curve. Without the option, the diameters Dx are not extrapolated.  

• Cu is the uniformity coefficient. Cu is not a field of the database. It is calculated by Geotec as:  

  𝐶𝑢 =
𝐷60

𝐷10
   if D10 > 0.001 and D60 > 0.001 and D60 < 1000 

• Cc is the concavity coefficient. Cc is not a field of the database. It is calculated by Geotec as:  

  𝐶𝑐 =
𝐷30×𝐷30

𝐷10×𝐷60
    if D10 > 0.001 and D30 > 0.001 and D60 > 0.001 

• The fields Silt, Sand, Gravel, Cobbles and Boulders are not fields of the database. They are 
calculated by Geotec as:  

  𝑆𝑖𝑙𝑡 = 𝑃0.08 − 𝑃0.002    

If P0.002 is NULL, it corresponds to the percentages of fine particles, because the percentage of clay is 
not known.  

  𝑆𝑎𝑛𝑑 = 𝑃5 − 𝑃0.08  

  𝐺𝑟𝑎𝑣𝑒𝑙 = 𝑃80 − 𝑃5  

  𝐶𝑜𝑏𝑏𝑙𝑒𝑠 = 𝑃225 − 𝑃80  

  𝐵𝑜𝑢𝑙𝑑𝑒𝑟𝑠 = 100 − 𝑃225  
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The sample characterization shows the calculations based on the grain size analysis, as well as the data 

from the SAMPLE table, for information purposes, including: 

• The description based on the grain size curve, calculated by Geotec. 

• The description entered for the current sample. 

• The USCS classification calculated by Geotec.  

• The USCS classification of the current sample. 

• Category is used to enter a code to categorize the test, with 20 characters. It is mainly used for 

grain size combinations. The value CMB-xx is entered in the record of a grain size used in a 

combination. See the documentation of Lab for details about combinations. 

• The category of the current sample. It can be the type of soil indicated in the soil description 

matrix. It can also be the value CMB-xx which is entered in the record of a sample used in a 

combination.  

• The length of the grain size is used for results of grain size combinations. The length is the sum of 

the lengths of all samples combined.  

• The length of the current sample.  

In Management… 

• When the calculation is done (via the button  or using Action > Calculate), the calculation date is 

updated. 

• When a modification to the test is saved, the modification date is updated. 

• The smoothing of the grain size curve can be fixed; however, offset values entered at specific points 

of the curve take precedence over the global smoothing. With a value of -1, no smoothing of the 

grain size curve is done and the offset values for each point of the curve are not taken into account.  

If no smoothing is defined in the Grain size table, the calculation is done with the smoothing 

defined in the options of Lab.    
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Figure 40 – Grain size entry form – Results 

The table of the Results tab at the bottom of the form shows data from the GRAIN_SIZE_POINT 

secondary table of the Geotec database. 

• The site number, the boring number, the sample number and the diameter together constitute 

the key of the records. 

• The diameter of the sieves or particles is in millimeters; with a precision of 4 decimals. The 
diameters can be entered or generated automatically by selecting a sieving method.  

• The % passing the sieve is either entered by the user, or copied during the calculation by Geotec of 
the results based on the raw data in the SIEVE_POINT (Sieving tab) and HYDROMETER_POINT 
(Hydrometer tab) tables.  



DATA ENTRY FORMS | Version 8.12.1 | Page 103 

  

• The reading is either the mass retained on the sieves (individual or cumulative) of the SIEVE_POINT 
table, or the hydrometer reading of the HYDROMETER_POINT table. These values are copies 
automatically.  

• The elapsed time, in minutes, for the hydrometer test, is a raw data in the HYDROMETER_POINT 
table. The values are copies automatically.  

• The temperature in degrees Celsius, for the hydrometer test, is a raw data in the 
HYDROMETER_POINT table. The values are copies automatically.  

• The reading correction, for the hydrometer test, is a raw data in the HYDROMETER_POINT table if 
the composite correction was not used. The values are copies automatically. 

• The smoothing (Z) is used for the smoothing of the grain size curve at the current point. It contains 

the offset around the point for the curve.  With a value of -1, the curve goes through the point as a 

straight line – there is no smoothing. With a value of 0, the curve goes through the point with a 

rounded line; the greater the value, the more the curve is smoothed at the point.  A smoothing 

coefficient for the whole curve can be defined in the Grain size table and / or in the options or Lab; 

see the documentation of Lab. 

• Transfer is a 1-character code to classify records for their management. By putting "X" in the 

Transfer field, the point will not be displayed in the curve and not included in the calculations. 

9.1.1.1 Calculations 

The grain size description is determined from the materials and their proportions.  

• Geotec calculates the percentages of materials.  

o The clay percentage is P0.002 

o The silt percentage is P0.08 – P0.002 

o The sand percentage is P5-P0.08 

o The gravel percentage is P80-P5 

o The cobbles percentage is P225-P80 

o The boulders percentage is 100-P225 

• The proportions are then determined from the percentages of materials. 

o If percentage is < 1 %  → material not included 

o Otherwise, if percentage is < 10 % → proportion 4 (trace) 

o Otherwise, if percentage is < 20 % → proportion 3 (some) 

o Otherwise, if percentage is < 35 % → proportion 2 (adjective) 

o Otherwise   → proportion 1 (main) 

• The description is then generated based on the material and its proportion. 

The USCS is calculated based on the grain size curve only if P0.08 is less than 50 %. Otherwise, the limits 

test is used to calculate the USCS classification.  
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• By default, coarse is S.  Is there more gravel than sand? P5 < (100 + P0.08)/2 ? 

o If yes, coarse is G.  

o If no, coarse is S.  

• By default, fine is M. If there most clay than silt? P0.002 > P0.08/2 or P0.002 > 50? 

o If yes, fine is C.  

o If no, fine is M.  

• For gravels, the gradation is W by default (if Cu or Cc is not defined). Geotec verifies Cu and CC. 

o If  u ≥ 4 and 1 ≤  c ≤ 3, gradation is W.  

o Otherwise, if Cu > 0 and Cc > 0, gradation is P.  

• For sands, the gradation is W by default (if Cu or Cc is not defined). Geotec verifies Cu and CC. 

o If  u ≥ 6 and 1 ≤  c ≤ 3, gradation is W.  

o Otherwise, if Cu > 0 and Cc > 0, gradation is P.  

• To create the USCS classification, Geotec verifies the percentage of fine particles.  

o IF P0.08 < 5 %   →      = CoarseGradation  
   like GW, GP, SW, SP 

o Otherwise, if P0.08 > 12 % →      = CoarseFine 
   like GM, GC, SM, SC 

o Otherwise  →      = CoarseGradation-CoarseFine 
  like GW-GM, GW-GC, GP-GM, GP-GC, SW-SM, SW-SC, SP-SM, SP-SC 

9.1.2. Sieving 

The Sieving tab at the top of the entry form is used to enter raw data for the sieving test done. By 

clicking on the Sieving tab, the same tab gets activated at the bottom of the form to enter the 

measurements for each sieve. The bottom tab shows the SIEVE_POINT temporary table.  

 n  anagement data… 

• Enter up to 40 characters in the fields Realized by and Verified by. 

• The test date and verification date are noted in the format yyyy-mm-dd hh:mi:ss. 

• The name or number of the laboratory where the test was done is noted, with 20 characters. 

• The name of the data file can be entered, with a maximum of 255 characters. By clicking on the 

button right of the field, the Windows file selection screen opens.  

To save the file with its full path, enable the option in the preferences. See the X3D documentation. 

• Remark is alphanumeric with 255 characters for additional details. 

The laboratory apparatus used for the sieving test are indicated. This ensures better monitoring in the 

event that an equipment is faulty.  
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• The number of the balances used for weighing for coarse, medium and fine fractions are indicated, 

with 20 characters. The list of apparatus numbers defined in the EQUIPMENT table and whose 

category begins with BAL is suggested (paragraph 9.14). 

If balances are associates to the selected sieving method, their numbers are automatically entered.  

The auxiliary water contents are only used for wet soils tests. If sieving is done on dry materials, leave 

these fields empty or indicate a water content of 0%. Otherwise, for the coarse (wstone) and fine (wsand) 

fractions, enter:  

• The tare number, with 20 characters. The list of apparatus numbers defined in the EQUIPMENT 

table and whose category begins with TARE is suggested (paragraph 9.14). 

• The tare mass. If a mass is defined in the EQUIPMENT table for the selected tare, it will be 

displayed. The unit is the one defined for the sieving method.  

• The mass of the tare and wet soil. The unit is the one defined for the sieving method. 

• The mass of the tare and dry soil. The unit is the one defined for the sieving method. 

• The water content, in %. It is calculated by Geotec or can be entered by the user.  

   𝑤 =
𝑚𝑎𝑠𝑠𝑡𝑎𝑟𝑒 𝑤𝑒𝑡 𝑠𝑜𝑖𝑙−𝑚𝑎𝑠𝑠𝑡𝑎𝑟𝑒 𝑑𝑟𝑦 𝑠𝑜𝑖𝑙

𝑚𝑎𝑠𝑠𝑡𝑎𝑟𝑒 𝑑𝑟𝑦 𝑠𝑜𝑖𝑙−𝑚𝑎𝑠𝑠𝑡𝑎𝑟𝑒
× 100% 

Then, define the soil fractions, depending on the sieving method selected (paragraph 9.11).  

• Enter the maximum diameter of the particles, if needed.  

• For each quartering of the selected sieving method, so for the coarse (total), medium (gravel) and 

fine (sand) fractions:  

o The maximum and minimum diameters of the sieves are indicated.  

o Enter for mass to be sieved. The mass is of the wet soil. The unit is indicated next to the field, 
depending on the one defined for the sieving method. 

If the soil was already dried before weighing, do not indicate an auxiliary water content, or 
enter 0%.  

If just one or two quarterings are defined for the method, then only those defined will have 

diameters. The Mass field will be deactivated for non-defined quarterings.  

• After washing: 

o Indicate the tare number used for the sand fraction, with 20 characters. The list of apparatus 
numbers defined in the EQUIPMENT table and whose category begins with TARE is suggested 
(paragraph 9.14). 

o Indicate the tare mass. If a mass is defined in the EQUIPMENT table for the selected tare, it will 
be displayed. The mass is in grams.  

o Enter the mass of the tare and dry sand, after washing. If the tare mass is not indicated, enter 
the mass of the dry sand directly, in grams.  



DATA ENTRY FORMS | Version 8.12.1 | Page 106 

  

 

Figure 41 – Grain size entry form – Sieving 

In the Sieving tab at the bottom of the entry form: 

• The sieve diameters defined in the sieving method are generated automatically. For each sieve, 

indicate the cumulative or individual mass, depending on the type of weighing indicated in the 

sieving method. Indicate the mass measured in the pan to verify the acceptability of the test.  

9.1.2.1 Calculations 

The following calculations are done for the sieving test (top part of the entry form): 

• The dry mass of the fine fraction (sand) is calculated as:  

   𝑚𝑎𝑠𝑠𝑑𝑟𝑦 𝑠𝑎𝑛𝑑 =
𝑚𝑎𝑠𝑠𝑤𝑒𝑡 𝑠𝑎𝑛𝑑

1+
𝑤𝑠𝑎𝑛𝑑

100

 

• The dry mass of the medium fraction (gravel) is calculated as:  

   𝑚𝑎𝑠𝑠𝑑𝑟𝑦 𝑔𝑟𝑎𝑣𝑒𝑙 =
𝑚𝑎𝑠𝑠𝑤𝑒𝑡 𝑔𝑟𝑎𝑣𝑒𝑙−𝑚𝑎𝑠𝑠𝑐𝑢𝑚 𝑔𝑟𝑎𝑣𝑒𝑙

1+
𝑤𝑠𝑎𝑛𝑑

100

+
𝑚𝑎𝑠𝑠𝑐𝑢𝑚𝑔𝑟𝑎𝑣𝑒𝑙

1+
𝑤𝑠𝑡𝑜𝑛𝑒

100

 

• Then the water content of the medium fraction is calculated as: 



DATA ENTRY FORMS | Version 8.12.1 | Page 107 

  

   𝑤𝑔𝑟𝑎𝑣𝑒𝑙 =
𝑚𝑎𝑠𝑠𝑤𝑒𝑡 𝑔𝑟𝑎𝑣𝑒𝑙−𝑚𝑎𝑠𝑠𝑑𝑟𝑦 𝑔𝑟𝑎𝑣𝑒𝑙

𝑚𝑎𝑠𝑠𝑑𝑟𝑦 𝑔𝑟𝑎𝑣𝑒𝑙
× 100% 

• The total dry mass is calculated as:  

   𝑚𝑎𝑠𝑠𝑑𝑟𝑦 𝑡𝑜𝑡𝑎𝑙 =
𝑚𝑎𝑠𝑠𝑤𝑒𝑡 𝑡𝑜𝑡𝑎𝑙−𝑚𝑎𝑠𝑠𝑐𝑢𝑚 𝑠𝑡𝑜𝑛𝑒

1+
𝑤𝑔𝑟𝑎𝑣𝑒𝑙

100

+
𝑚𝑎𝑠𝑠𝑐𝑢𝑚 𝑠𝑡𝑜𝑛𝑒

1+
𝑤𝑠𝑡𝑜𝑛𝑒

100

 

where:  

wsand is the auxiliary water content of the sand fraction (for wet soil test) 

wstone is the auxiliary water content of the stone fraction (for wet soil test) 

wgravel is the water content calculated for the mass used after the 1st quartering 

masscum gravel is the cumulated mass on the smallest diameter of the medium fraction 

masscum stone is the cumulated mass on the smallest diameter of the coarse fraction 

The following calculations are done for each diameter of the sieving test (bottom part of the entry 

form). The results are shown as information in the disabled columns.  

• The dry mass of sand, the dry mass of the medium fraction and to total dry mass are copied into 

the Total dry mass column, as information, for the diameters corresponding to the 3 fractions.  

• The individual mass is either entered, or equal to the cumulative mass minus the previous 

cumulative mass.  

• The cumulative mass is either entered, or equal to the sum of the individual mass and the previous 

cumulative mass.  

• The cumulative dry mass is calculated as: 

   𝑚𝑎𝑠𝑠𝑐𝑢𝑚 𝑑𝑟𝑦 =
𝑚𝑎𝑠𝑠𝑐𝑢𝑚 𝑤𝑒𝑡

1+
𝑤𝑠𝑡𝑜𝑛𝑒

100

 

For the sand fraction, the dry mass equals the mass indicated. It is understood that the test is done 

with dry soil.  

• The % retained on the sieve is calculated from the dry mass of the fraction indicated in the 1st 

column 

   % 𝑟𝑒𝑡𝑎𝑖𝑛𝑒𝑑 =
𝑚𝑎𝑠𝑠𝑐𝑢𝑚 𝑑𝑟𝑦

𝑚𝑎𝑠𝑠𝑑𝑟𝑦 𝑓𝑟𝑎𝑐𝑡𝑖𝑜𝑛
 

• The passing % are calculated for each fraction as well as for the total.  

o For the coarse fraction:  % 𝑝𝑎𝑠𝑠𝑖𝑛𝑔𝑡𝑜𝑡𝑎𝑙 = 100 − % 𝑟𝑒𝑡𝑎𝑖𝑛𝑒𝑑 

o For the medium fraction:   

o % 𝑝𝑎𝑠𝑠𝑖𝑛𝑔𝑚𝑒𝑑𝑖𝑢𝑚 = 100 − % 𝑟𝑒𝑡𝑎𝑖𝑛𝑒𝑑  

The heading of this column indicates the minimum diameter of the coarse fraction. 

o % 𝑝𝑎𝑠𝑠𝑖𝑛𝑔𝑡𝑜𝑡𝑎𝑙 =
% 𝑝𝑎𝑠𝑠𝑖𝑛𝑔𝑙𝑎𝑠𝑡 𝑡𝑜𝑡𝑎𝑙 × % 𝑝𝑎𝑠𝑠𝑖𝑛𝑔𝑚𝑒𝑑𝑖𝑢𝑚

100
  

where % 𝑝𝑎𝑠𝑠𝑖𝑛𝑔𝑙𝑎𝑠𝑡 𝑡𝑜𝑡𝑎𝑙 is the total % passing the minimum diameter of the coarse 
fraction.  
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o For the fine fraction:   

o % 𝑝𝑎𝑠𝑠𝑖𝑛𝑔𝑓𝑖𝑛𝑒 = 100 − % 𝑟𝑒𝑡𝑎𝑖𝑛𝑒𝑑  

The heading of this column indicates the minimum diameter of the medium fraction. 

o % 𝑝𝑎𝑠𝑠𝑖𝑛𝑔𝑚𝑒𝑑𝑖𝑢𝑚 =
% 𝑝𝑎𝑠𝑠𝑖𝑛𝑔𝑙𝑎𝑠𝑡 𝑚𝑒𝑑𝑖𝑢𝑚 × % 𝑝𝑎𝑠𝑠𝑖𝑛𝑔𝑓𝑖𝑛𝑒

100
   

where % 𝑝𝑎𝑠𝑠𝑖𝑛𝑔𝑙𝑎𝑠𝑡 𝑚𝑒𝑑𝑖𝑢𝑚 is the medium % passing the minimum diameter of the 
medium fraction.  

o % 𝑝𝑎𝑠𝑠𝑖𝑛𝑔𝑡𝑜𝑡𝑎𝑙 =
% 𝑝𝑎𝑠𝑠𝑖𝑛𝑔𝑙𝑎𝑠𝑡 𝑡𝑜𝑡𝑎𝑙 ×% 𝑝𝑎𝑠𝑠𝑖𝑛𝑔𝑙𝑎𝑠𝑡 𝑚𝑒𝑑𝑖𝑢𝑚 × % 𝑝𝑎𝑠𝑠𝑖𝑛𝑔𝑓𝑖𝑛𝑒

100
   

• The existing passing % indicates the value saved in the database before the last calculations.  

• If a grain size envelope is selected, the minimum and maximum passing % defined for the envelope 

are indicated at the corresponding diameters, and are concatenated in the column Passing min-

max.  

• The compliance at each diameter that has a requirement is verified by Geotec. If the passing % is 

less than the minimum requirement or more than the maximum requirement, the passing % is Non-

Compliant (N.C.).  

• For each fraction, the mass on the pan can be entered. The loss percentage is calculated for the 

test validity and shown in the Passing total column.  

  % 𝑙𝑜𝑠𝑠𝑐𝑜𝑎𝑟𝑠𝑒 =
𝑚𝑎𝑠𝑠𝑡𝑜𝑡𝑎𝑙 𝑤𝑒𝑡 −𝑚𝑎𝑠𝑠𝑐𝑢𝑚 𝑝𝑎𝑛

𝑚𝑎𝑠𝑠𝑡𝑜𝑡𝑎𝑙 𝑤𝑒𝑡
× 100 

  % 𝑙𝑜𝑠𝑠𝑚𝑒𝑑𝑖𝑢𝑚 =
𝑚𝑎𝑠𝑠𝑔𝑟𝑎𝑣𝑒𝑙 𝑤𝑒𝑡−𝑚𝑎𝑠𝑠𝑐𝑢𝑚 𝑝𝑎𝑛

𝑚𝑎𝑠𝑠𝑔𝑟𝑎𝑣𝑒𝑙 𝑤𝑒𝑡
× 100 

  % 𝑙𝑜𝑠𝑠𝑓𝑖𝑛𝑒 =
𝑚𝑎𝑠𝑠𝑠𝑎𝑛𝑑 𝑤𝑎𝑠ℎ𝑒𝑑−𝑚𝑎𝑠𝑠𝑐𝑢𝑚 𝑝𝑎𝑛

𝑚𝑎𝑠𝑠𝑠𝑎𝑛𝑑 𝑤𝑎𝑠ℎ𝑒𝑑
× 100 

where  

masscum pan is the cumulative mass on the pan for the fraction indicated  

masssand washed is the mass of dry sand after washing 

The sieve diameter, reading (individual or cumulative mass) and total passing percentage are copied in 

table GRAIN_SIZE_POINT, visible in the Results tab at the bottom of the entry form.  

9.1.3. Hydrometer 

The Hydrometer tab at the top of the entry form shows data from the HYDROMETER table of the Geotec 

database. It is used to enter raw data for the hydrometer test done. The tab is displayed as soon as a 

GRAIN_SIZE record exists. By clicking on the Hydrometer tab, the same tab gets activated at the bottom 

of the form to enter the readings. The bottom tab shows the HYDROMETER_POINT temporary table.  

 n  anagement data… 

• Enter up to 40 characters in the fields Realized by and Verified by. 

• The test date and verification date are noted in the format yyyy-mm-dd hh:mi:ss. 

• The name or number of the laboratory where the test was done is noted, with 20 characters. 
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• The name of the data file can be entered, with a maximum of 255 characters. By clicking on the 

button right of the field, the Windows file selection screen opens.  

To save the file with its full path, enable the option in the preferences. See the X3D documentation. 

• Remark is alphanumeric with 255 characters for additional details. 

The Dry mass calculation is used to determine the equivalent dry mass of the sample used for the 

hydrometer test.   

• The method is selected from: 

o 1: moisture content (low water % after air-drying) 

o 2: water content (higher water %, often in clays) 

o 3: oven drying 

• Enter the tare number, with 20 characters. The list of apparatus numbers defined in the 

EQUIPMENT table and whose category begins with TARE is suggested (paragraph 9.14). 

• Enter the tare mass, in grams. If a mass is defined in the EQUIPMENT table for the selected tare, it 

will be displayed. 

• For methods 1 and 2 

o Enter the mass of the tare and air-dried or wet soil, in grams. 

o Enter the mass of the tare and oven-dried soil, in grams. 

o The moisture content or water content is entered or calculated by Geotec as: 

   𝑤 =
𝑚𝑎𝑠𝑠𝑡𝑎𝑟𝑒 𝑤𝑒𝑡 𝑠𝑜𝑖𝑙−𝑚𝑎𝑠𝑠𝑡𝑎𝑟𝑒 𝑑𝑟𝑦 𝑠𝑜𝑖𝑙

𝑚𝑎𝑠𝑠𝑡𝑎𝑟𝑒 𝑑𝑟𝑦 𝑠𝑜𝑖𝑙−𝑚𝑎𝑠𝑠𝑡𝑎𝑟𝑒
× 100% 

• For method 3 

o Enter the mass of the dispersing agent used, in grams.  

o Enter the mass of the tare and oven-dried soil after the hydrometer test, in grams. The 
dispersing agent will also be included in the open-dried solution.  

In Characteristics of sample 

• The specific gravity (Gs) of the sample for the hydrometer test is 2.7 by default. It can be modified.  

• The sieve diameter (mm) is selected from the drop-down list. The suggestions are between 5 mm 

and 0.08 mm. The 2mm sieve is generally used.  

• The passing sieve % is read from the GRAIN_SIZE_POINT table (bottom Results tab) at the sieve 

indicated. If there is no passing percentage for the sieve, Geotec will use the passing % of the 

greater sieve.  

• The mass retained on 0.08 mm (mass0.08) can be entered, in grams.  

• Enter the total mass of the sample for the test, air-dried or wet, in grams.  
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• The equivalent dry mass of the sample, in grams, is included in the calculations. It can be entered 

or calculated by Geotec.  

o For methods 1 and 2: 𝑚𝑎𝑠𝑠𝑑𝑟𝑦 =
𝑚𝑎𝑠𝑠𝑡𝑜𝑡𝑎𝑙

(1+
𝑤

100
)

 

o For method 3:   𝑚𝑎𝑠𝑠𝑑𝑟𝑦 = 𝑚𝑎𝑠𝑠𝑡𝑎𝑟𝑒 𝑑𝑟𝑦 𝑠𝑜𝑖𝑙 − 𝑚𝑎𝑠𝑠𝑡𝑎𝑟𝑒 − 𝑚𝑎𝑠𝑠𝑑𝑖𝑠𝑝𝑒𝑟𝑠𝑖𝑛𝑔 

The laboratory apparatus used for the hydrometer test are indicated. This ensures better monitoring in 

the event that an equipment is faulty and is used to retrieve the specifications of some of the equipment 

used.  

• The hydrometer number is indicated, with 20 characters. The list of hydrometers and their model 

(151H or 152H) defined in the HYDROMETER_CALIBRATION table is suggested (paragraph 9.13). By 

selecting a hydrometer, the standard elapsed time are displayed in the bottom table, from 30 

seconds to 1440 minutes.  

• The bulb length (Lbulb) of the hydrometer is entered, in cm. If it is defined in the 

HYDROMETER_CALIBRATION table for the selected hydrometer, it will be displayed. If the length is 

not entered, a value of 0 cm is used in the calculations.  

• The bulb volume (Vbulb) of the hydrometer is entered, in ml. If it is defined in the 

HYDROMETER_CALIBRATION table for the selected hydrometer, it will be displayed. If the volume is 

not entered, a value of 0 ml is used in the calculations. 

• Coefficients A and B of the calibration curve are entered (CalibA et CalibB). If they are defined in 

the HYDROMETER_CALIBRATION table for the selected hydrometer, they will be displayed. If the 

coefficients are not entered, a coefficient A of -0.266 (151H) or -0.163 (152H) and a coefficient B of 

16.3 are used in the calculations. 

• Coefficients A and B of the composite correction curve are entered (CompA et CompB).  If they are 

defined in the HYDROMETER_CALIBRATION table for the selected hydrometer, they will be 

displayed. If a correction reading is taken rather than the calculation via the composite correction, 

enter 0 in both fields. If the coefficients are not entered, values of 0 are used in the calculations.   

• The density correction factor is entered; the default value is 1. If it is defined in the 

HYDROMETER_CALIBRATION table for the selected hydrometer, it will be displayed. 

• The meniscus is entered. For a 151H, the meniscus is 0.5 by default. For a 152H, the meniscus is 1 

by default. This value will be added to the readings taken at the top of the meniscus (see 

calculations).  

• The number of the cylinder used is indicated, with 20 characters. The list of apparatus numbers 

defined in the EQUIPMENT table and whose category begins with CYL is suggested (paragraph 

9.14). 

• The area A (cm2) and the volume (ml) of the cylinder are entered. If the area and / or the volume 

are defined in the EQUIPMENT table for the selected cylinder, they will be displayed. If the area is 

not entered, a value of 27 cm2 is used in the calculations.  
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• The number of the balance used for weighing is indicated, with 20 characters. The list of apparatus 

numbers defined in the EQUIPMENT table and whose category begins with BAL is suggested 

(paragraph 9.14). 

In the Hydrometer tab at the bottom of the entry form: 

• Adjust, if needed, the elapsed time at the time of reading, in minutes. If no reading is taken at a 

certain time, leave the row empty. It will not be saved.  

• Enter the hydrometer reading. The reading is taken at the top of the meniscus. If the reading is 

done at the bottom of the meniscus, set the meniscus value to 0 and ensure that the calibration 

was also done with readings taken at the bottom of the meniscus.  

• Enter the temperature, in degrees Celsius. It will be copied to the following row when entering the 

next reading.  

• If the reading correction is done via a control solution instead of the composite correction (so 

coefficients A and B for the composite correction are at 0), enter the correction. It will be copied to 

the following row when entering the next reading.  

 

Figure 42 – Grain size entry form – Hydrometer 
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9.1.3.1 Calculations 

The following calculations are done for the hydrometer test (top part of the form) and will be used in 

the calculations of the bottom table.  

• The passing 0.08 mm P0.08 is read at the 0.08 mm sieve in the Results tab at the bottom of the entry 

form.  

• The passing 0.08 mm washed P0.08 washed is calculated if there is a mass retained on 0.08 mm, as:  

   P0.08 washed = 100 −
𝑚𝑎𝑠𝑠0.08

𝑚𝑎𝑠𝑠𝑑𝑟𝑦
× 100 

The following calculations are done for each reading of the hydrometer test (bottom part of the entry 

form). The results are shown as information in the disabled columns. 

• The coefficient of viscosity η of water, in poises: 

   𝜂 = 0.000005 × 𝑡𝑒𝑚𝑝 × 𝑡𝑒𝑚𝑝 − 0.000445 × 𝑡𝑒𝑚𝑝 + 0.01692 

• The K factor is a constant based on the temperature of the soil suspensions and the relative density 

of the soil particles.  

   𝐾 = √
30𝜂

980×(𝐺𝑠−1)
 

• The reading correction is a raw data of the HYDROMETER_POINT table if the composite correction 

is not used. If the composite correction is used, the correction is calculated as: 

   𝑐𝑜𝑟𝑟 = −𝐶𝑜𝑚𝑝𝐴 × 𝑡𝑒𝑚𝑝 + 𝐶𝑜𝑚𝑝𝐵 

• The effective reading corresponds to the reading with the composite correction applied: 

   𝑟𝑒𝑎𝑑𝑖𝑛𝑔𝑒𝑓𝑓 = 𝑟𝑒𝑎𝑑𝑖𝑛𝑔 − 𝑐𝑜𝑟𝑟 

• The effective depth is calculated with the calibration curve: 

   𝑑𝑒𝑝𝑡ℎ𝑒𝑓𝑓 = −𝐶𝑎𝑙𝑖𝑏𝐴 × (𝑟𝑒𝑎𝑑𝑖𝑛𝑔 + 𝑚𝑒𝑛𝑖𝑠𝑐𝑢𝑠) + 𝐶𝑎𝑙𝑖𝑏𝐵 +
𝐿𝑏𝑢𝑙𝑏

2
−

𝑉𝑏𝑢𝑙𝑏

2𝐴
  

If readings are taken between 2 minutes (at 30 seconds, 1 minute and 2 minutes), the hydrometer 

will not be removed from the solution. The last term of the equation (
𝑉𝑏𝑢𝑙𝑏

2𝐴
) is not subtracted for 

those readings.  

• The equivalent diameter of the particles D, in millimeters, is calculated based on  tokes’ law.  

   𝐷 = 𝐾 × √
𝑑𝑒𝑝𝑡ℎ𝑒𝑓𝑓

𝑒𝑡𝑖𝑚𝑒
= √

30𝜂

980×(𝐺𝑠−1)
×

𝑑𝑒𝑝𝑡ℎ𝑒𝑓𝑓

𝑒𝑡𝑖𝑚𝑒
 

• The existing diameter indicates the value saved in the database before the last calculations.  

• The calculation of the particle content Part depends on the hydrometer model.  

For 151H:  𝑃𝑎𝑟𝑡 =
100

𝑚𝑎𝑠𝑠𝑑𝑟𝑦
× 𝑟𝑒𝑎𝑑𝑖𝑛𝑔𝑒𝑓𝑓 × 𝐹 × (

𝐺𝑠

𝐺𝑠 − 1
 ) 
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For 152H:  𝑃𝑎𝑟𝑡 =
100

𝑚𝑎𝑠𝑠𝑑𝑟𝑦
× 𝑟𝑒𝑎𝑑𝑖𝑛𝑔𝑒𝑓𝑓 × 𝐹 × 𝑎 where 𝑎 = 1.53 − (0.2 × 𝐺𝑠) 

• The passing percentage P is calculated with the passing % of the sieve diameter.  

   𝑃 = 𝑃𝑎𝑟𝑡 ×
P𝑠𝑖𝑒𝑣𝑒

100
  where Psieve is 100% if it is not defined.  

If a mass retained on 0.08 mm is indicated,   

   𝑃 = 𝑃𝑎𝑟𝑡 ×
𝑃0.08

𝑃0.08 𝑤𝑎𝑠ℎ𝑒𝑑
   

• The existing passing % indicates the value saved in the database before the last calculations.  

The elapsed time, the reading, the temperature, the reading correction (if read), the equivalent 

diameter and the passing percentage are copied in table GRAIN_SIZE_POINT, visible in the Results tab at 

the bottom of the entry form.  

9.2. Limits form 

The form shows data from the LIMITS table and its secondary table LIMITS_POINT of the Geotec 

database. It is used to enter lab measurements and calculate the results of water content and liquid and 

plastic limits tests. 

• The site number, the boring number and the sample number together constitute the key of the 

records. 

• The site, boring and sample numbers identify the sample on which the water content and / or 

limits test was done.  

The drop-down list of sites shows all sites that have a least one sample defined in the SAMPLE 

table. The drop-down list of borings shows all borings that belong to the site selected and that have 

at least one sample defined in the SAMPLE table.  The drop-down list of samples shows all samples 

defined in the SAMPLE table for the selected boring.  

The USCS button opens the calculation window. It is used to calculate the USCS value and insert it into 

the USCS field of the SAMPLE table for the corresponding sample. In the calculation window, you can 

choose to fill only the empty fields, not the existing values. To do this, check the box Fill empty fields 

only. Otherwise, the calculation overwrites existing USCS values. See the calculation details in the next 

section.  

In Management data… 

• Enter up to 40 characters in the fields Realized by and Verified by. 

• The test date and verification date are noted in the format yyyy-mm-dd hh:mi:ss. 

• The name or number of the laboratory where the test was done is noted, with 20 characters. 

• The name of the data file can be entered, with a maximum of 255 characters. By clicking on the 

button right of the field, the Windows file selection screen opens.  
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To save the file with its full path, enable the option in the preferences. See the X3D documentation. 

• Remark is alphanumeric with 255 characters for additional details. 

The laboratory apparatus used for the test are indicated. This ensures better monitoring in the event 

that an equipment is faulty.  

• The number of the balance used for weighing is indicated, with 20 characters. The list of apparatus 

numbers defined in the EQUIPMENT table and whose category begins with BAL is suggested 

(paragraph 9.14). 

• The number of the Casagrande apparatus or of the cone penetrometer, depending on the test 

used, is indicated with 20 characters. 

• The type of liquid limit indicates either S for Swedish cone or C for Casagrande. This field is 

automatically filled according to the bottom tab where the data is entered. 

• A remark on the preparation of the sample can be added, with 80 characters. 

The results can be directly entered by the user or calculated by Geotec based on the measurements in 

the bottom tables.  

• The natural water content (WN) is in %. 

• The plastic limit (WP) is in %. 

• The liquid limit (WL) is in %. 

• The plasticity (PI) and liquidity (LI) index are calculated automatically. These values are not saved in 

the database. 

• The shear strength of the remolded soil can be entered, in kPa. 

• Non-plastic material can be checked. 

• The USCS classification is calculated by Geotec. 

The sample characterization shows data from the SAMPLE table, for information purposes, including: 

• The description entered for the current sample. 

• The USCS classification of the current sample. 

In Management... 

• When the calculation is done (via the button  or using Action > Calculate), the calculation date is 

updated. 

• When a modification to the limits test is saved, the modification date is updated. 

• Transfer is a 1-character code to classify records for their management. 

The tabs at the bottom of the Limits form show data from the LIMITS_POINT secondary table of the 

Geotec database. The All readings tab shows all readings done for the current sample. The reading type 



DATA ENTRY FORMS | Version 8.12.1 | Page 115 

  

is shown as well as all fields of the table. The other tabs show only part of the fields, depending on the 

type of readings to be entered. 

• The site number, the boring number, the sample number, the reading type and the point index 

together constitute the key of the records. 

• The reading type is entered with the tab selected. 

o N for natural water content 

o P for plastic limit 

o C for liquid limit with the Casagrande apparatus 

o S for liquid limit with the Swedish cone 

• The point index (I_POINT) is used to enter several points for the same test. It is an integer. 

• Enter the tare number, with 20 characters. The list of apparatus numbers defined in the 

EQUIPMENT table and whose category begins with TARE is suggested (paragraph 9.14). 

• Enter the tare mass, in grams. If a mass is defined in the EQUIPMENT table for the selected tare, it 

will be displayed. 

• Enter the mass of the tare and wet soil, in grams. 

• Enter the mass of the tare and dry soil, in grams. 

• The water content W is entered or calculated by Geotec. 

• The number of blows N of the test is an integer. It is used only for the liquid limit test with the 

Casagrande apparatus. 

• The initial penetration reading P0 is in mm. It is only used for the Swedish cone liquid limit test. 

• The 1st, 2nd, 3rd and 4th penetration readings P1, P2, P3 and P4 are in mm. They are used only for 

the Swedish cone liquid limit test. 

• The average reading P is in mm. It can be entered or calculated by Geotec. It is only used for the 

Swedish cone liquid limit test. 

• The drying temperature can be specified for liquid limit tests. 

• The drying mode is a 2-character field indicating the control mode for water content. Typical codes 

would be WA (water addition), DA (air drying), DO (oven drying), DF (filtration drying), DP (drying 

with an absorbent plate). 

• Transfer is a 1-character code to classify records for their management. By putting "X" in the 

Transfer field of one of the points, the point will not be included in the calculations. 
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Figure 43 – Limits entry form 

9.2.1. Calculations 

In the bottom table, Geotec calculates for each record 

• of all tests, the water content w:    𝑤 =
𝑚𝑎𝑠𝑠𝑡𝑎𝑟𝑒 𝑤𝑒𝑡 𝑠𝑜𝑖𝑙−𝑚𝑎𝑠𝑠𝑡𝑎𝑟𝑒 𝑑𝑟𝑦 𝑠𝑜𝑖𝑙

𝑚𝑎𝑠𝑠𝑡𝑎𝑟𝑒 𝑑𝑟𝑦 𝑠𝑜𝑖𝑙−𝑚𝑎𝑠𝑠𝑡𝑎𝑟𝑒
× 100% 

• of the Swedish cone test, the average penetration:  𝑃 = 𝑎𝑣𝑒𝑟𝑎𝑔𝑒(𝑃𝑥 − 𝑃0) 

The natural water content WN (%) is the average of the w of the “ ” type records (water content) if 

there are several for the same sample. 

The plastic limit WP (%) is the average of the w of the “ ” type records (plastic limit) if there are several 

for the same sample. 

The liquid limit WL (%) with the Casagrande apparatus depends if it’s a one-point or multipoint test. 

• 1-point method:     𝑊𝐿 = 𝑤 × (
𝑁

25
)0.121 

• Multipoint method: Geotec plots a straight line of water content as a function of number of blows 

(logarithmic scale) and extrapolates to N = 25. 
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The liquid limit WL (%) with the Swedish cone depends if it’s a one-point or multipoint test. 

• 1-point method:     𝑊𝐿 =
20(𝑤−15)

𝑃+10
+ 15 

• Multipoint method: Geotec plots a straight line of water content as a function of cone penetration 

(linear scale) and extrapolates to P = 10. 

The plasticity index (%) is calculated as:   𝑃𝐼 = 𝑊𝑃 − 𝑊𝐿 

The liquidity index is calculated as:   𝐿𝐼 =
𝑊𝑁−𝑊𝑃

𝑊𝑃−𝑊𝐿
 

The USCS is calculated using the Atterberg chart. Line A’s equation is 𝑃𝐼 = 0.73(𝑊𝐿 − 20). 

• If WL < 50 

o If PI > 7 and I  ≥ line    →      =    

o Else if PI ≥ 4 and PI ≥ line    →      =   -ML 

o Else    →      =    

• If W  ≥ 50 

o If PI ≥ line     →      =    

o Else    →      =    

9.3. Proctor form 

The form shows data from the PROCTOR table and its secondary table PROCTOR_POINT of the Geotec 

database. It is used to enter lab measurements and calculate the results of Proctor tests for the 

determination of the water content – dry density relationship.  

• The site number, the boring number and the sample number together constitute the key of the 

records. 

• The site, boring and sample numbers identify the sample on which the compaction test was done.  

The drop-down list of sites shows all sites that have a least one sample defined in the SAMPLE 

table. The drop-down list of borings shows all borings that belong to the site selected and that have 

at least one sample defined in the SAMPLE table.  The drop-down list of samples shows all samples 

defined in the SAMPLE table for the selected boring.  

 n  anagement data… 

• Enter up to 40 characters in the fields Realized by and Verified by. 

• The test date and verification date are noted in the format yyyy-mm-dd hh:mi:ss. 

• The name or number of the laboratory where the test was done is noted, with 20 characters. 

• The name of the data file can be entered, with a maximum of 255 characters. By clicking on the 

button right of the field, the Windows file selection screen opens.  

To save the file with its full path, enable the option in the preferences. See the X3D documentation. 
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• Remark is alphanumeric with 255 characters for additional details. 

The laboratory apparatus used for the test are indicated. This ensures better monitoring in the event 

that an equipment is faulty and is used to retrieve some of the specifications.  

• The number of the balances used for weighing for density (D) and for water content (WC) are 

indicated, with 20 characters. The list of apparatus numbers defined in the EQUIPMENT table and 

whose category begins with BAL is suggested (paragraph 9.14). 

• The number of the rammer used is indicated, with 20 characters. The list of apparatus numbers 

defined in the EQUIPMENT table and whose category begins with RAM is suggested (paragraph 

9.14). 

• The number of the mould used is indicated, with 20 characters. The list of apparatus numbers 

defined in the EQUIPMENT table and whose category begins with MOUL is suggested (paragraph 

9.14). 

The test parameters as well as the mould and sample characteristics are then defined.  

• The method used is selected between A, B, C and D. For method A or B, the meshing will be set to 5 

mm. For method C or D, the meshing will be 20 mm.  

• The diameter of the cut-off sieve (meshing) is automatically displayed based on the method 

selected, but can be modified. The suggested values are 5 mm, 10 mm, 20 mm and 80 mm.  

• The passing % is read from the grain size analysis done on the sample at the meshing indicated. The 

user can modify it or enter a passing % if a grain size analysis wasn’t done.  

• The test type is selected between Standard or Modified. 

• The rammer type is selected between Manual or Mechanical. 

• The preparation is selected between Dry or Moist. 

• The purpose of the normalizing correction is to bring all points of the Proctor test on a common 

basis, as if they were all done with the same percentage of stones retained on the 5 mm sieve. The 

normalizing correction at 5 mm sieve can be based on the existing grain size of the sample, or on 

the average of the stone contents. The calculations are detailed in the next section.  

• The mould mass (g) and volume (cm3) are entered.  If a mass and a volume are defined in the 

EQUIPMENT table for the selected mould, they will be displayed. 

• The apparent specific gravity of sand is 2.7 by default and can be changed by the user.  

• The apparent specific gravity of stone is 2.7 by default and can be changed by the user.  

• The bulk specific gravity of stone is 2.7 by default and can be changed by the user.  

• The retained % on 5 mm is calculated based on the selected normalizing correction at 5 mm sieve.  
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• The standard from which the correction formula used to correct the optimum water content and 

the maximum dry density as a function of the stone content of the total sample can be indicated. It 

is ASTM-D4718. 

In Management... 

• When the calculation is done (via the button  or using Action > Calculate), the calculation date is 

updated. 

• When a modification to the Proctor test is saved, the modification date is updated. 

• Transfer is a 1-character code to classify records for their management. 

The results can be entered directly by the user or calculated by Geotec based on the measurements in 

the bottom table. The Values measured in the test are calculated based on the points of the 

compaction curve. The Values corrected for stone are corrected for stone content, if the passing % is 

less than 100%. See the calculation details in the next section.  

• The optimum water content is in %.  

• The maximum dry density is in kg/m3.  The unit weight will automatically be calculated.  

• The maximum dry unit weight is not a field in the database. You can enter a value (in kN/m3) and 
the maximum dry density will be automatically calculated.  

• The degree of saturation is in %.  

The table at the bottom of the Proctor form shows data from the PROCTOR_POINT secondary table of 

the Geotec database. 

• The site number, the boring number, the sample number and the point index together constitute 

the key of the records. 

• The index (I_POINT) defines the order of each point on the compaction curve. It is an integer. 

• Enter the tare number, with 20 characters. The list of apparatus numbers defined in the 

EQUIPMENT table and whose category begins with TARE is suggested (paragraph 9.14). 

• Enter the tare mass, in grams. If a mass is defined in the EQUIPMENT table for the selected tare, it 

will be displayed. 

• Enter the mass of the tare and wet soil, in grams. 

• Enter the mass of the tare and dry soil, in grams. 

• Enter the mass of the mould and wet soil, in grams.  

• If measured, enter the mass retained on the 5 mm sieve for the normalization, in grams.  

• The water content Wtest is entered or calculated by Geotec. 

• The density Dtest is entered or calculated by Geotec. 

• The retained % on the 5 mm sieve is entered or calculated by Geotec.  
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• The water content normalized at 5 mm W is entered or calculated by Geotec based on % retained. 

• The density normalized at 5 mm D is entered or calculated by Geotec based on % retained. 

• Smoothing (Z) is used for the smoothing of the compaction curve at the current point. It contains 

the offset around the point for the curve.  With a value of 0, the curve goes through the point; the 

greater the value, the more the curve is smoothed at the point.  An offset can be set for the whole 

curve; see the documentation of Lab. 

• Transfer is a 1-character code to classify records for their management. By putting "X" in the 

Transfer field, the point will not be displayed in the curve and not included in the calculations. 

 

Figure 44 – Proctor entry form 

9.3.1. Calculations 

For each point of the curve, Geotec calculates: 
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• The water content wtest:  𝑤𝑡𝑒𝑠𝑡 =
𝑚𝑎𝑠𝑠𝑡𝑎𝑟𝑒 𝑤𝑒𝑡 𝑠𝑜𝑖𝑙−𝑚𝑎𝑠𝑠𝑡𝑎𝑟e dry soil

𝑚𝑎𝑠𝑠𝑡𝑎𝑟𝑒 𝑑𝑟𝑦 𝑠𝑜𝑖𝑙−𝑚𝑎𝑠𝑠𝑡𝑎𝑟𝑒
× 100% 

• The density dtest:    𝑑𝑡𝑒𝑠𝑡 =
𝑚𝑎𝑠𝑠𝑚𝑜𝑢𝑙𝑑 𝑠𝑜𝑖𝑙−𝑚𝑎𝑠𝑠𝑚𝑜𝑢𝑙𝑑

𝑣𝑜𝑙𝑢𝑚𝑒𝑚𝑜𝑢𝑙𝑑
1000

×(1+
𝑤𝑡𝑒𝑠𝑡

100
))

 

• If a mass retained on 5 mm is entered, the retained % on the 5 mm sieve is:  

     𝑟𝑒𝑡𝑎𝑖𝑛𝑒𝑑5𝑚𝑚 𝑖𝑛𝑑𝑖𝑣 =
𝑚𝑎𝑠𝑠𝑟𝑒𝑡𝑎𝑖𝑛𝑒𝑑

𝑚𝑎𝑠𝑠𝑡𝑎𝑟𝑒 𝑑𝑟𝑦 𝑠𝑜𝑖𝑙−𝑚𝑎𝑠𝑠𝑡𝑎𝑟𝑒
× 100  

For the complete test, Geotec calculates: 

• The passing % which is read from the grain size analysis done on the sample at the meshing 

indicated. 

• The retained % on 5 mm depends on the selected normalizing correction. 

With grain size:   𝑟𝑒𝑡𝑎𝑖𝑛𝑒𝑑5𝑚𝑚 = 100 × (1 −
𝑝𝑎𝑠𝑠𝑖𝑛𝑔5𝑚𝑚

𝑝𝑎𝑠𝑠𝑖𝑛𝑔𝑚𝑒𝑠ℎ𝑖𝑛𝑔
) 

With average stone contents:   𝑟𝑒𝑡𝑎𝑖𝑛𝑒𝑑5𝑚𝑚 = 𝑎𝑣𝑒𝑟𝑎𝑔𝑒(𝑟𝑒𝑡𝑎𝑖𝑛𝑒𝑑5𝑚𝑚 𝑖𝑛𝑑𝑖𝑣)  

For each point of the curve, Geotec calculates the normalized water content and density. 

• The normalizing correction:   𝑐𝑜𝑟𝑟 =
𝑟𝑒𝑡𝑎𝑖𝑛𝑒𝑑5𝑚𝑚

100
−

𝑟𝑒𝑡𝑎𝑖𝑛𝑒𝑑5𝑚𝑚 𝑖𝑛𝑑𝑖𝑣

100
 

• The water content W normalized at 5 mm: 

   if corr ≥ 0  𝑤 = 𝑤𝑡𝑒𝑠𝑡 × (1 − 𝑐𝑜𝑟𝑟) + (0.8 × 𝑐𝑜𝑟𝑟)  

   if corr < 0 𝑤 =
𝑤𝑡𝑒𝑠𝑡+(0.8×𝑐𝑜𝑟𝑟)

(1+𝑐𝑜𝑟𝑟)
  

If there is no retained % at 5 mm, the normalized water content equals the test water content.  

• The dry density D normalized at 5 mm: 

   if corr > 0 𝑑 =
1

(
𝑐𝑜𝑟𝑟

𝑔𝑠𝑏𝑢𝑙𝑘×1000
)+

(1−𝑐𝑜𝑟𝑟)

𝑑𝑡𝑒𝑠𝑡

 

   if corr ≤ 0 𝑑 = 𝑑𝑡𝑒𝑠𝑡 ×
1−|𝑐𝑜𝑟𝑟|

1−(
|𝑐𝑜𝑟𝑟|×𝑑𝑡𝑒𝑠𝑡
𝑔𝑠𝑏𝑢𝑙𝑘×1000

)
 

where gsbulk is the bulk specific gravity of stone.  

If there is no retained % at 5 mm, the normalized dry density equals the test dry density.  

For the test, Geotec calculates the optimum point.  

• The normalized points (w, d) are placed on a graph of dry density as a function of water content 

and the optimum point (wopt test, dmax test) of the test is found by kriging.  

• The density of water gw is defined at 1000 kg/m3.  

• The specific gravity of the soil gs is calculated as:  

     𝑔𝑠 = 𝑟𝑒𝑡𝑎𝑖𝑛𝑒𝑑5𝑚𝑚 ×
𝑔𝑠𝑎𝑝𝑝

100
+ 𝑔𝑠𝑠𝑎𝑛𝑑 ×

100−𝑟𝑒𝑡𝑎𝑖𝑛𝑒𝑑5𝑚𝑚

100
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where gsapp is the apparent specific gravity of stone and gssand is the apparent specific gravity of 

sand.  

• The degree of saturation degsat test is: 𝑑𝑒𝑔𝑠𝑎𝑡 𝑡𝑒𝑠𝑡 =
𝑤𝑜𝑝𝑡 𝑡𝑒𝑠𝑡

(
𝑔𝑤

𝑑𝑚𝑎𝑥 𝑡𝑒𝑠𝑡 
 − 

1

𝑔𝑠
)
 

where wopt test is the optimum water content of the test and dmax test is the maximum dry density of 

the test.  

For the test, Geotec calculates the optimum point (wopt, dmax) corrected for stone content, if applicable.  

• If the % passing the meshing is less than 100% 

     𝑑𝑚𝑎𝑥 =
1

(
1−

𝑝𝑎𝑠𝑠𝑖𝑛𝑔
100

𝑔𝑠𝑏𝑢𝑙𝑘×𝑔𝑤
)+

(
𝑝𝑎𝑠𝑠𝑖𝑛𝑔

100 )

𝑑𝑚𝑎𝑥 𝑡𝑒𝑠𝑡

 

     𝑤𝑜𝑝𝑡 = 𝑤𝑜𝑝𝑡 𝑡𝑒𝑠𝑡 ×
𝑝𝑎𝑠𝑠𝑖𝑛𝑔

100
+ 0.8 ×

100−𝑝𝑎𝑠𝑠𝑖𝑛𝑔

100
 

     𝑑𝑒𝑔𝑠𝑎𝑡 =
𝑤𝑜𝑝𝑡

(
𝑔𝑤

𝑑𝑚𝑎𝑥  
 − 

1

𝑔𝑠
)
 

Otherwise, values are equal to the test optimum.  

9.4. Consolidation form 

The form shows data from the CONSOLIDATION table and its secondary table CONSOLIDATION_POINT 

of the Geotec database. It is used to define the parameters and results of the odometer consolidation 

and permeability test. 

• The site number, the boring number and the sample number together constitute the key of the 

records. 

• The site, boring and sample numbers identify the sample on which the consolidation / permeability 

test was done.  

The drop-down list of sites shows all sites that have a least one sample defined in the SAMPLE 

table. The drop-down list of borings shows all borings that belong to the site selected and that have 

at least one sample defined in the SAMPLE table.  The drop-down list of samples shows all samples 

defined in the SAMPLE table for the selected boring.  

• Enter up to 40 characters in the fields Done by and Verified by. 

• The test date and verification date are noted in the format yyyy-mm-dd hh:mi:ss. 

• The name or number of the laboratory where the test was done is noted, with 20 characters. 

• The name of the data file can be entered, with a maximum of 255 characters. By clicking on the 

button right of the field, the Windows file selection screen opens.  

To save the file with its full path, enable the option in the preferences. See the X3D documentation. 

• Remark is alphanumeric with 255 characters for additional details. 
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Enter the sample characteristics. 

• H0 is the initial height of the sample; the suggested unit is millimeters. 

• Gs is the relative density. 

• K0 is the initial permeability; the suggested unit is m/s. 

• W0 is the initial natural water content, in %. 

• The degree of saturation is then entered. 

The void ratios are entered or calculated by Lab. 

• E0 is the void ratio at in-situ effective stress P0. 

• Ei is the void ratio at effective stress of 9.81 kPa or entered for at the start of the test (MTQ). 

• Ec is the void ratio at preconsolidation stress Pc. 

• Ef is the void ratio at effective stress at the end of testing Pf. 

Effective stresses are in kPa. 

• P0 is the in-situ effective soil stress. It is entered by the user.  

• Pf is the effective stress at the end of testing. It is entered or calculated by Lab. 

The results include the calculation method, the preconsolidation stresses and the indices. 

• The calculation method is chosen between Sobek (simplified method) and MTQ (LC22-301 

standard). By default, the Sobek method is chosen. Depending on the method, the values of PC and 

PC max differ as well as the Ei. 

• PC min represents the lower limit of the preconsolidation stress (kPa). It is entered or calculated by 

Lab. 

• PC represents the probable preconsolidation stress (kPa). It is entered or calculated by Lab. 

• PC max represents the upper limit of the preconsolidation stress (kPa). It is entered or calculated by 

Lab. 

• CC is the compression index. It is entered or calculated by Lab. 

• CCR is the recompression index. It is entered or calculated by Lab 

• CV is the consolidation coefficient for the probable preconsolidation stress (PC); the suggested unit 

is m2/s. It is entered. 

• CK is the permeability variation index. It is entered or calculated by Lab. 

• When the calculation is done (via the button  or using Action > Calculate), the calculation date is 

updated. 

• When a modification to the consolidation test is saved, the modification date is updated. 
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The table at the bottom of the Consolidation form shows data from the CONSOLIDATION_POINT 

secondary table of the Geotec database. 

• The site number, the boring number, the sample number and the point index together constitute 

the key of the records. 

• The index (I_POINT) defines the order of each point on the consolidation curve. It is an integer. 

• The pressure (P) is required. The suggested unit is kPa. 

• The void ratio (E) is required. 

• The permeability (K) can be entered if an odometer permeability test was done, in m/s. 

• CC is the compression index per loading. CC is equal to the slope between a point (log P, e) and the 

previous. As soon as values of P and E are entered for a 2nd point, CC is calculated. 

• CV contains the consolidation coefficient measured during loading to go from the previous pressure 

to pressure P. The suggested unit is the m2/s. 

• Smoothing (Z) is used for the smoothing of the consolidation curve at the current point. It contains 

the offset around the point for the curve.  With a value of 0, the curve goes through the point; the 

greater the value, the more the curve is smoothed at the point.  An offset can be set for the whole 

curve; see the documentation of Lab. 

• Transfer is a 1-character code to classify records for their management. By putting "X" in the 

Transfer field, the point will not be displayed in the curve and not included in the calculations. 
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Figure 45 – Consolidation entry form 

9.4.1. Calculations 

The calculations are available only in the Lab module, using a style file that shows the consolidation 

curve. Figure 46 shows the points used in the calculations. 

The Casagrande construction is used for the calculation and is shown in red. There are 200 points 

calculated at regular intervals (on logarithmic scale) for each curve. Lab finds the inflection point IP 

(where the second derivative is null) and the point of maximum curvature. We do not use the rebound 

curve if it is present, but it appears on the graph of consolidation tests. 

• E0 is the interpolated value on the Y axis at P0 stress, if entered. 

• Ei is the interpolated value on the Y axis at a stress of 9.81 kPa. With the MTQ method, Ei is not 

calculated if a value is already entered. 

• Ec is the interpolated value on the Y axis at Pc stress. 
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• Ef is the value interpolated on the Y axis at Pf stress (end of test). 

• Pf is calculated as the maximum effective stress, before the rebound curve. 

• Pc min is the intersection between the slope at IP and the horizontal from e0. 

• With the Sobek method: 

o Pc is the intersection of the slope at the IP and the extension of the portion before the Pc. 

o Pc max is found with the construction of Casagrande. We take the bisector between the 
horizontal at the point of maximum curvature and the tangent at this same point. Pc max is the 
intersection between this bisector and the slope at the IP. 

• With the MTQ method: 

o Pc is found with the construction of Casagrande. We take the bisector between the horizontal 
at the point of maximum curvature and the tangent at this same point. Pc is the intersection 
between this bisector and the slope at the IP (therefore equal to Pc max from the Sobek 
method). 

o Pc max is the stress at the divergence between the virgin consolidation curve and its upward 
extension (inflection point). 

• Cci is the slope at the IP. 

• Ccr is the slope between a point at 25% and another at 50% of the load in logarithmic mode. 

• Ck is the slope of the least squares line passing through the points (k, e) (permeability, void radio). 

By putting "X" in the Transfer field of one of the points, the point will not be displayed in the curve 

and not included in the calculation of Ck. 
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Figure 46 – Details of consolidation calculations – Sobek method (top) and MTQ (bottom) 

9.5. Swedish cone form 

The form shows data from the FALL_CONE table of the Geotec database. It is used to enter the shear 

strengths of an intact or remoulded soil determined by the fall cone test.  

• The site number, the boring number and the sample number together constitute the key of the 

records. 

• The site, boring and sample numbers identify the sample on which the fall cone test was done.  

The drop-down list of sites shows all sites that have a least one sample defined in the SAMPLE 

table. The drop-down list of borings shows all borings that belong to the site selected and that have 

at least one sample defined in the SAMPLE table.  The drop-down list of samples shows all samples 

defined in the SAMPLE table for the selected boring.  

 n the  wedish cone tab… 

• The shear strength of unremoulded soil (SU) is numeric, in kPa. 

• The shear strength of the remolded soil (SUR) is numeric, in kPa. 

• Sensitivity to remoulding (ST) is the ratio of intact strength to remoulded strength. Sensitivity is 

calculated automatically when both strengths are entered. The user can modify it. 

• The natural water content of the sample can be entered, in %. 

• Remark is alphanumeric with 255 characters for additional details. 

 n the  anagement tab… 

• Enter up to 40 characters in the fields Realized by and Verified by. 

• The test date and verification date are noted in the format yyyy-mm-dd hh:mi:ss. 
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• The name of the data file can be entered, with a maximum of 255 characters. By clicking on the 

button right of the field, the Windows file selection screen opens.  

To save the file with its full path, enable the option in the preferences. See the X3D documentation. 

• Category is used to enter a code to categorize the test, with 20 characters. 

• Transfer is a 1-character code to classify records for their management. 

9.5.1. Calculations 

Geotec calculates the sensitivity as Su / Sur if both values are entered. 

 

Figure 47 – Swedish cone entry form 

9.6. Specific gravity form 

The form shows data from the GS_SOIL table of the Geotec database. It is used to enter results of 

specific gravity tests.  

• The site number, the boring number and the sample number together constitute the key of the 

records. 

• The site, boring and sample numbers identify the sample on which the specific gravity test was 

done.  

The drop-down list of sites shows all sites that have a least one sample defined in the SAMPLE 

table. The drop-down list of borings shows all borings that belong to the site selected and that have 

at least one sample defined in the SAMPLE table.  The drop-down list of samples shows all samples 

defined in the SAMPLE table for the selected boring.  

In the Results tab… 

• The specific gravity of the sand fraction is used to enter the test result. The diameter shown is 5 

mm. 

• The specific gravity of the fraction smaller than sand can then be entered.  

• The cut-off diameter of this fraction is then entered (in mm).  

• The radio buttons Sand fraction and Fraction < 5 mm will be used in a future development. 
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 n the  anagement tab… 

• Enter up to 40 characters in the fields Realized by and Verified by. 

• The test date and verification date are noted in the format yyyy-mm-dd hh:mi:ss. 

• The name of the data file can be entered, with a maximum of 255 characters. By clicking on the 

button right of the field, the Windows file selection screen opens.  

To save the file with its full path, enable the option in the preferences. See the X3D documentation. 

• Category is used to enter a code to categorize the test, with 20 characters. 

• Transfer is a 1-character code to classify records for their management. 

• Remark is alphanumeric with 255 characters for additional details. 

 

Figure 48 – Specific gravity entry form 

9.7. Density form 

The form shows data from the DENSITY table of the Geotec database. It is used to enter measurements 

of unit weight or density for a sample.  

• The site number, the boring number, the sample number and the test type together constitute the 

key of the records. 

• The site, boring and sample numbers identify the sample on which the density test was done.  

The drop-down list of sites shows all sites that have a least one sample defined in the SAMPLE 

table. The drop-down list of borings shows all borings that belong to the site selected and that have 

at least one sample defined in the SAMPLE table.  The drop-down list of samples shows all samples 

defined in the SAMPLE table for the selected boring.  

• The test type is the one used to determine the density.  

• The wet density measured by the test is entered; in kg/m3.  

• Enter up to 40 characters in the fields Realized by and Verified by. 

• The test date and verification date are noted in the format yyyy-mm-dd hh:mi:ss. 
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• The name of the data file can be entered, with a maximum of 255 characters. By clicking on the 

button right of the field, the Windows file selection screen opens.  

To save the file with its full path, enable the option in the preferences. See the X3D documentation. 

• Category is used to enter a code to categorize the test, with 20 characters. 

• Transfer is a 1-character code to classify records for their management. 

• Remark is alphanumeric with 255 characters for additional details. 

 

Figure 49 – Density entry form 

9.8. Unconfined compression form 

The form shows data from the UCS table of the Geotec database. It is used to enter the results of 
unconfined compressive strength tests for soil samples.  

• The site number, the boring number and the sample number together constitute the key of the 

records. 

• The site, boring and sample numbers identify the sample on which the unconfined compressive 

strength test was done.  

The drop-down list of sites shows all sites that have a least one sample defined in the SAMPLE 

table. The drop-down list of borings shows all borings that belong to the site selected and that have 

at least one sample defined in the SAMPLE table.  The drop-down list of samples shows all samples 

defined in the SAMPLE table for the selected boring.  

• The height of the test specimen is entered in mm.  

• The diameter of the test specimen is entered in mm.  

• The mass of the test specimen is entered in g.  

• The water content of the test specimen is entered in %.  

• The dry density of the test specimen is entered in g/cm3.  

•  he material’s Young’s modulus is entered in MPa.  
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•  he material’s Poisson’s ratio is entered.  

• The maximum load at failure is entered, in N.  

• The deformation is the decrease in height of the specimen due to compression, in mm.  

• The compressive strength is entered, in MPa. 

• The failure type is entered with a 2-character code.   

• The angle of the fracture plane is in degrees.  

• Enter up to 40 characters in the field Tested by. 

• The test date is noted in the format yyyy-mm-dd hh:mi:ss. 

• The name of the data file can be entered, with a maximum of 255 characters. By clicking on the 

button right of the field, the Windows file selection screen opens.  

To save the file with its full path, enable the option in the preferences. See the X3D documentation. 

• Category is used to enter a code to categorize the test, with 20 characters. 

• Transfer is a 1-character code to classify records for their management. 

• Remark is alphanumeric with 255 characters for additional details. 

 

Figure 50 – Unconfined compression entry form 

9.9. Shear strength form 

The form shows data from the SHEAR table of the Geotec database. It is used to enter the characteristics 
and results of shear strength tests done on a sample.  

the Interpretation button opens the interpretation of a group of shear strength tests. 

• The site number, the boring number and the sample number together constitute the key of the 

records. 
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• The site, boring and sample numbers identify the sample on which the shear strength test was 

done.  

The drop-down list of sites shows all sites that have a least one sample defined in the SAMPLE 

table. The drop-down list of borings shows all borings that belong to the site selected and that have 

at least one sample defined in the SAMPLE table.  The drop-down list of samples shows all samples 

defined in the SAMPLE table for the selected boring.  

Under the Identification tab, we define the characteristics of the test and of the sample. 

• The test number is can be entered; with 20 characters.  

• The test type is entered.  The proposed types are the consolidated drained test (CD), the 

consolidated undrained test (CU), the direct shear test (DIR) and the unconsolidated undrained test 

(UU).  The description of the selected type is automatically displayed.  

• Sigma’3 is the lateral pressure, in k a.  his field is not used if the test type is “UU”. 

• The loading rate is entered, in mm/min.  

• The backpressure is in kPa.  

• The rupture shape can be selected.  The description of the rupture shape is automatically displayed 

after selecting the code.  

• The sample unit weight is entered, in kN/m3. 

• The sample density is in kg/m3. 

• W0 is the initial water content of the sample, in %.  

• Wf (top), Wf (middle) and Wf (bottom) are the final water content at the top, middle and bottom 

of the sample, in %.  

 nder the  esults tab… 

• For CD, CU and UU type tests, the following values at the peak (maximum) and at the largest 

deformation are entered: 

o q’ is the deviatoric effective stress (kPa) 

o p’ is the mean effective stress (kPa) 

o E is the strain (%) 

o u* is the porewater pressure (kPa). Values of u* are not entered for CD and UU type tests. 

• For DIR type tests, the following values are entered: 

o Tau is the shear stress (kPa) 

o Sigma n’ is the normal effective stress (kPa) 

Under the Management tab... 

• Enter up to 40 characters in the fields Done by and Verified by. 
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• The test date and verification date are noted in the format yyyy-mm-dd hh:mi:ss. 

• The name of the data file can be entered, with a maximum of 255 characters. By clicking on the 

button right of the field, the Windows file selection screen opens.  

To save the file with its full path, enable the option in the preferences. See the X3D documentation. 

• The group number is used to enter an identification of 20 characters grouping the shear strength 

tests of same type and associated to the same site. The drop-down list shows the groups defined in 

the Interpretation form.  

• Category is used to enter a code to categorize the test, with 20 characters. 

• Transfer is a 1-character code to classify records for their management. 

 

 

Figure 51 – Shear strength entry form 

9.9.1. Interpretation 

The form shows data from the TRIAXIAL table of the Geotec database. It is used for the interpretation of 
a group of shear strength tests. 

the Shear strength button opens the shear strength entry form. 

• The site number and group number together constitute the key of the records. 

• The site number identifies the sites. The drop-down list shows all sites defined in the SITE table. 
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• The group number identifies the group of interpretation. Enter up to 20 characters with letters, 

numbers and symbols - _ ( ) . Accents and other special characters cannot be used. 

• The test type can be entered.  The types are the same as in the Shear form. The description of the 

selected type is automatically displayed.  

• c and c’ are the cohesion and effective cohesion, respectively.  

• Phi and Phi’ are the total and effective friction angle, respectively.  

• Remark contains a string of 255 characters to describe the group of tests.  

Under the Management tab... 

• Enter up to 40 characters in the fields Done by and Verified by. 

• The test date and verification date are noted in the format yyyy-mm-dd hh:mi:ss. 

• The name of the data file can be entered, with a maximum of 255 characters. By clicking on the 

button right of the field, the Windows file selection screen opens.  

To save the file with its full path, enable the option in the preferences. See the X3D documentation. 

• Category is used to enter a code to categorize the test, with 20 characters. 

• Transfer is a 1-character code to classify records for their management. 

9.10. Concentrations form 

The form shows data from the CONCENTRATION table of the Geotec database. It is used to enter 

concentrations of contaminants measured in-situ or via laboratory analyses. See the description of the 

Contaminants form in paragraph 10.10 which contains the criteria used for the calculations.  

• The site number, the boring number, the top depth and the contaminant together constitute the 

key of the records. 

• The site and boring numbers identify the boring in which concentrations were measured. The drop-

down lists show all sites that have a least one boring defined in the BORING table, then all borings 

of the BORING table for the selected site. 

• If the contaminant concentration was measured on a sample or sub-sample, enter its number. If a 

number is entered, its top and bottom depth are automatically retrieved and displayed in the form. 

• The group of contaminants is defined. The list is from the CONTAMINANT table, but the user can 

enter another one with 50 characters maximum. The group is used to narrow the drop-down list of 

contaminants.  

• The contaminant is the one for which concentrations were measured. The list from the 

CONTAMINANT table for the group selected is suggested, but the user can enter another one, with 

40 characters maximum.  
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• The top and bottom depths of the measurement, if applicable, are entered; the suggested unit is 

the meter. If the measurement applies to a sample / sub-sample, its depths are automatically 

indicated.  

• A remark of 255 characters is used to add details.  

• The contaminant concentration in soil is entered. The measurement unit should be the one defined 

in the CONTAMINANT table for the same contaminant.  

• If criteria A to C are defined in the CONTAMINANT table, the contamination level in soil is 

calculated. It is a 10-character field with these values, usually: A-, A, A-B, B, B-C, C and C+. 

• The contaminant concentration in water is entered. The measurement unit should be the one 

defined in the CONTAMINANT table for the same contaminant.  

• If criteria A to C are defined in the CONTAMINANT table, the contamination level in water is 

calculated. It is a 10-character field with these values, usually: A-, A, A-B, B, B-C, C and C+. 

• Alert is used to enter an alert threshold of 5 characters.  

• When a modification is saved, the modification date is updated. 

• When the calculation is done (via the button  or using Action > Calculate), the calculation date is 

updated. 

• Category is used to enter a code to categorize the test, with 20 characters. 

• Transfer is a 1-character code to classify records for their management. 

9.10.1. Calculations 

Geotec calculates the contamination level based on the concentration indicated in the entry form and 

criteria A to C defined in the CONTAMINANT table (paragraph 10.10) for the same geologic province as 

the one of the current site. If no province is defined for the site, it is compared to criteria from the B 

province. If the 3 contamination criteria are not defined for the contaminant, the calculation of the level 

is not done.  

The calculation function also retrieves the depths of the samples or sub-samples entered in the SAMPLE 

table and updates them in the CONCENTRATION table. If the values are linked to a sample, this function 

is not launched.  
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Figure 52 – Concentrations entry form 

9.11. Sieving methods form 

The form shows data from the SIEVING_METHOD table and its secondary table SIEVES_SET of the 

Geotec database. It is used to define the sieving methods used in the laboratory and the associated sets 

of sieves. Sieving methods BNQ_2501-025 and LC_21-040 are automatically added to Geotec databases. 

• The sieving method number is the key of the record. It typically corresponds to the number of the 

standard. Enter up to 20 characters with letters, numbers and symbols - _ ( ) . Accents and other 

special characters cannot be used. 

• The classification norm is entered with 20 characters. It is for future development. 

• The method description has 255 characters. 

• Minimum limit, maximum limit, grain size description and concrete sand are for future 

development. 

• For each method, up to 3 quarterings or groups of sieves can be defined as needed: the coarse 

fraction (Cobbles), medium fraction (Gravel) and fine fraction (Sand). 

o Indicate the number of the scale used for weighing. 

o Indicate whether the weighing is individual (each sieve separately) or cumulative. 

o Indicate the unit of mass (grams g, kilograms kg or pounds lb). 

The table at the bottom of the Sieving methods form shows data from the SIEVES_SET secondary table 

of the Geotec database. 

• The sieving method number and the diameter together form the key of the records. 

• The sieve diameter is numerical. It can be entered or selected via the drop-down list which suggests 

Quebec standard sieves between 300 mm and 0.08 mm. 
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• The fraction is required. This is a 1-character field that indicates whether the sieve is associated 

with the coarse fraction (Q for Cobbles), the medium fraction (G for Gravel) or the fine fraction (S 

for Sand). 

• The sieve number can be entered. The drop-down list suggests the sieves defined in the Laboratory 

Equipment form (paragraph 9.14). 

 

Figure 53 – Sieving methods entry form 

9.12. Grain size requirements form 

The form is used to define grain size specifications that can be associated with the grain size tests and 

presented in the Lab module. The MG-20, MG-20B, MG-56 and MG-80 grain size specifications are 

automatically added to Geotec databases. 

• The Envelope (or specification) is required. Enter up to 20 characters with letters, numbers and 

symbols - _ ( ) . Accents and other special characters cannot be used. 

• The description of the specification can be entered. 

In the bottom table, define the requirements for the grain size specifications. 

• Indicate the diameter where a requirement applies. A list of common diameters is available. 

• Enter the minimum passing and the maximum passing for each diameter. 

Data entered in the Grain size requirements form are automatically saved in multiple tables. 
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• The SPEC site 

• The boring whose number is the name of the specification and whose remark is the description of 

the specification 

• The samples MIN and MAX in the boring 

• A grain size curve associated to the MIN sample with the diameters and their MIN_PASSING 

• A grain size curve associated to the MAX sample with the diameters and their MAX_PASSING 

 

Figure 54 – Grain size requirements entry form 

9.13. Hydrometer calibrations 

The form shows data from the HYDROMETER_CALIBRATION table of the Geotec database. It is used to 
specify the calibration factors for the hydrometers used by the laboratory. Calibration of the ASTM 151H 
and 152H hydrometers are automatically added to the Geotec databases for reference. 

• The hydrometer number is the key of the record. Enter up to 20 characters with letters, numbers 

and symbols - _ ( ) . Accents and other special characters cannot be used. 

• The hydrometer model is either 151H or 152H. The calibration and the calculations differ 

depending on the model chosen. 

• The calibration date is noted in the format yyyy-mm-dd hh:mi:ss. 

• The length of the hydrometer bulb is entered, in cm. 

• The volume of the hydrometer bulb is entered, in cm3. 

• Coefficients A and B of the calibration curve are entered. 

• Coefficients A and B of the composite correction curve are entered. If a correction reading is taken 

rather than the calculation via the composite correction, enter 0 in both fields. 

• The density correction factor is entered; the default value is 1. 
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• A description of the hydrometer can be added with 255 characters. 

 

Figure 55 – Hydrometer calibration entry form 

9.13.1. Calibration curve 

The calibration curve of a hydrometer establishes the relationship between the distance (cm) and the 

reading taken on the hydrometer. The reading is always taken at the top of the meniscus and adjusted in 

the calculations of the hydrometer test. Figure 56 show an example of calibration for measured depth, 

real depth, and effective depth as a function of reading. 

The effective depth equation is:  𝐻′ = 𝐿1 +
𝐿𝐵

2
−

𝑉𝐵

2𝐴
   where 

• VB is the volume of the bulb (cm3) 

• A is the area of the sedimentation cylinder (cm2) 

• LB is the length of the bulb (cm) 

• L1 is the measured depth (blue curve) and corresponds to the distance from the reading mark on 

the hydrometer stem to the top of the hydrometer bulb. 

• The real depth H (orange curve) corresponds to the distance from the reading mark on the 

hydrometer stem to the geometric center of the hydrometer bulb, or:  𝐻 = 𝐿1 +
𝐿𝐵

2
 

• The effective depth H' (gray curve) corresponds to the real depth corrected for water displacement 

resulting from the insertion of the hydrometer in the suspension, or: 𝐻′ = 𝐻 −
𝑉𝐵

2𝐴
 

The different set of values can be used in the calibration but by entering or not the length and / or 

volume. Below are the coefficients to enter for calibration for the example of the figure. 

• If measured depth is used, enter coefficient A (-0.167), coefficient B (10.6), bulb volume (64 cm3 in 

our example) and bulb length (14 cm). 

• If real depth is used, enter coefficient A (-0.167), coefficient B (17.6), bulb volume (64 cm3 in our 

example) and bulb length of 0 (already included in the calibration). 

• If effective depth is used, enter coefficient A (-0.167), coefficient B (16.485), bulb volume of 0 

(already included in the calibration) and bulb length of 0 (already included in the calibration). 
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Figure 56 – Example of calibration curves 

9.13.2. Composite calibration 

1. Calculations of percentages of soil remaining in suspension are based on the use of distilled water. 

However, the use of a dispersing agent increases the specific gravity of the resulting liquid 

compared to that of distilled water. 

2. Hydrometers are calibrated at 20oC. Temperature variation from this standard may produce 

inaccuracies in readings. The amount of inaccuracy increases as the variation from 20oC increases. 

3. Hydrometers are graduated to be read at the bottom of the meniscus formed by the liquid on the 

stem. Since it is not possible to secure readings of soil suspensions at the bottom of the meniscus, 

readings should be taken at the top of the meniscus and a correction applied. 

These three inaccuracies are included in the composite calibration. 

Prepare a solution of distilled water and dispersing agent in the same proportion as will be used in the 

sedimentation tests. At 2 sufficiently different temperatures, read the hydrometer at the top of the 

meniscus. For a 151H, the correction is the difference between the reading and one. For a 152H, it is the 

difference between the reading and zero (1.0 or 0.0 being the reference readings at the bottom of the 

meniscus in a cylinder filled with distilled water at 20oC). 

Create a graph of correction with temperature (Figure 57) and set a straight-line relationship with 

equation y = ax + b. With the example below, coefficient A would be -0.476 and coefficient B would be 

16.071. 
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Figure 57 – Example of calibration of composite correction 

9.13.3. Density correction factor  

The correction factor F for density is used in the BNQ 2501-025 standard. Please refer to it. With a value 

of 1, the factor has no impact. 

9.14. Lab equipment form 

The form shows data from the EQUIPMENT table of the Geotec database. It is used to define the 

apparatus used in the laboratory and their information. 

• The category and the apparatus number together constitute the key of the records. 

• The category indicates the type of device. It is used to create a field-specific drop-down list in the 

entry forms. The following choices should be used: 

Balance, Cylinder, Rammer, Mould, Tare, Thermometer, Sieve 

• The apparatus number identifies the equipment. Enter up to 20 characters with letters, numbers 

and symbols - _ ( ) . Accents and other special characters cannot be used. 

• The model has 20 characters to specify the equipment model or sub-categorize equipment. 

• The calibration date is noted in the format yyyy-mm-dd hh:mi:ss. 

• The mass, volume, area, height and diameter are numeric fields and only apply to certain types of 

apparatus. 

• The measurement scale of the apparatus is alphanumeric with 50 characters. 

• The measurement precision of the apparatus is 50 character alphanumeric. 

• An apparatus description can be added with 255 characters. 
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Figure 58 – Lab equipment entry form 

10. General entry forms  

The last tab of the Entry forms menu is General (paragraph 2.1). It is separated in entry forms for 

administration and for predefined lists and other definitions. 

10.1. Employees form 

The Employees form is for future development.  

10.2. Clients form  

The form shows data from the CLIENT table of the Geotec database. It is used to enter administration 

information about your clients. The list of client numbers and names defined in the CLIENT table is used 

in the Site, Projects and Contracts entry forms.  

• The client number is the key of the record. Enter up to 20 characters with letters, numbers and 

symbols - _ ( ) . Accents and other special characters cannot be used. 

• The client’s name is a 80-character string.   

• The address is entered with up to 255 characters.  

• The city, the province and the country are 20-character strings.  

• The postal code is a 10-character string.   

• The phone and fax numbers have 20 characters.  

• Email has 50 characters maximum, and website has 80.  

• The client’s GST and PST numbers can be entered with 10 characters. 

• The contact’s name for the client is entered, with 60 characters.  
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•  he client’s logo file can be selected, with a maximum of 255 characters. By clicking on the button 

right of the field, the Windows file selection screen opens.  

To save the file name with its full path, enable the option in the preferences. See the X3D 

documentation. 

• Remark is alphanumeric with 255 characters for additional details. 

 

Figure 59 – Clients entry form 

10.3. Projects form 

The form shows data from the PROJECT table of the Geotec database. It is used to enter administration 

information about your projects. The list of project numbers and names defined in the PROJECT table is 

used in the Site and Boring entry forms.  

• The project number is the key of the record. Enter up to 20 characters with letters, numbers and 

symbols - _ ( ) . Accents and other special characters cannot be used. 

• A sub-project can be added with 20 characters.  

• The project name is an 80-character string.   

• The description is alphanumeric with 255 characters for a complete description of the project.  

• The client number for the project has 20 characters. The list of client numbers and names defined 

in the CLIENT table is suggested (paragraph 10.2). 

• The client’s name is automatically the one defined in the CLIENT table for the client number 

selected. The value is alphanumeric with 255 characters.  

• The dossier is a general reference number; with 20 characters.  

• The start and end dates of the project are noted in the format yyyy-mm-dd hh:mi:ss. 

• The phase, type and activity code for the project are alphanumeric with 12 characters.  

• The ISO version, ISO procedure and ISO sequence are alphanumeric with 12 characters. 



DATA ENTRY FORMS | Version 8.12.1 | Page 144 

  

 

Figure 60 – Projects entry form 

10.4. Contracts form 

The form shows data from the CONTRACT table of the Geotec database. It is used to enter 

administration information about your contracts. The list of contract numbers and names defined in the 

CONTRACT table is used in the Site and Boring entry forms.  

• The contract number is the key of the record. Enter up to 20 characters with letters, numbers and 

symbols - _ ( ) . Accents and other special characters cannot be used. 

• The general contractor doing the work for the contract is entered, with 80 characters.  

• The contract name is a 255-character string.   

• The description is alphanumeric with 255 characters for a complete description of the contract.  

• The client number for the contract has 20 characters. The list of client numbers and names defined 

in the CLIENT table is suggested (paragraph 10.2). 

• The client’s name is automatically the one defined in the CLIENT table for the client number 

selected. The value is alphanumeric with 255 characters.  

• The start and end dates of the contract are noted in the format yyyy-mm-dd hh:mi:ss. 

 

Figure 61 – Contracts entry form 
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10.5. Regions form 

The form shows data from the REGION table of the Geotec database. It is used to identify and describe a 

region and the limits of the domain it covers. The list of region numbers and descriptions defined in the 

REGION table is used in the Site entry form.  

The Domain< and Map buttons are active only in the Site module. They are used to define the domain 

directly with the mouse, and to edit the map. See the Site documentation. 

• The region number is the key of the record. Enter up to 20 characters with letters, numbers and 

symbols - _ ( ) . Accents and other special characters cannot be used. 

•  he region’s domain is defined.  he minimum and maximum easting and northing of the region 

are entered (in meters). 

• The angle is the declination at the center of the region indicated on topographic maps, between -90 

and 90 degrees.  If the declination is West, the value is position; if the declination is East, the value 

is negative.  

• The zone where the region is located is entered. 

• The NAD projection system is either NAD27 or NAD83. 

• The coordinate system is either MTM or UTM. 

•  he region’s domain can also be defined with the East and West longitude and North and South 

latitude of the region.  

• The longitude and latitude of the region’s center can be entered or calculated. 

They are used in the Google Maps tool integrated to the modules. 

• The description is alphanumeric with 255 characters to add notes.  

• A cartographic file can be associated to the region, with a maximum of 255 characters. By clicking 

on the button right of the field, the Windows file selection screen opens. This cartographic file can 

be displayed in the Site module. 

To save the file name with its full path, enable the option in the preferences. See the X3D 

documentation. 

• Transfer is a 1-character code to classify records for their management. 

10.5.1. Calculations 

Geotec calculates the longitude and latitude of the region’s center.  f   and   min and max coordinates 

are entered, Geotec calculates their average and converts it to lat-lon. Otherwise, Geotec calculates the 

average of the longitudes and latitudes of the sites that have the region number defined. 
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Figure 62 – Regions entry form 

10.6. Municipalities form 

The form shows data from the MUNICIPALITY table of the Geotec database. It is used define the 

municipalities. The list of municipality numbers and names defined in the MUNICIPALITY table is used in 

the Site entry form.  

The Tutorial.mdb database provided by Sobek contains the list of municipalities in Quebec based on the 

website DonneesQuebec.ca from 2022.  

• The name of the municipality is a 100-character string.  A value is required.  

• The municipal code is the key of the record. Enter up to 10 digits. 

• The designation shows the type of agglomeration: a village, a parish, a city, etc. with 20 characters. 

• The MTM zone where the municipality is located is entered; this number varies between 3 and 10 

inclusively in Quebec.  

• Easting contains the value expressing the hundreds of thousands of X coordinates for the 

municipality.  

• Northing contains the value expressing the millions and hundreds of thousands of Y coordinates for 

the municipality.  

• The area is expressed in km2. 

• The population is then entered.  

• The number and name of the regional county municipality (RCM) to which the municipality 

belongs are entered.  The number is an integer; the name is a 50-character string.  

• The number and name of the administrative region to which the municipality belongs are entered.  

The number is an integer; the name is a 50-character string.  
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Figure 63 – Municipalities entry form 

10.7. Lists form (English and French) 

The forms show data from the LIST_ENG (English) and LIST_FRE (French) tables of the Geotec database. 

The language corresponds to the language in which the software is used. The forms are used to define 

the drop-down lists of values used in the other entry forms of Geotec, except for fields whose type of 

drop-down list of “1: distinct” or “6: no list” (paragraph 18).  

The Geotec database created by DBM contains more than 400 records. The user can modify them, add 

some and delete others.  NOTE: If you modify the LIST_ENG table, the records are not automatically 

modified in the LIST_FRE table. If you use Geotec in both languages, verify their correspondence.  

• The table name, field name, value and description together constitute the key of the record.  

• The name of the Geotec table is identified. 

• The name of table field is identified. The list suggests all fields of the selected table.  

• The value is typically an abbreviation. It is the item chosen when the type of drop-down list is “2: 

value” or “4: + value” (paragraph 18). It is alphanumeric with 10 characters.  

o If there is no value to indicate, use the dot. In this case, the description will be used in the 
drop-down list. 

o To use ranges of numeric values, enter the minimum value followed by : and by the maximum 
value. You can associate a description, color and pattern to a range of values.  

For example, enter the value 0:20 in order for the associated color to be used for all values 
between 0 and 20 inclusively. 

• The description is chosen when the type of drop-down list is “3: description” or “5: + description” 

(paragraph 18). It is alphanumeric with 255 characters.  

• A color associated to the value is selected by double-clicking in the cell. This color is used for curves 

of type Color.  

• A pattern associated to the value is selected by double-clicking in the cell. This pattern is used for 

curves of type Pattern.  
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• The rank is used to force a display order in the list. The items are displayed by numerical rank (from 

0), followed by the items without a rank. The items with the same rank are displayed alphabetically. 

The % character is supported as replacement character for the table and field names, to avoid repeating 

values used in different fields. For example, the remarks on the hydrogeology measurements in tables 

BORING and PIEZOMETRIC_LEVEL can be entered once only with % as table and MEASURE_REM% as 

field.  

In the Geotec modules, the description of a value from the tables of lists can be displayed by using the 

@@ characters, except if an equivalence for this table, field and specific value is already defined In the 

EQUIVALENCE table (see paragraph 10.11) For example, @@BORING.TYPE will indicate Test pit if the 

value of the TYPE field of the BORING table is TP. 

 

Figure 64 – Lists entry form 

10.8. Properties form 

The form shows data from the PROPERTIES table of the Geotec database. It is used to define the various 

properties that do not have a specific table in Geotec. The list of properties defined in the PROPERTIES 

table is used in the Other properties entry form (paragraph 8.7). 

• Property is the key of the record. You can enter up to 20 characters with letters, numbers and 

symbols - _ ( ) . Accents and other special characters cannot be used. 

• If the Hide box is checked, the property will not be displayed in the table in the Sample form. This 

checkebox is managed on each workstation separately. 

• The property units is alphanumeric with 10 characters. It is indicated next to the property in the 

table of the Sample form. 



DATA ENTRY FORMS | Version 8.12.1 | Page 149 

  

• The parent property can be selected from all defined properties. It is for a future development. 

• The category is alphanumeric with 10 characters and it used to group several properties in the 

same category.  

• The measurement type indicates if the property is measured at a given depth (1), for a depth 

interval (2), on a sample (3) or on a run (4).  he properties of type “3” are displayed in a table in the 

Sample form for facilitate the data entry, except those that are hidden or whose order is 0.  

• The type of drop-down list for the remark of each property can be defined. In table LIST_ENG, the 

table name is PROPERTIES, the field name is the name of the property (ex: PROPERTIES and 

CONTAINER). 

o 0: Default. The list shows the records from the LIST_ENG table, and if there are none, the 
existing data from the database, for the current field. 

o 1: Distinct. The list shows the existing data in the database for the current field. 

o 2: Value. The list shows the values from the LIST_ENG table for the current field. Only one 
choice can be selected at a time. 

o 3: Description. The list shows the descriptions from the LIST_ENG table for the current field. 
Only one choice can be selected at a time. 

o 4: + Value. The list is the same as for Value, but the choices are concatenated after each 
selection. 

o 5: + Description. The list is the same as for Description, but the choices are concatenated after 
each selection.  

o 6: No list. No list is displayed. 

• Order is used to force a display order in the table of the Sample form, from smallest to largest 

number. To hide a property from the table in Sample form, set its rank to 0.  

• The format of the numeric values can be modified for viewing – for example in scientific format, or 

without decimals.  

• The minimum value is numeric. It is for a future development. 

• The maximum value is numeric. It is for a future development. 

• The description is alphanumeric with 255 characters to describe the property 

• A remark can be added with 255 characters. 

• The name of the person who added the property and the date added can be entered for better 

management. 

• Transfer is a 1-character code to classify records for their management. 
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Figure 65 – Properties entry form 

10.9. Materials form 

The form shows data from the MATERIAL table of the Geotec database. It is used to define various 

materials and to associate a display color or automatisms for quality control. The list of materials and 

their description defined in the MATERIAL table is used in several Geotec forms. 

• Material is the key of the record. You can enter up to 20 characters with letters, numbers and 

symbols - _ ( ) . Accents and other special characters cannot be used. 

• The color associated to the material can be used in graphic reports. By double-clicking in the field, a 

color definition form opens to facilitate its selection. 

• A default sieving method can be selected for the material via the drop-down list showing all sieving 

methods defined (paragraph 9.11). 

• A default grain size requirement can be selected for the material via the drop-down list showing all 

grain size requirements defined (paragraph 9.12). 

• The reference test and the minimum required are used to establish compliance during tests to 

determine in-situ densities. They will be used in a future development. 

• The material description is alphanumeric with 255 characters. 

 

Figure 66 – Materials entry form 
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10.10. Contaminant form 

The form shows data from the CONTAMINANT table of the Geotec database. It is used to define 

contamination criteria for water and soils.  The list of contaminants defined in the CONTAMINANT table 

is used in the Concentrations form (paragraph 9.10). 

The Tutorial.mdb database provided by Sobek contains several contamination criteria based on previous 

lists from the MDDEP.  

• The contaminant and the geologic province together constitute the key of the record.  

• The contaminant is alphanumeric with 40 characters. 

• The code for the geologic province has 1 character and is used to define criteria A of the 

contaminant. 

• The group has 50 characters. It is used to narrow the drop-down list of contaminants in the 

Concentrations form.  

• The description of up to 255 characters is used to add information. 

The following four fields are for the soil contamination.  

• Measurement unit is used to enter the unit of the contaminant concentrations in soil.  

• Criteria A to C contain the contaminant concentrations corresponding to each criteria.  

The following four fields are for the water contamination.  

• Measurement unit is used to enter the unit of the contaminant concentrations in water.  

• Criteria A contains the method’s quantification limit.  

• Criteria B contains the water consumption criterion.  

• Criteria C contains the surface water and sewer criterion.  

 

Figure 67 – Contaminants entry form 
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10.11. Equivalences forms 

The forms show data from the EQUIVALENCE table of the Geotec database. The form is used to define 

expressions to display by the graphic modules instead of specific values.  

• The table name, field name and value together constitute the key of the record.  

• The name of the Geotec table is identified. 

• The name of table field is identified. The list suggests all fields of the selected table.  

• The value is what we define an equivalence for.  

• The equivalent expressions in French and English are alphanumeric with 80 characters.  

In the Geotec modules, you can display an expression equivalent to a value by using the @@ characters. 

For example, “R” will be displayed in a column showing the sample N values when N = 100.  

The @@ characters can also be used to display the description of a value from the LIST_ENG or LIST_FRE 

table if no equivalence for this table, field and specific value exists (paragraph 10.7). 

 

Figure 68 – Equivalences entry form 

11. Simple queries and data retrieval  

In all Geotec entry forms, queries can be done to retrieve data from the database using various criteria. 

The queries filter the records in the database in order to consult, modify, complete, print or delete 

them. Queries are done in three steps: 1 – open the Query mode; 2 – enter the filter criteria; 3 – execute 

the query. 

Use the button   of the application toolbar, the [F7] key or Data > Retrieval by > Simple Query to 

open the default entry form of the module, for example Boring in Log and Axis in Pro. The form will be 

directly in Query Mode, indicated in the title bar and by the dark blue background color of the form. 
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The user can do a query in any entry form. Once the form is open (paragraph 2), use the [F7] key, the 

button  of the entry form toolbar or Query > Enter to switch to Query mode (indicated in the title bar 

and by the dark blue background color of the form). Then, enter the criteria for the query. The filter 

values can be typed in directly or via more complex criteria.  

• Use [F7] a 2nd time or use Query > Last to fill with the last criteria used.  

• Use % to replace several characters. For example, BH% to retrieve borings whose number starts 

with BH, or 2022-04% to retrieve borings whose date is April 2022, or simply % to retrieve all 

records that have a value in the given field.  

• Use _ to replace just one character. For example, BH0_ to retrieve borings whose number has 4 

characters and starts with BH0. 

• Use < or > for numbers or dates. For example, >10 for greater than 10, or <2019-06-01 for before 

June 1st 2019.  

• Use IS NULL to retrieve all records without a value in the given field.  

• Use ! (which means not LIKE) to exclude records from a query. The ! can be used for a specific 

value, or with the replacement characters. For example, !TP% to retrieve everything except borings 

starting with TP, or !%2015% to retrieve everything except borings with 2015 in their number.  

• Use the drop-down lists to select a specific value in a field.  

• In the drop-down lists, hold down the [Ctrl] or [Shift] key to select several non-consecutive or 

consecutive values, respectively. Then hit [Enter] or click outside the list to confirm the selection. 

The values will be displayed, separated by ;. Multiple selections can indication exclusions. For 

example, !TP%;!%2014% to exclude all records starting with TP and those that have 2014 in their 

number. 

Then, use the [F8] key, the button  of the entry form toolbar or Query > Execute to execute the 

query. It will return all records from the database that correspond to the specified criteria and the status 

of the title bar will be Saved (paragraph 3.1). If no record corresponds, the entry form returns to New 

mode (to insert). 

To cancel the query, use [Ctrl]+[Q] keys, the button  of the entry form toolbar or Query > Cancel. The 

form returns to New mode (to insert).  

The option Query > View SQL is active as soon as a query is done and show the SQL statement. 
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Figure 69 – Query mode 

12. Customized queries (OBSOLETE) 

WARNING: THE CUSTOMIZED QUERY FORM WILL BE REMOVED IN A FUTURE RELEASE. WE 

RECOMMEND USING SIMPLE QUERIES (PARAGRAPH 11). 

Use the button  of the application toolbar Data > Retrieval by > Customized Query to open the 

customized query form. 

 

Figure 70 – Customized query form 
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12.1. Creation of a condition 

The creation of a condition is done in an empty row of the conditions table.  The addition of a condition 

creates a new row in the conditions table. 

12.1.1. Selective condition 

By selective condition, we refer to a condition that has a chosen criterion in all its elements, with the 

eventual exception of Null.  To create a selective condition, the steps are:  

• Select a table from the database. Click in the cell of the Table column, then select the table in the 

scrolling list opened via the button, or directly type the table name.  

Selecting a table may automatically create join conditions (see paragraph 12.6). 

• Select a field of the table in the cell of the Field column. This selection is done the same way as for 

the table; the scrolling list displays the fields from the selected table. 

• Select an operator in the cell of the Operator column. This selection is done the same way as for 

the table and field.  

With the Like and Not Like operators, the “%” and “ ” characters can be used in the value as a 

replacement character, as in a simple query (see paragraph 11). Do not confuse the == operator 

which is a join operator between two tables and the = operator which is the equality operator.  

• Select one or many values, accordingly, in the cell of the Value column.  If the operator is =, Like or 

Not Like, it is possible to choose several values, the separation character being “;”. 

Hold down the [Ctrl] key and click on the desired values for non-consecutive values or use the 

[Shift] key for consecutive values, by clicking on the first and last value of the series.  

The list of the possible values in a condition depends on all other conditions defined in the table.   

• Ask to retrieve the records that do not have a value in the field of the condition, by entering Y or N 

in the cell of the Null column.  If the field chosen in the condition is not with required value, the 

Null cell contains N by default.   

Example: since borings are generally vertical, the DIP field will often contain no value, sometimes 90, 

and a value lower than 90 if the boring is not vertical.  To retrieve only the vertical borings, the 

condition should be that the DIP field of the BORING table is equal to 90 degrees or empty, so with Y 

in the Null cell. 

Example: if the condition is on the CATEGORY field of the GRAIN_SIZE table with Not Like as the 

operator and «EX» as the value, the query will return all the records with a value other than EX in 

the CATEGORY field of the GRAIN_SIZE table. The records with no value in this field will only be 

retrieved if the condition contains Y in the Null cell. 

12.1.2. Non-selective condition 

A non-selective condition has one or many elements with no defined criteria.   
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• Example: If the user wants to retrieve the borings having a dip value entered in the database, 

whatever the value, and exclude the borings without a dip, he creates a condition on the DIP field 

of the        table using the “<>” operator, an impossible value, 370 for example, and N in the 

Null cell.  

• Example: If the user wants to retrieve all the borings in which a piezometer is defined, he creates a 

condition in which he only selects the PIEZOMETER table and leaves empty the other elements of 

the condition.  This condition is interpreted as a retrieval of the records of borings present in the 

PIEZOMETER table, without another specification. 

12.2. Modification of a condition 

Modifying a condition is done by selecting a new element of this condition, the table, field, operator, 

value or presence of records with the empty field.  

Changing an element in a condition erases all the elements in the cells to the right of the modified 

element.  Therefore, changing the name of the table in a condition implies selecting a field from this 

table as well as the other elements of the condition. 

Modifying a condition may lead to the deletion and/or addition of join conditions (see paragraph 12.6). 

12.3. Deletion of a condition 

To select a condition, click in the grey cell on its left.  A condition is selected when it is in reverse video.  

To delete a condition, select it and click on Delete.  

Deleting a condition may lead to the deletion of join conditions (see paragraph 12.6). 

12.4. Insertion of a condition 

Clicking on the Insert button inserts a new empty row in the conditions table.  The new row is inserted 

at the top of the table if no condition was selected, or after the selected row.  The user can then create a 

condition in the new row. 

12.5. Moving a condition 

The user can move a condition in the table by selecting it and clicking on one of the buttons with an up 

and down red arrow, to move the condition up or down by one row in the table. 

12.6. Joint conditions 

12.6.1. Automatic join conditions 

The following example defines a join condition, more specifically an automatic junction condition. 

 o select all the borings from the “      D  ” site that have a piezometer, the user creates a 

condition on the SITE_NO field of the BORING table using the = or Like operator and the “      D  ” 

value.  He then creates a new condition whose only criterion is the PIEZOMETER table.  By selecting this 

table, two join conditions are automatically created. These conditions mean that the application must 



DATA ENTRY FORMS | Version 8.12.1 | Page 157 

  

locate all the borings identified by the pair SITE_NO - BORING_NO present in the BORING and 

PIEZOMETER tables. 

For join conditions to be created automatically there must be a relationship between the tables of the 

conditions.  In the previous example, the SITE_NO and BORING_NO fields in the PIEZOMETER table are 

not only part of the key of the PIEZOMETER table but also form an external key that links the 

PIEZOMETER table to the BORING table.  

The elements of an automatically generated join condition cannot be modified but the condition can be 

deleted.  This deletion may make the condition at the origin of the deleted join condition unnecessary 

(without any effect). 

12.6.2. Join conditions entered by the user  

This example explains when the user should create a join condition to specify the retrieval. 

If the user wants to retrieve the borings that have the same category as at least one of their respective 

samples, he must create the following join condition. 

 

To create this join condition, the user creates a new condition on the table and field to compare, 

SAMPLE and CATEGORY in our example. He then selects the == operator. Choosing the value, 

“      .        ” in our example, is done via the scrolling list of the Value cell. 

12.7. Viewing the SQL command 

Clicking on the SQL button opens a tool tip showing the SQL command that will be launched with 

defined conditions.  

12.8. Default conditions 

Each application has specific default conditions.  Selecting the Default value from the scrolling list 

associated to the Name field in the Query zone (see paragraph 12.10) replaces the content of the table 

with the default conditions of the application. The values entered as criteria for these conditions are the 

last values used. 

For example, with Log, the default conditions are on the SITE_NO and BORING_NO fields of the BORING 

table. 

12.9. Launch / cancellation of the query  

To launch the data retrieval, click OK in the query editing window or press the [F8] key. The data found 

are then displayed in the graphs and objects defined in the style file used. Clicking on Cancel closes the 

query editing window without launching the data retrieval. 
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12.10. Management of queries  

The user can save a query in the database.  A previously saved query can be selected, modified and 

deleted.  The management of the queries are in the rectangle labelled Query in the editing window of 

the customized queries (Figure 70). 

12.10.1. Selecting a query  

To select a query in the database, click on the arrow button right of the query name field.  In this list, the 

Default term is displayed first, followed by the saved queries in alphabetical order.  

To choose a query from the list, click on its name. Then, the name of the selected query, its description 

and its conditions are displayed in the fields and table of the conditions editing window. 

12.10.2. Saving a query  

To be able to save the current query in the database, the name of the query must be different than 

Default, at least one of its conditions must have changed, or its description must have been edited. 

Then, click Add.  If the name of the query already exists, it will be updated in the database. It is not 

possible to modify the Default query. 

The name of the query is entered in the Name field of the Query zone.  If a query is selected, the user 

can change its name.  If the user provides a query name that already exists in the database, a message 

will notify the user and he must enter another one.   

The Description field is used to enter a string of up to 255 characters to describe the query. It becomes 

active when a name other than Default is used. The button on the right of the Description field opens 

the text editing window. 

12.10.3. Deleting a query  

To delete a query, select it and click on the Remove button of the Query zone.  The Remove button is 

not active for the Default query. 

13. Google Maps 

Use the button  of the application toolbar or Data > Retrieval by > Google Maps to open the Google 

Maps window to view the position of borings, sites and regions, as well as polygonal limits and axes 

depending on the module.  

To use the tool: 

1. Execute a simple query (paragraph 11), a query by limit (paragraph 14) or by group of records 

(paragraph 15), or a customized query (paragraph 12).  

2. The longitudes and latitudes of the sites, borings and regions must have been defined or calculated in 

the database (paragraphs 5.1, 5.3 and 10.5 respectively). 
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3. For the calculations, the MTM or UTM coordinate system, the NAD 83 or 27 and the zone must be 

indicated for the sites in the SITE table so that the coordinate / longitude-latitudes conversions are 

done correctly. 

When opening Google Maps, the map is positioned at the location of the data retrieved. By moving the 

map, any entity located inside the view is also displayed. 

When data is displayed in Google Maps, place the cursor on an entity to display a tooltip with 

information about the entity. For borings, it includes the site and boring numbers, type, state, zone, 

northing, easting, ground elevation, rock depth, maximum depth, latitude and longitude. For sites and 

regions, it includes the site or region number, the zone, and the latitude and longitude of the site or 

region center.  

Localisation 

You can center the map on a site from the database, via the drop-down list that shows all sites whose 

longitude and latitude are defined or calculated. 

The latitude and longitude of the map center are displayed. The user can modify the center manually or 

by moving the map with the mouse. 

The current zoom varies between 1 (view of the Earth) to 21 (very close view). It can be set manually or 

changed with the mouse wheel. 

Minimum zoom for display 

The user can define the minimum zoom for display the regions, sites and borings. The entities will not 

be displayed on the map if the current zoom is smaller than the minimum zoom. 

A minimum zoom can be defined for the markers indicating the location, as well as for the texts showing 

the entity number.  

Data displayed 

The five buttons open the drawing attributes window to define the appearance of the entities in Google 

Maps, including the marker (symbol) and the text for the identifications.  

In the Pro and Site modules, the default attributes for the borings, axes and limits are those of curves 

#110 (Boring), #101 (Axis_Curve) and #120 (Limit) of the plan view. They can be modified as follows.  

Regions and Sites:  

• Define the marker and its diameter, and the font, its size and the text alignment.  

• With roadmap and terrain, the marker and text are black.  

• With satellite and hybrid, the color defined for the marker is used for the marker and the text.  

Borings:  

• Define the marker and its diameter, and the font, its size and the text alignment.  
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o The marker for each boring is the one in the current markers file whose name is the 
concatenation of the type and state of the boring, for example, TP_R for a realized test pit.  

o If no corresponding marker is found, the one defined for borings is used.  

• The current boring is always red (marker and text). It is the boring shown on the graphic page.  

• The retrieved borings are always blue (marker and text). They are the borings retrieved in the 

query. The number of borings retrieved is indicated (including the current one).  

• The borings inside the domain include all borings located in the domain of the map and visible at 

the current zoom. The total number is indicated.  

o With roadmap and terrain, the marker and text are black.  

o With satellite and hybrid, the color defined for the marker is used for the marker and the text. 

Axes and Limit:  

If the query is done via a polygonal limit or an axis, they will also be displayed in Google Maps.  

• Define the marker, its diameter, and its color for the implementation points.  

• Define the line color and thickness representing the axis or the limit.  

 

Figure 71 – Google Maps 
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Type of map  

The standard map types can be selected for Google Maps: Roadmap, Terrain, Satellite and Hybrid. 

13.1. Interactive editing 

In Google Maps, do a right click with the mouse to display a contextual menu. 

 

Figure 72 – Interactive editing in Google Maps 

13.1.1. Create a site  

By selecting Create a Site, the cursor becomes . If the user wants to cancel right away, right click and 

select Cancel.   

To create the site, click with the mouse at one corner of the new site, hold down and move the cursor to 

the diagonally opposite corner; a dotted line shows the area created. When the button of the mouse is 

released, the site entry form is displayed.  

By default, the coordinate systems of the last site queried are used (MTM or UTM, NAD83 or NAD27). 

The X and Y coordinates of the bottom left corner, its longitude and latitude, the zone used for the 

calculation, as well as the width and height of the area are automatically entered.  

The user enters the site number and any other information in the entry form, and saves the new site.  

13.1.2. Create an axis 

By selecting Create an Axis, the cursor becomes . Click with the mouse at each point of the axis. A 

dotted line shows the movement of the cursor. When the last point of the axis is defined, right click and 

select Cancel to erase the axis being created, or Terminate to edit and save the new axis.  

The axis entry form is then displayed and shows the coordinates of each point clicked. The axis points 

are converted to geodesic coordinates based on the systems defined in the site of the axis (MTM or 

UTM, NAD83 or NAD27).  

The user enters the axis number and any relevant information in the entry form, and saves.   
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13.1.3. Create a boring 

By selecting Create a Boring, the cursor becomes . Click with the mouse at the location of the boring.  

The boring entry form is then displayed and shows the coordinates of the added boring, based on the 

systems defined in the site of the boring (MTM or UTM, NAD83 or NAD27). 

The user enters the boring number and any relevant information in the entry form, and saves. 

13.1.4. Select borings 

This option is disabled in Google Maps. It is active in the plan view of the Site module. Please refer to the 

Site documentation.  

13.1.5. Create and modify a rectangular or polygonal limit 

• By selecting Create a rectangular limit, the cursor becomes .  If the user wants to cancel right 

away, right click and select Cancel. 

Click with the mouse at one corner of the rectangular limit, hold down and move the cursor to the 

diagonally opposite corner; a dotted line shows the area created.  

When the button of the mouse is released, the limits entry form is displayed; the longitudes and 

latitudes of the 4 corners of the limit are automatically entered. The number of the current site is 

shown as limit number. The user can modify it, then save the new rectangular limit.  

• By selecting Create a polygonal limit, the cursor becomes .  If the user wants to cancel right 

away, right click and select Cancel. 

Click with the mouse each point of the polygonal limit. A dotted line shows the movement of the 

cursor. When the last point of the polygonal limit is defined, right click and select Terminate. 

The limits entry form is then displayed; the longitudes and latitudes of each point of the limit are 

automatically entered. The number of the current site is shown as limit number. The user can 

modify it, then save the new polygonal limit.  

Any rectangular or polygonal limit can be modified with the mouse. When the cursor is on a limit, it 

becomes . By right clicking, a contextual menu is displayed.  

When adding a point to the limit, the cursor becomes . The point will be added between the two 

points closest to the cursor. A message is displayed, showing the exact coordinates of the point. To stop 

the addition of points, right click and select Terminate.  

When the cursor is on a point of the limit, the option Delete this Point from Limit is active. A message is 

displayed to confirm the deletion of the point.   

When the cursor is on a point of the limit, it becomes . By clicking on the point, it becomes . Move 

the point to the desired position, and release the button of the mouse; a message is displayed to 

confirm the move.  
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14. Polygonal limits 

Use the button  of the application toolbar or Data > Retrieval by > Polygonal Limit to open the entry 

form to define polygonal limits. The form will be directly in Query Mode, indicated in the title bar and by 

the dark blue background color of the form. See paragraph 11 for details about the queries.  

The retrieval by limit is used to retrieve borings located within the coordinates of the limit.  

1. Select the limit in the drop-down list. 

2. Touch [F8] to execute the query. 

3. The coordinates of the limit are displayed in the table and the corresponding borings are retrieved.  

The form shows data from the LIM table and its secondary table LIM_POINTS of the Geotec database. It 

is used to define polygonal limits, a polygon or rectangle inside of which borings are located. 

The Rectangle < and Polygon < buttons are active only in the Site module. They are used to define the 

limits directly with the mouse. See the Site documentation. 

• The limit number is the key of the record. Enter up to 20 characters with letters, numbers and 

symbols - _ ( ) . Accents and other special characters cannot be used. 

• The reference identifies the site where the limit applies. The drop-down list shows all sites defined 

in the SITE table. The coordinate system, NAD and zone of the reference site are used to convert 

between longitude / latitude and geodesic coordinates the entities and the map. 

• A cartographic file can be associated to the limit, with a maximum of 255 characters. By clicking on 

the button right of the field, the Windows file selection screen opens, to select a .lim, .dxf or .xyz 

file. This cartographic file can be displayed in the Pro and Site modules. 

To save the file name with its full path, enable the option in the preferences. See the X3D 

documentation. 

• The description contains a string of 255 characters to describe the limit. 

The table at the bottom of the Polygonal limit form shows data from the LIM_POINT secondary table. 

The table is used to define each point of the limit.  

• The limit number and the index together constitute the key of the records. 

• The index (I) is the sequence number for the points of the limit, to determine the shape of the 

polygon. It is an integer. 

• The X and Y coordinates of each point are then entered. Coordinates are either entered in meters 

in the coordinate system, NAD system and zone of the reference site, or in longitude / latitude. 

Values are required. 
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Figure 73 – Polygonal limits entry form 

15. Group of records  

Use the button  of the application toolbar or Data > Retrieval by > Group of Records to open the 

entry form to define groups of records. The form will be directly in Query Mode, indicated in the title bar 

and by the dark blue background color of the form. See paragraph 11 for details about the queries.  

If data are already retrieved, the Add button will be active to create a new group of records.  

1. Select the desired tab at the bottom of the form for the creation of the new group. 

2. Click the Add button. 

3. All records already retrieved will be shown in the bottom table, based on the tab selected. 

4. Add a group number to save it in the database. 

Otherwise, the retrieval by group of records is used to retrieve some records from the database, based 

on grouping criteria defined by the user.  

1. Click on one of the 5 tabs at the bottom of the form, either to retrieve a group of Sites, of Axes, or 

Borings, of Samples or of Piezometers. 

2. Then, Select the group number from the drop-down list. 

3. Touch [F8] to execute the query. 

4. The records from the group are displayed in the table and are retrieved.  

The form shows data from the SEL table and its secondary tables SEL_SITE, SEL_AXIS, SEL_BORING, 

SEL_SAMPLE and SEL_PIEZO of the Geotec database. It is used to define groups of records based on user 

criteria. These groups can be retrieved via queries.  

• The group number is the key of the record. Enter up to 20 characters with letters, numbers and 

symbols - _ ( ) . Accents and other special characters cannot be used. 

• The description contains a string of 255 characters to describe the group of records. 
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• The reference site and boring is used mainly for groups of borings. It is used to define which boring 

will be the reference for the vertical alignment if several borings are superimposed on boring logs. 

The drop-down lists show all sites included in the group, then all borings of the selected site. You 

can also choose the reference site and boring by selecting a row of the table.  

The tabs at the bottom of the Group of records form show data from the SEL_SITE, SEL_AXIS, 

SEL_BORING, SEL_SAMPLE and SEL_PIEZO secondary tables, respectively. The tabs are used to define to 

which type of entity the group applies.  

The group number and the columns present in the table together constitute the key of the records. 

 

Figure 74 – Group of records entry form 

16. Import external data 

You can import external data, typically CSV files, in a table of the database. Application files specific to a 

few tables can also be imported. 

Click the button  of the application toolbar or Data > Import Data from the main window to open the 

import window. It can also be launched from the entry form toolbar (paragraph 3.2.10).  

The format of the CSV files is detailed in paragraph 16.8. 

16.1. Step 1: Select the table 

If the import window was opened from an entry form, the Table name is inactive and indicates the 

current table.  f it’s opened from the main window, select from the drop-down list the table into which 

data will be imported.  



DATA ENTRY FORMS | Version 8.12.1 | Page 166 

  

16.2. Step 2:  Select the file or directory to insert 

You can insert data from a single file, or from several files in the same directory at once. Click the 

desired checkbox, then click the Browse icon right of the Path field. A file selection or directory selection 

window opens to select the desired file or directory. It is also possible to use the drop-down list of the 9 

last directories used via the Path field.  

By selecting a file, its rows are automatically read and displayed in the tab Content of selected file. The 

file name and the total number of records read are shown in blue at the top of the tab.  

By selecting a directory, the list of .csv files from that directory is displayed in the tab List of files.  

The Path field gets updated with the path of the directory where the files are located.  

16.3. Step 3:  Select the insertion and replacement options 

When importing, all records whose keys do not exist in the database will be inserted. Additional 

insertion and replacement options can be selected.  

• By checking the option Create parent records, records that are parent to the file data are created 

when importing if they don’t already exist in the database.  hey will only be defined by their 

number. If the option is not checked and the parent records do not exist, the data will not be 

imported and an error message will be indicated in the report.  

Example: if a .csv file of samples is imported but the site and borings of the samples do not exist in 

the database, they will get created.  

• By checking the option Fill empty fields of existing records, records are already present in the 

database will be updated with the file data, but only for their fields that were empty.  

Example: if a csv file contains the X and Y coordinates of borings already present in the database 

but whose fields EASTING and NORTHING are empty, these coordinates will be inserted.  

• By checking the option Replace different values of existing records, records are already present in 

the database will be updated with the file data.  

If cells are empty in the .csv file, they will not affect existing values in the database.  

It is possible to delete values from the database. To do this, write NULL or ! as value in the desired 

cells of the .csv file.  

• If an archived site or boring exists in the database, the option Also import into archived sites and 

borings is active. Check this option to allow data to also be inserted into archived sites or borings. 

Otherwise, the records are skipped.  

In the transactions report, the archived data are listed if related records were not inserted because 

the option was not checked.  
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Figure 75 – Import external data 

16.4. Optional: Preview 

The Preview button is used to see the results of the data import without executing it. In the List of files 

tab, check the desired file(s) via their cell to the right of their number and click Preview. 

• The Read column indicates the number of valid records read in the file.  

• The Invalid column indicates the number of records that do not have values for all keys of the table, 

or that have the same keys as another record.  

• The Existing column indicates the number of records already existing in the database among those 

that are checked. 

• The Inserted column indicates the number of records that will be inserted in the table.  

• The Modified column indicates the number of records that will be modified in the table, in other 

words, a record where the value of at least one field will be modified. If options Fill empty fields or 

Replace different values are not checked, this column indicates 0.  

• The Updated column indicates the number of fields that will be modified in the table, in other 

words, whose value will be modified. If options Fill empty fields or Replace different values are not 

checked, this column indicates 0.  

All values greater than 0 are underlined. Double-click in a cell to open a file listing the corresponding 

records. Double-click on the file name to list the records of all columns.  The file opens with the text 

editor selected in the preferences window. The file named Preview_yyyy-mm-dd.txt is saved in the 

directory of output files. It indicates: 

• The date and time of the double-click 
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• The complete .csv file name 

• The Geotec table involved 

• The list of records based on the column clicked and their number in parentheses 

16.5. Optional: Data validation 

To validate the content of a file from the List of files, check the desired file via the cell to the right of its 

number and click on Content of selected file. You can view the file data. If data is incorrect or 

incomplete, correct them here. Uncheck row(s) if you don't want to insert them. 

You can resave the CSV file with the Save as… button. The new CSV file will include only the check rows 

and the corrected data, if applicable.  

The decimal symbol and the separator are displayed for information only after reading the file. 

16.6. Step 4: Insert into the database 

Click on the Insert button to save in the database using the insertion and replacement options. To insert 

data from multiple files, check the desired file(s) in the List of files tab before clicking on Insert. Then, 

the List of files indicates for each checked file: 

• In Read, the number of valid records read in the file.  

• In Invalid, the number of records that do not have values for all keys of the table, or that have the 

same keys as another record. 

• In Existing, the number of records already existing in the database among those that are checked. 

• In Inserted, the number of records inserted in the table.  

• In Modified, the number of records modified in the table; in other words, the records where the 

value of at least one field was modified. This column applies only with options Fill empty fields and 

Replace different values. 

• In Updated, the number of fields modified in the table; in other words, whose value was modified. 

This column applies only with options Fill empty fields and Replace different values. 

After the import, a file opens with the text editor selected in the preferences window. The file named 

Transactions_yyyy-mm-dd.txt is saved in the directory of output files. It indicates the name and path of 

each file and the number of records read, invalid, existing, inserted, modified and replaced, if applicable, 

as well as the tables involved. Click on Report to reopen the transactions file.  

16.7. Application file 

For the axis, piezocone and limits entry forms, it is possible to insert an application file with a specific 

structure. This option will then be active with the file extension indicated.  
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For the piezocone entry form, the Application file is a *.drf extension. By checking it, the option Create 

parent records is automatically checked. The *.drf file is used to automatically insert a lot of data in the 

CPTU and CPTU_POINT tables. See Appendix A – Importing *.drf files for piezocones. 

For the axes entry form, the Application file is a *.prf extension (seismic profiles). By checking it, the 

option Create parent records is automatically checked. The *.prf file is used to insert profiles of 

stratigraphic layers along an axis and the measured seismic velocities. Please contact us if you need to 

exact format. 

With the limits entry form, you can insert *.lim files generated via the Site module in SM2 mode.  

16.8. Format of *.csv data files 

The first row of a CSV file must contain the name of the fields to insert, as defined in the database. To 

know the exact name of the fields, use the [F1] key in the entry forms, or do a CSV data export 

beforehand (paragraph 17). From the 2nd row, put the values.  

The CSV import verifies if the headings correspond to fields in the selected table. If yes, the values are 

read. If not, the column is ignored. A column must exist for each primary key of a table, otherwise the 

data cannot be inserted.  

To delete data from the database, write NULL or ! in the cell and check the option Replace different 

values. Table 8 shows how to delete the values from the GROUND_ELEV field for 7 borings.  

Table 8 – Example of .csv to insert into the BORING table 

SITE_NO BORING_NO EASTING NORTHING GROUND_ELEV 

PETITE-DIGUE TF-01 300000 5000000 ! 

PETITE-DIGUE TF-02 300010 5000010 ! 

PETITE-DIGUE TF-03 300020 5000020 ! 

SMALL-DAM TP-01 300030 5000030 ! 

SMALL-DAM TP-02 300040 5000040 ! 

SMALL-DAM TP-03 300050 5000050 ! 

SMALL-DAM TP-04 300060 5000060 ! 

 

Table 9 – Example of .csv to insert into the GRAIN_SIZE_POINT table 

SITE_NO BORING_NO SAMPLE_NO SIZE PASSING 

PETITE-DIGUE PU-01 1 80 100 

PETITE-DIGUE PU-01 1 56 90 

PETITE-DIGUE PU-01 1 40 88.9 

PETITE-DIGUE PU-01 1 31.5 80 

PETITE-DIGUE PU-01 1 20 71 

PETITE-DIGUE PU-01 1 10 55 

PETITE-DIGUE PU-01 1 5 41.55 
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PETITE-DIGUE PU-01 1 0.08 24.5 

PETITE-DIGUE PU-01 1 0.0351 13 

PETITE-DIGUE PU-01 2 80 98 

PETITE-DIGUE PU-01 2 56 87 

PETITE-DIGUE PU-01 2 40 68 

PETITE-DIGUE PU-01 2 31.5 51 

PETITE-DIGUE PU-01 2 20 41 

PETITE-DIGUE PU-01 2 10 27 

PETITE-DIGUE PU-01 2 5 25 

PETITE-DIGUE PU-01 2 0.08 8 

17. Export data to CSV 

To produce a CSV report with data from an entry form, click the button  of the entry form toolbar, or 

use Action > Export Data.  All data retrieved will be presented as rows in a CSV file. The heading of each 

column will be the field name.  

If a customized format name other than Default is entered in the preferences window (see the 

documentation of X3D), the Layout used for the CSV report will be FORM_DEF_name. Otherwise, it 

will be FORM_DEF.  

The Windows file saving screen opens on the directory of output files to save the file at the desired 

location.  

18. Customize entry forms (Layout)  

You can customize each entry form via the shortcuts in the forms (paragraph 3.2.9) or the contextual 

menu (paragraph 3.3.10). The Layout button  is also available in the application toolbar or via Data > 

Layout of the main window.  

The layout window is used to customize the entry forms and the CSV files produced via the Export tool. 

The layout window is shown in Figure 76. A query can be done just like in the other entry forms to 

retrieve the layout of another entry form.  

The first time an entry form is opened, a record for the table is created in REPORT and records in 

REPORT_COL, as the bottom of the layout form, the customize the fields of the entry form. If a 

customized format name other than Default is entered in the preferences window (see the 

documentation of X3D), the Layout used for the CSV report will be FORM_DEF_name. Otherwise, it 

will be FORM_DEF.  

The changes done via the contextual menu or in Datasheet or Columnar display by moving a column, 

changing its dimensions or dragging it outside to hide it are saved in these 2 tables. 
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The Report parameters section indicates that the reports produced are of CSV type. You can choose 

that the column headings of the CSV file be the field name or the field title defined in the bottom table. 

This option is used only if the report is produced via the Layout form. If the report is produced via the 

entry form, the heading is always the field name. See paragraph 17. 

 

Figure 76 – Layout of entry forms and CSV reports 

• CNAME contains the field names. The values cannot be modified. 

• COL_NO contains the field number as defined in the database; the first field defined by # 0. The 

values cannot be modified.  

• DATATYPE indicates the type of field (paragraph 3.3.2), as defined in the database. The values 

cannot be modified. 

• LENGTH contains the maximum number of characters for the field. The values cannot be modified. 

• RANK defined the order in which the columns or rows appear from left to right or top to bottom. To 

modify the order, select the row in the table by clicking its number in the first column and move to 

the desired place. The rank value will be automatically adjusted.  

• SORT_ORDER is used to define the column(s) on which the data will be sorted after a query. 0 

keeps the default sort. Otherwise, the data will be sorted by the field with 1 as order, then with 2, 

etc. The data is always in ascending order.  

• FREEZE allows to block horizontal scrolling and keep columns to the left of the frozen always fixed. 

Only one cell of the FREEZE column can be set to Yes. Double-click in the cell to switch from No to 

Yes and vice-versa.  
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• HIDE indicates if a field is visible or not in Datasheet and Columnar display. Double-click in the cell 

to switch from No to Yes and vice-versa.  

• PROTECT indicates the protection against editing. It is active except for key fields and required 

fields. None indicates no protection.  Partial indicates that the user can only select from a drop-

down list.  Total indicates that the field cannot be edited. Double-click in the cell to switch from one 

choice to another. 

• LIST defined the type of drop-down list to use.  It can only be modified for Text fields, except for 

primary keys and foreign keys. 

o 0: Default. The list shows the records from the LIST_ENG table, and if there are none, the 
existing data from the database, for the current field. 

o 1: Distinct. The list shows the existing data in the database for the current field. 

o 2: Value. The list shows the values from the LIST_ENG table for the current field. Only one 
choice can be selected at a time. 

o 3: Description. The list shows the descriptions from the LIST_ENG table for the current field. 
Only one choice can be selected at a time. 

o 4: + Value. The list is the same as for Value, but the choices are concatenated after each 
selection. 

o 5: + Description. The list is the same as for Description, but the choices are concatenated after 
each selection.  

o 6: No list. No list is displayed. 

• WIDTH shows in terms of number of characters the width of the columns in Datasheet mode. By 

default, the width is equal to 1 more than the length, but with 5 as minimum and 20 as maximum. 

The user can change the width. It is also modified when the user adjusts the column width with the 

mouse in Datasheet mode.  

• LINE_FEED is used to force a word wrap on a value if it cannot be displayed fully in the cell in 

Datasheet mode. Double-click in the cell to switch from No to Yes and vice-versa. 

• FORMAT is used only for numeric fields and dates. It is used to modify the format of the values in 

the entry form. The format in the database is not changed. A drop-down list suggests several 

formats depending on the type of data (numeric or date) but the user can enter others.  

o Either a C expression (%g, %.2f, %.0e, %s, etc.) 

o Either with a mask (999.99 for 2 decimals, 9.99e for scientific notation with 2 decimals, yyyy-
mm-dd hh:mi for a date, etc.) 

• NULL_VALUE is not used and will be deleted in a future version.  

• TITLE is used to modify the name of the field heading in Datasheet and Columnar display. By 

default, the field name is entered. 
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• DESCRIPTION shows the tooltip message (paragraph 3.3.1). By default, the definition from the data 

dictionary is written. If the box Custom description of the fields of the preferences window is 

checked (see documentation of X3D), DESCRIPTION will be used. Otherwise, the tooltip shows the 

definition from the data dictionary in the language used in the module.  

Select one or several rows of the bottom table and click on Reset to initialize to the default values.  
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Appendix A – Importing *.drf files for piezocones  

For the piezocone form, the application file is a *.drf file.  It is used to automatically insert a lot of data 

in the CPTU and CPTU_POINT tables.  

A1. Converting a file from Excel to *.drf 

The following steps explain how to convert an Excel file to the *.drf format. Below is an example of the 

beginning of a *.drf file: 

XYZ 2014-11-29 12:15 Sobek Technologies 

SITE PROBE a b BORING 

1.63,295.83,42.6894,-2.781 

1.64,642.19,36.1549,-2.693 

1.65,867.01,32.1005,-2.535 

1.66,1338.82,25.3348,-2.341 

1. Validate the data in the Excel file by removing or correcting any error.  

2. Only keep the DEPTH, QT or QC, FS and U2 columns, in this order.  

The values are in meters, then kPa, kPa, kPa. See paragraph A3 if the values are in different units. 

3. For the 1st line, enter the following string in the first cell:  

XYZ yyyy-mm-dd hh:mi TECHNICIAN 

a. XYZ must be present to decode the file.  

b. The following value is the date and time of the test, in yyyy-mm-dd hh:mi format. If the exact 

time is not recorded, enter 00:00.  

c. The following value is the name or listing of the technicians.  

4. For the second line, enter the following string in the first cell:  

SITE PROBE BORING 

a. SITE is the site number (project).  

b. PROBE must have 3 parts separated by spaces (ex: STD 20T AD122, or A B C).  

c. The last value is the boring number.  

5. On line 3, add qt if QT is the input, qc if QC is the input. If no input is indicated and the values begin 

at line 3, a message will prompt the user to select QT or QC as the input during the import.  

6. The values start at line 4, or at line 3 if the previous step is skipped.  

7. Save this version of Excel, save as CSV file (Comma delimited or semi-colon delimited) and say Yes 

to the format change.  

8. Open the CSV file with a text editor (notepad, etc.) 

9. At the end of the first 3 lines, delete the 3 commas (or semi-colons) and save.  
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10. Rename the file extension from CSV to DRF. The values should all be separated by commas (or 

semi-colons). 

A2. Importing a *.drf file 

You can import directly into Geotec the DEPTH, QT or QC, FS and U2 data from a .drf file. These data will 

be inserted into the fields that have the same name, in the CPTU_POINT table. You can then calculate 

several parameters and results. 

1. Open the piezocone (CPTu) entry form.   

2. Click on the Import icon  in the toolbar of the entry form. 

3. Select the options Application file and Create parent records to create the site and boring 

automatically. 

4. Select the *.drf file to import by clicking on the Browse button next to the Path field.  

5. Click the Data from current file tab. 

6.  f the cone resistance input isn’t specified in the .drf file, a message asks the user to select qt or qc. 

This selection is saved for the following .drf files that will be imported without a specified input. 

To change your selection, close and reopen the piezocone form. 

7. Click on Insert. 

It is possible to import several *.drf files at once with the option Select a directory, just like for CSV files 

(paragraph 16.2). 

If values of QT or QC are smaller than 11 kPa or 0.011 MPa, data for these depths are not imported. 

If values of FS are < -999, they are imported as NULL.  

A3. Data units for DEPTH, QT or QC, FS and U2 

Geotec considers that the piezocone data are in meters in the 1st column (depth), and in kPa in columns 

2 (cone resistance), 3 (friction) and 4 (porewater pressure).  

It is possible to force another unit system for the last 3 columns by adding the following two lines after 

the last row of data: 

========================================== 

Units: meters,MPa,kPa,m 

The line starting with Units defines the unit system. This example indicates that in the 1st column, the 

data are in meters; in the 2nd, in MPa; in the 3rd, in kPa; and in the last, in meters.  

The units must be separated by the same separator as the values, either the comma or the semi-colon.  

When the unit indicated is MPa, the values are multiplied by 1000 to convert them to kPa when they are 

inserted into the database.  
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When the unit indicated is m, the values are multiplied by 9.81 to convert them to kPa when they are 

inserted into the database.  

A4. Automatic updates done in the database upon import 

When we import data from a .drf file, several values are inserted automatically into fields and tables of 

Geotec. 

• If the SITE does not exist in the database, it will be created upon import if the option Create parent 

records is checked. 

• If the BORING does not exist in the database, it will be created upon import if the option Create 

parent records is checked. 

• The boring TYPE is set to CP (Piezocone) in the BORING table. 

• The greatest depth read in the .drf file is inserted into the TOTAL_DEPTH field of the BORING table.  

• The date and time are inserted into the DATE_START field of the BORING table.  

• The name or list of technicians is inserted into the CARRIED_OUT_BY field of the BORING table.  

• The value D is inserted into the T field of the CPTU, BORING and SITE tables when the records did 

not already exist in the database, to indicate an import by .drf file.  

• If the CPTU does not exist in the database, it will be created upon import if the option Create 

parent records is checked. 

• The smallest depth read in the .drf file is inserted into the DEPTH_FIRST field of the CPTU table.  

• The greatest depth read in the .drf file is inserted into the DEPTH_LAST field of the CPTU table.  

• The groundwater depth entered in the BORING table is inserted into the WATER_DEPTH field of the 

CPTU table.  

• The default type of density is V (variable) in the D_TYPE field of the CPTU table. 

• The probe is inserted in the PROBE field of the CPTU table.  

• The DIAMETER of the cone is 20 mm by default. 

• The AREA_RATIO of the cone is 0.8 by default. 

• The increment between two values (in mm) read in the .drf file is inserted into the READING_STEP 

field of the CPTU table. 

• The radio button for Total resistance qt or for Tip resistance qc is selected to indicate the input. The 

corresponding field INPUT_QC is 0 for QT, 1 for QC.  

• The default calculation parameters are: 

o Nkt = 14 

o Nst = 3.08 
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o Su/Pc = 0.22 

o Min Ic = 2.6 

o Cq max = 1.7 

o Dr constant = 350 

 


